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Introduction

The user guide is intended for editors, administrators, marketers and merchandisers, working with
tasks as described in Roles and tasks. The user guide may also be helpful for developers when configuring and setting up EPiServer websites. Refer to EPiServer World for developer guides and technical documentation.

Features, licenses and releases
This user guide covers the latest releases for the entire EPiServer platform.
EPiServer CMS is the core part of the EPiServer platform providing advanced
content creation and publishing features for all types of website content. CMS features are available in all EPiServer installations.
EPiServer Commerce adds complete e-commerce capabilities to the core functionality in CMS. Commerce requires additional license activation.
Add-ons extend the EPiServer capabilities with features like advanced search,
multi-variate testing, and social media integration. Some add-ons are free, others
require license activation. Add-ons by EPiServer are covered in this documentation.
Due to frequent feature releases, this user guide may describe functionality that is not yet
available on your website. Refer to Release history to find out in which area and release a
specific feature became available.

Web-based user guide
This user guide is also available as an online help that opens in a web browser. The online help is
either accessed from within the EPiServer platform or from EPiServer World.
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Copyright notice
Copyright © 1996 – 2015 EPiServer AB. All rights reserved.
Changes to the contents, or partial copying of the contents, may not be done without permission.
The document may be freely distributed in its entirety, either digitally or in printed format, to all users
of EPiServer Software. We assume no liability or responsibility for any errors or omissions in the content of this document. We reserve the right to alter functionality and technical system requirements.
EPiServer is a registered trademark of EPiServer AB.
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Release history
The EPiServer user guide describes features in the EPiServer platform, including CMS for content
management and Commerce for e-commerce management, as well as add-ons from EPiServer.
New features are continuously made available through EPiServer updates. This user guide (15-1)
describes features added up until and including update 55 for EPiServer. Refer to EPiServer World
for previous user guide versions.
Area

Features and updates
l

Possibility to define one host name (per language) as primary host and let
other hosts redirect to this site - (update 55)

l

Default on-page editor is floating instead of flyout - (update 50)

l

Scheduled publishing for projects - (update 47)

l

Improved listing of categories - (update 46)

l

Improved editing of price information - (update 38)

EPiServer Find
l

Best bets for Commerce catalog entries - (update 55)

Google Analytics for EPiServer
l

Support for e-commerce tracking and Universal Analytics

Marketing Automation for Marketo
l

Support for marketing automation using Marketo
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Commerce
With EPiServer Commerce you can quickly create and deploy a flexible e-commerce website, combining powerful content management and display with advanced back-end online store management.

Feature summary
EPiServer Commerce provides features for both back-end administration of the online store as well
as for managing and displaying specific content for e-commerce, such as presentation of catalogs
and product items. There are numerous possibilities to extend the built-in functionality, for instance
through the EPiServer Add-on Store.
EPiServer Commerce is flexible and made for integration with other systems. This documentation describes a sample installation based on the sample template package for
EPiServer Commerce. Please be aware that your specific system may differ from what is
described here, and all parts described may not be available on a specific customized
website.

Catalogs and product management
With the Catalog features you can manage catalogs, product categories and products. Catalogs are
independent from one another and you may create as many catalogs as you need. Catalogs can be
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structured in a number of ways and organized into Categories, Products, SKUs, Bundles, Packages
and Dynamic Packages.
An intuitive user interface makes it easy to add new products and change the structure of a catalog.
You can quickly add or modify a product in one location and it will automatically update across all of
your e-commerce websites and channels. Furthermore, you can run multiple catalogs in parallel on
the same platform. You can also associate and recommend related products to increase your up-sell
and cross-sell opportunities.

Order management
EPiServer Commerce includes flexible order management features where customers can perform
returns and exchanges, ship to multiple addresses, modify orders and track packages. You can also
create recurring orders and process them automatically.
The Orders subsystem is where you monitor, track, change or create new orders, ship out items,
and create returns/exchanges. Orders are highly flexible, with the possibility to create purchase
orders with various options including split payments, split shipping, and split shipping addresses.
You can also create a one-page "fast" checkout or allow customers to make a purchase without
registering on your site.
EPiServer Commerce supports a number of payment types, currencies and shipping options so you
can easily expand your business into new markets. The platform also includes tax and shipping calculations that automatically show your customers all of their costs upfront, including duty and taxes.

Merchandising
Merchandising is about improving the customer experience, displaying relevant products and
increase conversion rates. EPiServer Commerce can automate your merchandising, so you can
bring more targeted visitors to your website and turn them into customers. You can easily create
product landing pages by uploading content and drop it into place. Through the use of shared blocks,
content will automatically update throughout the entire site.
Use the personalization features to create targeted content. EPiServer Commerce lets you define
personalization criteria such as the number of orders and amount spent within a defined period, along
with customer buying intention for a specific product type or category. You can get detailed information about your visitors and their buying patterns, and monitor your e-commerce website to see how
much a customer has spent over time and how often they return to your site. You can also learn what
visitors are looking for and what products are the most popular.

Customer management
Customer management in EPiServer Commerce include the ability to store customer records and
track orders that have been placed across multiple websites. You can also access shopping carts
and wish lists to see what your customers want at any point in time. Internal users, customers, partners and organizations are managed through the same interface. Generally, only your team of
internal users will have access to the administrative parts, and depending on their permissions will
have varying access to the subsystems and menu items within each system.

Pricing and promotions
With EPiServer Commerce it is easy to launch campaigns. You have the option to choose a preset
promotion or create a custom campaign of your own, all managed without the need for web
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development. You will have complete control over promotions, from developing custom discounts to
deciding when the campaign should go live.
Promotions are managed from the Marketing subsystem. Create your own promotions or use built-in
ones such as "Buy N of product X and get a discount" or "Buy N of product X and get one free".
Create a promotion that is visible prior to checkout or configure a promotion to be displayed during
checkout. You can also apply a shipping cost discount.
EPiServer Commerce automatically shows your customers targeted promotions based on their
industry, interests, demographics or any other data. You can also develop custom campaigns and
pricing based on sales seasons or regions. The extensive built-in pricing and information rules
include volume pricing, tiered pricing and pricing for specific customer groups.

Multi-site and language features
With EPiServer Commerce you will have one platform to create and deploy any number of localized
e-commerce websites. A unified web interface lets you control all of your product catalogs, customer data and local market data. You will have globalization support to manage your content,
products and regional settings for multi-markets.
The EPiServer Commerce multiple language, payment, shipping, tax and currency options help you
meet the needs of international customers. For example, you can create custom promotions for specific markets to further drive sales, or enable regional origin/drop shipping to better support international operations.

Multi-channel commerce
Using EPiServer Commerce content can be created in one place, and easily shared and distributed
through multiple channels such as mobile, social, e-mail, as well as on the e-commerce website.
You can create targeted campaigns for instance by offering a special promotion code to anyone who
"likes" your Facebook page or scans a QR code in a mobile campaign. New channels can easily be
added for future use.

Security
EPiServer Commerce gives you total control over who can access your e-commerce website backend to ensure that unauthorized users do not modify your website or view customer data. You can
configure access rights for users, user groups and functions. EPiServer Commerce has a number of
predefined roles for managing store procedures as well as website content and files, but you can
also set up your own set of roles. You can also work with predefined virtual roles, for instance to create access based on personalization and visitor groups.

Content management
Marketers and merchandisers will work from the editorial interface to create and update content. Perhaps you want to create a campaign or a landing page and edit product content in the product catalog. Or maybe create news or an article with content related to the products in your online store. You
can drag-and-drop content blocks or pages into the content area of another web page, making it easy
to create dynamic websites putting important content in focus.

© EPiServer AB

Commerce | 13

Administration and configuration
EPiServer Commerce is a flexible system made for customization, and with numerous configuration
possibilities. From the Administration section in Commerce Manager you can manage various ecommerce administrative and configuration tasks such as setting up shipping and payment gateways, default language, currency, units, tax configuration, and search settings.
From the administration interface in EPiServer CMS you will manage common website administrative task such as setting access rights for web pages in the page tree and block folder structure,
management of scheduled jobs, and language settings.

Getting started
Refer to the Getting started section for information on how to log in, access features and work with
the EPiServer user interface.
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Getting started
This section describes how to log in to an EPiServer website, access features and navigate the different modes. Note that the login procedure may be different from what is described here, depending
on how your website and infrastructure is set up. The examples described here are based on a
“standard” installation of EPiServer with sample templates.

Logging in
As an editor or administrator, you usually log in to your website using a specified URL, a login button
or link. Enter your user name and password in the EPiServer login dialog, and click Log In.

Accessing features
What you are allowed to do after you have logged in depends on your implementation and your
access rights, since these will control the options you see. When logged in, the EPiServer access
menu will be displayed in the upper right corner.
Selecting CMS Edit will take you to the editing view as well as other parts of the system. You can
also go directly to your personal dashboard by selecting the Dashboard option.

Navigation
Pull down the global menu available at the very top to navigate your way around. In the menu you
will find the different products and systems integrated with your website. Select, for instance, CMS
to display available options in the submenu.

The menu options you see may vary depending on your access rights. In the examples in
this user guide we have assumed that the user has full permissions to all functions in
EPiServer.

Next steps
Refer to the sections listed below for more information.
l

User interface and Roles and tasks in the CMS Editor User Guide for information about the
EPiServer user interface and roles.
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l

Managing content in the CMS Editor User Guide for information on how to create and publish
content.

l

Administration interface in the CMS Administrator User Guide for information on how to
administer and configure settings in EPiServer.

l

Commerce User Guide for information on how to work with e-commerce tasks, if you have
EPiServer Commerce installed.

l

Find User Guide for information on how to work with search optimization, if you have
EPiServer Find installed.

l

Add-ons section in the online help for information on how to use add-ons from EPiServer, if
you have any of these installed.

User interface
The toolbar and the panes in the EPiServer edit view provide easy access to functions when working with content. When entering the edit view, you will have the global menu and the toolbar at the
top, and adjustable panes to the left and right.

The global menu provides access to other areas of the EPiServer platform. The toolbar contains features like preview and view options, and lets you add items such as pages or blocks.
The EPiServer user interface is flexible allowing developers to plug-in customized features when implementing websites. This description refers to a "standard installation" of
EPiServer without customizations.

General features
l

Context-sensitive actions. Some features will only be available in certain context. The toolbar, for instance, will present relevant actions depending on what you are currently doing, and
the add (+) button also offers context-sensitive options.
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l

Primary actions. Some actions are opened in a new window, for example, a page delete confirmation. The background will be dimmed, meaning that you must finish the primary action to
continue.

l

Action feedback and notifications. Successful actions are confirmed by a message in the
notification bar. A notification may also appear in case of an error requiring you to take action.

l

Drag-and-drop operations. Drag-and-drop is supported in many areas. For instance, you
can drag pages, media files and blocks into the rich-text area or content areas, or re-arrange
the page tree structure using drag-and-drop.

l

Keyboard commands. Standard keyboard commands are supported in many areas, for
instance, when moving pages in the page tree or in the rich-text editor.

l

Search. Supported in many areas to locate, for instance, pages in the page tree or media in
the folder structure.

l

Adaptable work environment. Resize and pin the panes depending on what you are currently doing, and add and remove gadgets of your choice for quick access to functionality.

l

Support for time zones. Publishing actions in edit view are done in your local time zone,
whereas administrative actions are based on server time.

l

Context menus are available in many areas, for instance, in the panes, the page tree and in
item listings. The menu displays different available options depending on where in the interface you are and what you are doing.

Panes
The user interface has a left-hand and a right-hand pane, which can be adjusted and extended with
additional gadgets.
Pane pin is used for expanding and locking the panes in an open position.
Settings for a pane or a gadget allow you to configure or remove a gadget, or rearrange gadgets in a pane.
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Left-hand "navigation" pane
Contains the page tree structure (Pages), language branch (Sites) navigation and tasks management (Tasks) by default.
Right-hand "assets" pane
Contains the Media and Blocks folder structures by default, for easy access to drag items into the
content you are currently working with.

Editing
The toolbar on top displays an actions menu with context-sensitive publishing options which will
vary depending on content status and user access rights. During editing, content status and autosave information will be displayed.

When working with content such as pages and blocks in CMS, or catalog content in Commerce,
there are two editing views, On-Page Editing and All Properties, with toggle buttons to switch
between them.
On-Page Editing provides quick access to direct editing of a selection of content properties.
All Properties provides access to all available properties including more advanced ones
such as access rights and language settings.
When editing content properties, these options are common when adding, deleting, or selecting
items.
Click to select, for instance, a category.
Click to select, for instance, an image in a media folder, or a page in the page tree.
Click to remove, for instance, a category.

Roles and tasks
EPiServer is designed for interaction website visitors, as well as for collaboration between users. A
user in EPiServer is someone working with different parts of the platform. A user can belong to one
or more user groups and roles, depending on their tasks as well as the size and setup of the
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organization. Typical roles and related tasks are described below. Refer to Setting access rights in
the CMS Administrator User Guide for information on how to configure user groups and roles in
EPiServer.

Visitor
A visitor is someone who visits the website to find information or to use available services, on an ecommerce website possibly with purchasing intentions. Purchasing on an e-commerce website can
be done either "anonymously" (payment and shipping details provided), or by registering an account.
Visitors may also contribute to website content as community members, which usually requires
registration of an account profile.

Community member
Content may be added by visitors or community members, if social features and community functionality is available for the website. This content includes forum and blog postings, reviews, ratings
and comments, in which case there might be a need for monitoring this type of content on the website. Monitoring can be done for instance by an editor, or a specific moderator role for large websites
and online communities.

Content editor
A content editor is someone with access to the editorial interface creating and publishing content on
the website. Content editors with good knowledge of the website content, will be the ones working
with search optimization for selected content in search results. Editors may also want to follow-up
on content with unusually high or low conversion rate in order to update or delete this content.

Marketer
A marketer creates content and campaigns with targeted banner adverts to ensure customers have
consistent on site experience of the various marketing channels. Furthermore, the marketer monitors campaign KPIs to optimize page conversion. A marketer with good knowledge of the website
content, may also want to monitor search statistics in order to optimize search for campaigns and
promote content.

Merchandiser
A merchandiser typically works with stock on an e-commerce website to ensure that the strongest
products are put in focus. This role also creates landing pages, sets product pricing, coordinates
cross-product selling, oversees delivery and distribution of stock, and deals with suppliers. This user
wants to be able to identify search queries with unusual high or low conversion rates, in order to
adjust either the search or the product line.

Website owner
A website owner is someone with an overall responsibility for the content and performance of one or
more websites. This user monitors website activities such as page conversions, customer reviews
or sales progress. Rarely creates content but can be involved in the approval of content created by
others. A website owner may have administrative access rights and may be able to install selected
add-ons on the website.
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Administrator
An administrator works with configuration of various system settings from the administration user
interface, including search, languages, user access rights and visitor groups for personalized content. Administrators may also install add-ons on the website. Administrators usually have extended
access rights compared to other user groups, and can access all parts of the EPiServer platform.

Developer
A developer is someone with programming skills working with the setup and implementation of the
website, as well as maintenance and development of new functionality. Creates the content templates for pages, blocks and catalog content used by editors in CMS and Commerce, configures ecommerce settings, and manages the index and customized search features in Find. Developers
may also install add-ons on the website.
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Shopping process flow
Introduction
There are many different types of e-commerce websites, however the two most common ones are:
l

Business-to-Consumer (B2C) - typically designed for selling goods and services to consumers.

l

Business-to-Business (B2B) - used to build strategic relationships with other businesses,
and to ease the supply and procurement processes that characterize trade among those
organizations.

Sites can also have multiple roles, and a single site can provide several functions. EPiServer Commerce is a flexible platform allowing for seamless integration with external systems such as financial, CRM, inventory, warehouse and customer service systems.
Depending on how you chose to work with your online store administration and product content, you
will define your user roles and groups, and give them access rights to the different parts. Example of
user roles in EPiServer Commerce are content editors, marketers, business owners, and store and
system administrators.

Shopping process
A "typical" B2C shopping workflow involves a number of interactions between a visitor on the website, EPiServer Commerce, and any integrated external system.. Depending on how the system is
set up, the shopping workflow can be fully automated so that it requires little manual attention.
However, a purchase order can always be monitored, accessed and handled manually from the
Orders system if needed.
In the following we will describe an example of a B2C type of shopping workflow and the actions and
tasks involved.
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1. Cart created
In this example, a customer does not need to register on the site in order to buy. The order process actually starts as soon as the visitor selects a product and adds it to a shopping cart. A
cart (basket) will be created and saved in the system, and can be viewed in Orders under
"Carts". If the customer does not complete the checkout procedure, the cart will remain in the
system for a specified time.
When the customer returns to the website, the cart will be "remembered" and made available
for continued shopping. Already in this early step the system will perform an inventory and
pricing check, to look for availability in the warehouse, as well as discounts for selected
products in the cart. This will be updated if and when the customer returns to the cart at a later
stage.
2. Start checkout
When the customer decides to complete the purchase and chose to "proceed to checkout",
the first step of the checkout procedure is initiated.
3. Add address
In the second step of the checkout procedure, the shipping and billing address information
is added together with the preferred type of delivery (First class/Express etc). The address
information can be entered manually by an "anonymous" customer, or automatically if the customer is logged in and has a registered user profile with address information. The system can
also be set up so that it is possible to split shipments in different parts and to different
addresses here.
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4. Add payment
In step three of the checkout procedure, the payment is added to the "purchase order to be".
The system will calculate the total sum including the purchase amount and the shipping fee.
In this step the customer selects a payment method, for instance by credit card or PayPal.
The payment will be registered and verified. This may happen instantly or after a certain specified time, depending on how the payment process is set up and the type of e-commerce
solution (B2C or B2B). In this step it is also possible to split payments, if the system is configured for this.
5. Order created
Usually the actual purchase order is created in the system when the payment is settled. In
the last checkout step, a purchase order number is created, the customer confirms the purchase, and an order confirmation is sent to the customer. The shopping cart is now converted
to a purchase order which is visible with status "In Progress" under "Purchase Orders" in
Orders.
6. Order processing
When the order is created the order processing starts. This consists of steps to check the
warehouse and inventory status for the products in the order, and for creating the actual shipment. Depending on the inventory status for the products, the order may be split into more
than one shipment.
7. Shipment released - when the shipment is verified, it will be released. The purchase order
will now appear in Orders, under "Shipping/Receiving" and "Released for Shipping".
8. Add to picklist
This steps involves the addition of the shipping items to a picklist. The picklist is the list that
the warehouse will use to create the physical shipping of the products in the order. This step
will also produce a packing slip, which is the paper slip that will be attached to the physical
package to be shipped.
9. Order completed/shipped
When the picklists with the different orders and their respective packing slips have been created, the order will be set to completed. In the system this involves the creation of a shipment validation number which is associated with tracking number. The tracking number can
be entered manually or automatically, if such an integration exists. The tracking number connects the physical package with the shipping provider for the delivery, and is used for tracking
the package on its way to the delivery address. The purchase order will now appear in Orders
under "Purchase Orders" again, with status "Completed".
10. Return/Exchanges
Only completed orders can be subject to returns/exchanges. Depending on how the system
is set up, returns can be created automatically or manually. Creating a return usually involves
replacing a delivered product with another one in exchange, and/or a payment refund. When
the return is created it will appear in Orders under "Shipping/Receiving" and "Returns". Order
status can be for instance "Awaiting Exchange".
If the return involves replacement of a new product, the shipping procedure will be initiated
again. The return may also involve receiving a faulty product, in which case a receiving
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procedure is initiated involving the acknowledgement of a receiving receipt for the returned
product.

Integration with external systems
EPiServer Commerce is a flexible platform built for integration with other business systems needed
in an e-commerce environment. These systems are typically integrated with various parts of the
shopping workflow, for exchange of data with EPiServer Commerce.
Examples of such external systems:
l

Financial system - for instance invoice management, payment refunds,and sales reporting.

l

CRM (Customer Relationship Management) - for management of customer profiles and
contact information.

l

ERP (Enterprise Resource Planning) - central system for managing pricing, warehouses/inventories, customers and similar.

l

PIM (Product Information Management) - for managing product details for output to different online and print channels.

l

DAM (Digital Asset Management) - for managing various types of product related assets
such as images and videos.

l

Payment gateways - the setup of different payment solutions for instance credit cards and
PayPal.

l

Shipping gateways - the management of shipping providers and exchange of tracking information.

l

Inventory/warehouse system - exchange of inventory information in connected warehouses.

l

Customer services - exchange of for instance order status information.

You also have the possibility to extend your EPiServer Commerce solution with additional modules
from EPiServer and third-party providers. Extension modules are available from the EPiServer Addon Store in the top global menu in EPiServer, or from EPiServer.
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Catalogs
A catalog consists of products and variants (SKUs) organized into a structure based on product categories or "nodes". Products and variants in the catalog will have associated information such as pricing, markets, inventories, warehouses and assets such as images and documents.
Products can exist in one or more catalogs. Catalogs are independent from one another, and you
may create as many catalogs as you need and assign them to one or more websites. Product catalogs are often imported from other integrated systems, but can also be created manually.
The dates that each catalog will be available can also be defined. In this way, future revisions to
items and pricing can be easily prepared and reviewed in advance of the release date to the site.
Note that this documentation describes examples from the sample catalogs delivered
with the EPiServer Commerce sample site. Your installation may look different from what
is described here.

Catalog structure
Catalogs can be structured in a number of ways. For example, you may have various brands or
product lines. Each brand or product line can have its own catalog. Or, a retailer may have multiple
suppliers, in which case you can segment each supplier into its own catalog.

Catalog entries
The catalog is the top-level container for all types of catalog entries:
l

Categories - a grouping of purchasable products, for instance "Art Books" or "Cocktail
Dresses".

l

Products - represent various forms of merchandise that you can display and purchase from
the front-end site. A product is used to group variations where you buy one item in the group.

l

Variations/SKUs - corresponds to a specific type of product with specific characteristics.
For example, a "shirt" product will have an individual variation/SKU (Stock Keeping Unit)
which includes size, color and sleeve length.

l

Packages and bundles - groups of variations where you buy all the items in the group:
Packages - comparable to a SKU because the package item must be purchased as a
whole (for instance a computer system). Multiple SKUs make up the package, but it
has its own single unique pricing and SKU number. For example, the matching shirt
and hat combination is shrink-wrapped together and sold as a single unit. The package
has its own SKU number and is displayed as a single line item in the shopping basket.
Bundles - a collection of variations (SKUs) allowing customers to purchase two or
more items at once. All pricing is SKU-specific and separate. For example, a matching
shirt and hat may be presented together on the front-end so that the user can buy both
items at once. In their shopping basket though they will see each item listed separately.
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Meta classes and fields
You can define your own meta classes and meta fields for both catalogs and orders. For instance,
if you create a meta class called "Wine" you will want to add meta fields that are characteristic for a
wine catalog, for instance "color", "taste", "vintage" and "maturity".
When meta fields and classes have been created, they will be available for usage when working with
the product catalog. Meta classes and fields are defined in the Administration part of Commerce
Manager.

Working with catalogs
Working with catalogs include common tasks such as:
l

Creating catalogs through import/export or manual creation of catalog entries.

l

Categorization and organization of catalog entries.

l

Browsing and reviewing catalogs.

l

Editing catalogs before launching live on your site.

l

Managing pricing for catalog entries.

Importing and exporting catalogs
Managing product catalogs is a central feature in e-commerce, and getting the products into the system is a primary task when setting up a site the first time. A product catalog can be generated from
an external system and then imported into EPiServer Commerce.

When to import/export
When setting up a new e-commerce site you will of course need to get the products into the system.
Importing a product catalog may also be needed when new products have been added to the catalog
in an external system. The scenario could also be that you want to move or copy existing product
catalogs between websites. Creating catalogs and adding catalog entries can be done manually but
is most often not an option when dealing with large catalogs.

Import/export methods
Existing product catalogs can be exported and imported into EPiServer Commerce as a .zip file,
using the standard export/import feature. You can also manage the product catalog in bulk using the
CSV catalog import feature. Here you use an Excel sheet and save the file in the .csv format.
Before the export/import, the various types of product data is mapped to the desired catalog structure and format. The CSV catalog import feature can be used for your entire catalog data, or just portions of them.

Editing products after an import
Depending on the import/export setup, the information for the imported products and their variations
may need to be manually edited to be complete. For instance, you may want to add images, documents and associations to other products. This is described in Editing and publishing catalog
entries.
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Importing existing catalog data
Existing catalog data can be imported or exported to and from EPiServer Commerce websites using
the standard catalog Import/Export feature. The standard catalog importer imports .zip files exported from Commerce Manager. It is a quick way to import catalogs from other websites and start off
with a base to expand your catalog.
Accessing import/export
1. Go to Commerce Manager.
2. Access the Catalog List page in the Catalog subsystem. The Import/Export menu is located in the upper left corner of the main window.
3. For exporting catalogs, click on the check box for the appropriate catalog nodes.
4. Click on the Import/Export pull-down menu to choose either import or export. The corresponding page will appear in the main window.

Exporting catalogs
There are two ways to export catalogs in the Export Catalogs page.
1. Export everything included in the catalog node that you have selected.
l

To do this, click on the Start Export button. The progress window appears and shows the
status of the export.

l

When the export is complete, close the progress window.

2. Export only desired files.
l

To do this, click on the Download links highlighted in blue.
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Importing catalogs
1. Add the catalog file to upload for import using drag-and-drop from the source location.
2. The uploaded files will appear in the list of available files for import.
3. Click on the Start Import button. The progress window will show that the import is taking
place.
4. When the import is complete, close the progress window.

Importing catalogs using CSV files
The CSV catalog import is a feature in EPiServer Commerce that enables you to import and manage
catalog entries (such as products, variants/SKUs, packages) in bulk using an excel spreadsheet
(.csv format). It is an alternative to manually creating catalog entries, which can be tedious when
dealing with a large amount of catalog data.
This feature enables you to accomplish these key tasks:
l

Import your .csv spreadsheets and create new catalog entries in Commerce Manager.

l

Set your catalog items into a desired category structure of your choice.

l

Create entry relations to associate one entry with others (for instance a variant/SKU will
appear within a product or a package).

l

Edit or delete existing catalog items.

The CSV catalog import feature can be used for your entire catalog data, or just portions of them.
Import overview
Here are the basic steps you can take to import and set up a new catalog using the CSV import feature. Before you start, choose an existing catalog folder or create a new one (in the Catalog Management system in Commerce Manager) to import the CSV files to.
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1. Create CSV data files (using Excel Spreadsheet, Notepad, etc.) with information about your
categories, entries, and entry relations.
2. Create necessary meta fields for the new catalog entries (in the Administration system).
3. Upload the CSV data files to the CSV Import page in Commerce Manager, use drag-anddrop to add the files.
4. Create a mapping file for each CSV file. A mapping file is needed to link each column of data
in a CSV file to the correct attributes in Commerce Manager.
5. Import the CSV files and their corresponding mapping files into a specific catalog.
6. Create entry relations to associate one entry with another (for instance a Package and a
Product, or a Product and a Variation/SKU).
Format for CSV files
CSV files you create and import into Commerce Manager need to have a specific format.
l

The first row should have headers that correspond to different attributes of the data you want
to import (e.g., product name, price, description, image file location, etc.).

l

There are a few attributes that are in your CSV file to correctly structure your catalog:

l

Code: A unique code to identify each category or entry

l

Name: A unique name for each row of data

l

Entry Type (for entries only): Each row must contain one of the following five words in order
for the Commerce Manager to correctly recognize its entry type --"Variation", "Product",
"Package", "Bundle" or "Dynamic Package"

l

Parent & Child Entry Code (for entry relations only): A CSV file containing these codes can
specify relationships between entries (e.g., display different Variations within a Product).
Although , the following attribute is useful in creating a hierarchy in your catalog:

l

Action: A command to specify the action that will be taken during the import. Choose one of
the three options: Insert/Update/Delete or I/U/D.
Note: Please make sure to specify an appropriate command for each line of the CSV files.
Entering "Insert" when that data already exist, or "Update" when no data exist will give an
error during import and those line of data will not get successfully imported.

l

Category Code (by comma): By assigning a category code to an entry, you can specify the
category that you want to place your entry in.
Also please note this rule:

l

SEO URL: By design, this attribute that is present in both categories and entries must be
unique for each item in your catalog. Importing files that contain more than one identical url
will result in an error.

Mapping types
Different mapping types are used to create the mapping files mentioned in step 4 above.
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l

Category w/ Meta Data – select this type to create a mapping file for your category files.

l

Entry w/ Meta Data – select this type to create a mapping file for all the entry files (i.e., Packages, Products, Variation/SKUs, Bundles, and Dynamic Packages).

l

Entry Relation – select this type to create a mapping file for your entry relation file that specifies the relationships between entries such as many SKUs to one Product, or SKUs and
Products to a Package.

l

Entry Association – select this type when creating a mapping file for entry associations
(advertising other items under titles such as "You may also be interested in...

l

Variation w/ Inventory – select this type to create a mapping file to import your Pricing/Inventory data located in your Variation/SKU Edit screen.

l

Sale Price – Select this type to create a mapping file for Sale Price file, which specifies different currencies for each item.

By selecting these options, the Commerce Manager will display different sets of Fields and Attributes for you to manually assign to each data column of your CSV file. Figure 11 shows the display of
the mapping files with the Category w/ Meta and Entry Relations Data type respectively. The items
under Fields and Attributes with superscripts 1 and/or 2 are headers that are required attributes
that must exist in the CSV files you are importing (1- required field for Insert, 2 – required field for
Update).
Example: Importing and Setting up a New Catalog
The example below demonstrates how to use CSV import using the guidelines provided above.
Let us say you want to set up a "Baby Stuff" catalog with categories and entries as shown here in
Figure 1.

Figure 1
Prerequisite: Create a new catalog
First, create a new catalog called "Baby Stuff" in the Catalog Management system.
Step 1: Create CSV files containing data for your new entries
The example below is based on an a set of sample .csv files.
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These files provide the base for the discussion in the following section.
The sample files contain the following:
l

BabyStuffCategories.csv

l

BabyProducts.csv

l

BabyPackages.csv

l

BabyVariations.csv

l

BabyVariationInventoryPricing.csv

l

BabyEntryRelations.csv

l

BabyAssociations.csv

l

BabySalePrice.csv

CSV File Type 1 - Category File
This file specifies data for categories and/or subcategories within a Catalog.
The top line has column headers that will be matched with the Meta fields in the later steps. The
headers can also have different names. As you will see in later steps, Category Code in column 1 is
important since it specifies where the entry data will be stored. The code entered in under Parent
Code in column 2 can be used to create subcategories. If the Parent Code is set to "null" or "root,"
then that category will be created in the root level of a catalog. In this example, the "Infants" and
"Toddlers" category will be created at the root level, while the "Diapering Supplies" category will be
located under "Infants" as a subcategory.

Figure 2
CSV File Type 2 – Entry Files
These files specifies data for Catalog Entries. The Products, Variation/SKUS, and Packages CSV
files for this example are shown in Figure 3, 4, and 5 respectively.

Figure 3
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Figure 4

Figure 5
CSV File Type 3 – Entry Relations File
This file is used to link one entry to others. In this example, Var1 ~ Var5 (different diaper sizes) are
associated to Prod1 "Diapers," Var9 ~ Var11 (different quantity for wipes) are associated with Prod2
"Wipes" and so forth. Also some variants are assigned to packages. Please note that the Prod, Var
and Package codes MUST BE the codes from the entry CSV files (Figure 3, 4, and 5). If you include
codes that are not defined in the entry CSV files, you will get an error while importing them into Commerce Manager in Step 4.
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Figure 6
CSV file type 4 - Associations file
This file is used to create associations between different entries. In this example, Var 10 is associated to Var 1 as an Accessory, and Var 2 to Var 1 as a cross-sell item.

Figure 7
CSV file type 5 - Pricing/Inventory file
This file is used to specify the information for the Pricing/Inventory tab of each individual entry.
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Figure 8
CSV file type 6 - Sale Price file
This file is used to specify the information for the Pricing section of the Pricing/Inventory page.

Figure 9
Step 2: Create necessary meta fields for the new catalog entries
For this example, no additional meta fields need to be created because the sample spreadsheet
uses only the default attributes.
To create new meta fields follow these steps here.
l

Go to the Administration system in Commerce Manager.

l

Select the "Catalog System" folder and then "Meta Classes" node located in the left navigation frame.

l

Select Create New, then New Meta Class from its pull-down menu.
l

Enter in a Name, Friendly Name (e.g., Baby Catalog), and some description
(optional) for the meta class, and choose "Catalog Entry" for Entry Type.
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l

l

Click OK to save the new class.

Next Select Create New, then New Meta Field from its pull-down menu.
l

Enter in a Name, Friendly Name (e.g., Baby Diaper Size), and some optional
description.

l

Also Choose the data type for this meta field and other properties by clicking on
the check boxes.

l

l

Click OK to save the new field.

l

Repeat the steps to create all the necessary fields.

Associate the new meta fields to the meta class you created.
l

Select to "Meta Classes" node on the left navigation frame again.

l

For "Element" choose "Catalog Entry" in the pull-down menu.

l

Under "Type" choose your meta class (e.g., Baby Catalog) you created earlier.

l

Select the desired meta fields from the list displayed at the bottom of the
screen.

l

l

Select OK to save the new meta class to fields association.

You are done with setting up your meta fields.

Step 3: Upload the CSV data files to the CSV import page
Follow these steps to prepare the CSV files for import:
l

Select Catalog Management.

l

In the upper-left detail area, click on Catalogs folder and you will see the Catalog List view in
the main area.

l

In the action area above the main view, click the Import/Export drop-down button and select
CSV Import Catalog.

l

You will now see the CSV Import Catalog page in the main screen. The screen contains two
tabs 1) CSV Import and 2) Mapping File.

CSV Import Tab
l

In the "CSV Import" tab in the main view, add a file to import using drag-and-drop from the
source location.

l

The CSV file you uploaded will be added to the "Files available for import:" list.

l

Repeat the previous four steps for each CSV file you wish to upload.
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Figure 10
Step 4: Create a mapping file for each CSV file
Now create a mapping file that will specify the data in the CSV file to its corresponding attributes in
the Commerce Manager.
Mapping file tab
l

Click the "Mapping file" tab in the main view. You will now see the "Mapping file" tab view of
the CSV Import Catalog view as shown below.
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Figure 11
Edit existing mapping file section
l

Load mapping file: This section is used to retrieve previously created and saved mapping
files. Since there is no existing mapping file in this example, leave this section blank.

Meta Class, Language section
l

Mapping Type*: Select "Category w/ Meta Data"

l

Meta Class*: Select "Default Catalog Node"

l

Language*: English

Data fle and CSV adjustment section
l

Data File*: The drop down values presented here are dependent on the different CSV data
files you uploaded on the "CSV Import" tab in step 2.

l

For this example, first choose "BabyStuffCategory.csv."Leave the rest of the field as default
and move on to the next section.

Fields and Attributes, Column headers in the data file, and Selected values section
The values presented under the "Fields and Attributes" column are representative of the "Meta
Class" selected in the "MetaClass, Language" section above (which were either previously imported
or created within Commerce Manager).
The values presented in the drop-down menus under the "Column headers in the data file" column
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are representative of the "Data file" selected in the "Data file and CSV adjustment" section above
(which were previously imported above).
l

Select the appropriate "Column header" drop-down value to "map" with the MetaClass
"Fields and Attributes" to the left; the value selected will be reflected in the "Selected values"
column to the right.

Save mapping file section
l

Enter a file name for the "Enter file name" textbox. For this example, save the mapping files
using the same CSV file names.

l

Click the "Save" button. The browser returns to the CSV Import tab, and the mapping file in
.XML format will be added to the list in the "Choose mapping file" section.

l

Repeat Step 3 to create and save a mapping file for each CSV files you wish to import.

l

For CSV Entry files, select the "Entry w/ Meta Data" option under "Mapping Type."

l

For CSV Entry Relations file, select "Entry Relation".

l

For CSV Associations file, select "Entry Association."

l

For CSV Pricing/Inventory file, select "Variation w/ Inventory."

l

For CSV Sale Pricing file, select "Sale Price."

l

When all the mapping files are saved, your CSV Import tab screen should look something like
this.

Figure 12
Step 5. Import the CSV files and their corresponding mapping files into a specific catalog
At the "CSV Import" tab view (Figure 12), do the following:
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l

Select and highlight the CSV file you wish to import in the "Files available for import" section.
For this example, select BabyStuffCategories.csv.

l

Select and highlight the mapping file that corresponds to the selected CSV file in the "Choose
mapping file for import" section. For this example, select BabyStuffCategories.xml.

l

Select the catalog in the "Catalog" drop-down into which you would like to import your CSV
data. In this example choose "Baby Stuff".

l

Click the "Start import" button. You will see the "Importing catalog" modal dialog box which
will notify you of the percentage of completion as well as logging messages.

l

Click "Close Window" at the bottom of the modal dialog to complete the operation.

l

Repeat Step 4 to import all the remaining CSV & Mapping pairs.

Step 6. Verify your import
In the Catalog Management system, expand the "Baby Stuff" folder under Catalog and verify that
the contents of your CSV file were imported into the appropriate catalog.

Browsing and searching catalogs
Catalogs and their related products and variants, can be viewed and explored under Catalog in the
Commerce submenu. You can also search for specific catalog entries such as products and variants (SKUs).

Browsing catalogs
Click on Catalog to browse the list of catalogs. In this example, there are multiple catalog nodes
with different types of products.
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Click on a catalog node (category) to expand the underlying subcategories, which will be displayed
in the main content area. The listing here displays an overview with the name, code, price, and availability for products and their variants (SKUs). The catalog listing can be filtered per market using the
Market selector at the top. You can also display thumbnail images for catalog entries.

Click on a category and "drill down" until you see products, packages and bundles. Click on the
arrow next to a product, package or bundle to expand the list to display related products and variants. When displaying variants you will see the stock availability and pricing information.

Click on a product/variant to view and edit the content for the item. For more information on how to
edit products and variants, refer to Editing and publishing catalog entries.
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Searching for catalog entries
To do a basic search for catalog entries from the Catalogs view, enter one or more keywords into
the search field.

If you enter keywords inside quotation marks ("barbra paperback"), then search will only fetch
entries that have those exact keywords. Refer to the Search section in the CMS Editor User Guide
for more information about search features in EPiServer.

Accessing products in CMS
You can also access entries in the product catalog from CMS > Edit through the Catalogs gadget
in the assets pane. This is useful when you want to drag-and-drop catalog entries into content areas
in CMS pages or blocks. Refer to Managing content for more information on how to work with content items.

Creating and editing catalogs
When creating a catalog manually, you start by defining the catalog properties and then continue
adding catalog entries such as products and their variants. The catalog content can either be imported from an external source, or created manually in the catalog user interface.

Creating a catalog
Catalogs are created from the Catalogs user interface.
l

Catalogs can only be created under the catalog root level, meaning for instance that you cannot create a catalog under another catalog in the catalog tree.

l

Select the Catalog Root, chose the New option from the context menu, or click the add button at the top.
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l

Enter the catalog details as described below. The catalog will be autosaved by the system,
and will not be available on the website until published.

Editing a catalog
The properties described below are available when editing a catalog.
l

Name - this name will appear in the catalog listing.

l

Name in URL - link automatically created based on name and place in the navigation,
depends on the implementation if this is visible in links on the site.

l

Default currency - the default currency to be used for catalog entries. Available currency
options here are defined in Commerce Manager.

l

Default language - the "master" language to be applied for catalog entries.

l

Base weight - the "standard" weight unit that will be applied to catalog entries. This is used
for instance when calculating weight values for shipping totals in the checkout.

l

Available languages - select the additional languages in which the catalog content will be
available. Refer to Managing multi-lingual content in the CMS Administrator User Guide for
more information on how to work with languages for catalog content.

Catalogs and languages
Catalog properties are "global", meaning that they have the same value for all languages and can
only be edited from the default "master" language. Switch to the default language if you need to edit
these. The default language is usually the first language listed next to Languages in the header. The
catalog language settings will be inherited by all catalog entries.
Changing the default language for a catalog is rarely needed, but be aware that if you do
this some catalog properties might end up having empty values.
Refer to Managing multi-lingual content in the CMS Administrator User Guide for more information
on how to work with languages in EPiServer Commerce.
Publishing the updated catalog
Just as when you edit other types of catalog content, a draft version will be created when you
change catalog properties. The changes you make will not be visible on the website until they are
published, following the normal content publishing flow in EPiServer.
Refer to Publishing and managing versions in the CMS Editor User Guide for more information on
how to publish changes.
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Deleting a catalog
Be aware that deleting a catalog may cause things to stop working on your site. Before
deleting your catalog you may wish to export it to be saved for future use. The delete operation may take some time depending on the size of the catalog.
Select the desired catalog in the catalog tree, select Delete in the context menu, and Delete Catalog to confirm the deletion.

Creating catalog entries
The Catalog interface in EPiServer Commerce provides multiple options for working with catalog
data. Marketers may want to create new products and variants, and merchandisers may want to
enrich new products that are being added to the e-commerce channels. For e-commerce solutions
integrated for instance with an external ERP system, products may already exist with core data and
need only to be completed inside EPiServer Commerce. In other scenarios, new products may be
created from scratch.
These are common tasks when working with catalog entries:
l

Locate "incomplete" products added from integrated systems, add content and media, and
then categorize and publish them.

l

Create products, add content and media provided from external sources, and then categorize
and publish them.

l

Adding product code, internal and display name, properties, media and corresponding prices
and inventory, to product variants.
When creating catalogs you should carefully consider the catalog structure for maintenance and performance reasons. It is recommended not to build too deep hierarchies of
categories, products and variants in your product catalog. However, a flat catalog structure with too many entries in the same category can have a negative impact on performance.

Creating a catalog entry
Catalogs can be imported into the system, or manually created. Here we assume that you already
have an existing catalog in your system, and want to add one or more entries to the catalog.
Catalog entries can be of the following types:
l

Product - various forms of merchandise available for website display and purchasing.

l

Category - a grouping of purchasable products.

l

Variant or SKU - a specific type of product with specific characteristics.

l

Package - contains multiple products or variants, with a single unique pricing for the entire
package.

l

Bundle - a collection of variants with individual pricing, allowing customers to purchase two
or more items at once.
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New entries can be created either from the context menus in the catalog tree or the main listing, or
from the add content button at the top. When expanding the catalog tree, different options will be
available depending on the context in which you attempt to create a new entry.

For instance, selecting a category node allows you to create either a new category, a product or a
variant (SKU). When selecting a product, you can create either a new product or a variant (SKU).
Since variants belong to the lowest level in the product hierarchy, adding subentries will not be possible for variants, there will only be an edit option. Packages and bundles can only be created under
categories.
The catalog tree does not display products or variants, only category nodes. Use the
main catalog entry listing in the middle to access options for products and variants
(SKUs).
Creating a category
Categories can have their own rich content including assets, for instance descriptions of "wine
regions" for a subset of wine products.
1. Expand the catalog tree or click in the main catalog listing and navigate to the desired catalog
or category node. Or, use the catalog search feature to find the product you want to work
with.
2. Chose the New Category option from the add button at the top or in the context menu for
the item in the listing.
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3. Enter a name for the category and select the appropriate product category type (meta class).
The system will suggest types based on the context and previous similar previous actions.

4. Complete the category details as desired. The item will be autosaved by the system, and will
not be available on the website until published. Refer to editing and publishing catalog entries
for more information on how to edit and publish product content.
Creating a variant (SKU)
Catalogs may contain only products, both products and variants, or only product variants. In this
example we will create a variant (SKU).
1. Expand the catalog tree or click in the main catalog listing and navigate to the desired catalog
entry (category or product). Or, use catalog search to find the product you want to work with.
2. Chose the desired catalog entry to add by selecting it from the add button at the top or in the
context menu for the item in the listing. In this example we will select a product to create a
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variant of this.

3. Enter a name for the variant and select the appropriate variant type (meta class). The system
will suggest types based on the context and previous similar actions.
4. Complete the variant details as desired. The item will be autosaved by the system, and will
not be available on the website until published. Refer to editing and publishing catalog entries
for more information on how to edit and publish product content.
Duplicating catalog entries
Duplication allows you to replicate an existing entry to be used as a start-off for a second one. A
duplicated catalog entry will be created with a unique ID. Once created you can edit the item to create a second similar item and also move it to any desired location in the catalog tree. You can duplicate a single catalog entry, or a selection of multiple entries.
When duplicating catalog entries, the following information will be available:
l

Category - a new code will be created based on the original, as well as name in URL and
SEO URL. Name and internal name will be the same as for the original, and content will be
duplicated. Subentries such ans products and variants in the category will not be duplicated.

l

Product - a new URL name, SEO URL and product code will be created based on the original. Name and internal name will be the same as for the original, as well as market availability. Content for the product will be duplicated.

l

Variant (SKU) - a new URL name, SEO URL and product code will be created based on the
original. The internal name will be the same as for the original, as well as market availability.
Content for the variant will be duplicated, as well as pricing information.

In this example we will duplicate a selection of multiple variants and add them to another category in
the catalog tree.
1. Expand the catalog tree and navigate to the desired catalog or category node, so that
products and variants are displayed in the main listing.
2. In the list, select the checkboxes for the desired items to be duplicated.
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3. Drag your selection to the desired location in the catalog tree.

4. Click Duplicate in the Paste Item dialog.

5. The selected catalog entries will be duplicated in the desired location.
You can also use the Copy/Paste options in the list menu for duplicating multiple entries, or the
Copy/Paste option in the Context menu to duplicate a single catalog entry. Refer to Product categorization for more information on how to move and link catalog entries.

See also
Refer to the following sections for information about editing, deleting and categorizing catalog
entries:
l

Editing product categories

l

Editing products and variants (SKUs)

l

Editing product packages and bundles

l

Product categorization

Editing catalog entries
Editing catalog entries involves adding or changing content such as SEO information, internal or
display name, media or product relations. It also involves deleting catalog entries, for instance
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variants of a product. It is also possible to work with pricing and inventory information, although in
many cases this information comes from integration with external systems and may not be possible
to update in EPiServer Commerce.
If the e-commerce system is integrated with for example an ERP system, data regarding products,
prices, and inventories may be imported into EPiServer Commerce, and the information is then
enriched from there.
A common scenario can include the following steps:
l

An import job creates products with "raw" data from the ERP system.

l

Commerce editors enrich the product information with additional content and images.

l

The content is reviewed and then published.

Catalog entries can be of the following types:
l

Category - a grouping of purchasable products.

l

Product - various forms of merchandise available for website display and purchasing.

l

Variant or SKU - a specific type of product with specific characteristics.

l

Package - contains multiple products or variants, with a single unique pricing for the entire
package.

l

Bundle - a collection of variants with individual pricing, allowing customers to purchase two
or more items at once.

Editing a catalog entry
Here we assume that you already have existing catalog entries which you want to update. Refer to
Creating catalog entries for information on how to create catalog entries.
Catalog-specific editing options
In Commerce, you will find a view selector with additional options in addition to All Properties and
On-Page Editing views. Using these you can work with items in a list, or access the pricing and
relations views for a selected category or product.

Properties
A property is a field where you will enter information, for instance a product description or a link to
an image. The properties that you will see when editing content are both built-in EPiServer properties
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as well as customized properties for templates on your website. This description refers to properties
in a standard installation of the EPiServer Commerce sample site.
Drag-and-drop
Drag-and-drop functionality is frequently used in EPiServer. You can for instance add assets by dragging items from the Media gadget in the assets pane into the assets area of a product, or add an
image to a product description by dragging the image from the Media gadget into the rich-text editor
of a product description.
Saving and publishing
After editing a catalog entry, you can either publish the changes directly, or schedule for later publishing using the save and publish flow for content in EPiServer. Note that certain information such
as pricing, will be immediately published when edited.
Deleting catalog entries
You can delete products and variants, as well as entire product categories and their related products,
when maintaining your product catalog. Refer to Editing product categories, Editing products and
variants, and Editing packages and bundles for information on how deletion of different types of catalog entries works.
Translating catalog content
Like other types of content such as pages and blocks, catalog entries can exist in multiple languages. Refer to Multi-language management for more information on how to translate catalog
entries.

Editing multiple catalog entries
When displaying a listing in the item list area, you can work with several catalog entries at the same
time by selecting a number of items in the list, and then apply actions such as cut, copy, paste,
detach and delete from the toolbar.
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See also
Refer to the following sections for information about editing, deleting, categorization and translation
of catalog entries:
l

Editing product categories

l

Editing products and variants (SKUs)

l

Editing packages and bundles

l

Product categorization

l

Multi-language management

Editing categories
As a merchandiser you may want to review and update your category structure and the content
saved for a category. Category content can easily be updated, previewed and saved and published.
You can delete a category and the system will completely remove all links and leave other category
links intact.
Here we assume that you already have an existing product catalog with categories in your system,
and want to update the existing category information, or delete the category entirely.
Refer to Editing products and variants for more detailed information about editable properties.
Editing a category
Do the following to edit a product category:
1. In the Catalog view, select the desired product category in the catalog tree.
2. Select Edit in the context menu for the selected category.
3. Update the category information you want to change, for instance the name or
SEO information, or the category description.
4. After editing the category information, you can either publish the changes directly, or schedule for later publishing using the save and publish flow for content in EPiServer.
Deleting a category
When deleting a category the following will happen depending on how the category is linked to other
catalog entries:
l

If the category is linked to catalog entries that are also linked to other categories, then all links
to the deleted category will be completely removed, and the other category links will be left
intact.

l

If there are categories, products and variants that are linked only to the category to be
deleted, these entries will be deleted as well.

To delete a category, select the category in the catalog tree, select Delete from the context menu,
and click Delete to confirm the deletion. You can also select Delete from the context menu for the
category in the item listing, or from the upper menu.
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To delete multiple catalog entries at the same time, select the entries in the item list and click the
Delete button in the menu.
Be aware that deletion of catalog entries cannot be undone. When deleting a category
with many subitems, the deletion may take some time before it is completed.

Editing products and variants
Editing of products and variants is typically done when you want to add information to existing
(incomplete) entries that have been imported to the system, or want to add one or more entries manually. You can also delete a product or a variant. Furthermore, you can create relations between catalog entries by adding them in multiple categories, or by associating items with each other for
instance for cross-selling purposes.
In the sample site the editable properties for products and variants are almost the same. The only difference is that if you have both products and variants in your system, pricing and inventory options
will not be available for products since these are normally defined on variant (SKU) level. For
products you will also see a tab displaying variants (SKUs) related to the product. Categories also
have some of the properties described here.
Changes to existing relations and pricing will be immediately published and visible on
the website, and is not included in the publishing flow for the rest of the content. Changes
to content and assets must be actively published to become visible on the website.
Refer to Publishing and managing versions in the CMS User Guide for more information
about the publishing process.
Product and variant (SKU) properties
This section describes properties in the EPiServer Commerce sample templates, as they appear
when editing them from the All Properties view. Some of the properties in a template are default, and
some are template-specific for the website.
Administrators and developers can define meta fields for enriching product information, for instance
"fabrics" for clothing, or "genre" for media. Dictionary type values such as "silk" or "satin" can then
be added from Settings in the global menu, to become available for editors when editing catalog content.
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Header
The header area provides an overview of information associated with categories, products and variants. Much of this is created automatically and will rarely need to be changed, unless you are manually creating catalog entries.
At the very top you can see the structure path (clickable) for the entry, together with the type of entry
and its name.
l

Display name - will be displayed externally as the main title for the product/variant on the content display page.

l

Name - name used internally in edit view when working with the item. This is also the name
that you provide when creating a new catalog entry, and the name you will see in catalog listings.

l

Name in URL - URL automatically created based on name and place in the navigation,
depends on the implementation if this is visible in links on the site.

l

SEO URL - created automatically and based on the internal name first provided, depends on
the implementation if this is visible in links on the site.

l

Code - the product code/identification key, most often provided by an external system but
can be updated here.

l

Markets - for changing market availability, by default a product/variant is available in all markets when created.

l

Visible to - by default catalog content will be publicly visible and editable for users within the

CommerceAdmins group.
l

Languages - shows available languages for the content (with the active language not underlined).

l

ID, Type - shows the ID set by the system and the type of content upon which the product or
variant is based.

Content
The Content tab holds most of the information for the product/variant. The properties here are specific for the implementation and will vary depending on the product/variant type (meta class) upon
which the product/variant is based. For a "book" type of product/variant, the fields can be for
example "media type" and "author".
The description is often a rich-text editor where you can add for example formatted text, images and
links.
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Pricing
The Pricing tab offers an overview of prices for the selected variant (SKU). The Tax Category can
be set here, allowing you to associate a variant with different taxes depending on product type, for
instance, "luxury items" or VAT for different regions. Tax categories are defined in the administration
interface in Commerce Manager, and will be available for selection here.
Clicking Edit prices will take you to the view for managing pricing, where you can efficiently compare prices between products and markets when editing them.

Refer to Managing prices for information on how to add and edit prices for variants (SKUs).
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Inventory
Most often the information on the Inventory tab is retrieved through the integration with external systems, in which case it will rarely need to be changed from here, or may not be possible at all to edit.
On the sample site, you can add information about quantities and shipping dimensions, but the
information related to inventory locations is read-only.
The following properties can be edited for a variant:
l

Max. Quantity - the maximum number of items that can be purchased at one time.

l

Min. Quantity - the minimum quantity that can be purchased from the variant page.

l

Tracked - if selected for the variant, you will be unable to complete orders unless you provide
inventory information (see Inventory Location, below). If Tracked is not selected you can
place orders without providing inventory amounts

l

Weight, Length, Height, Width - these properties are used for calculating the shipping cost
based on the shipping configuration.

Inventory location displays the information as described below.
l

Location - the physical stock location of the inventory, as defined in the warehouse settings.

l

Quantity - total available quantity for a specific location.

l

Reserved - define a quantity allowing you to reserve a specified number of inventory "In
Stock", and prevent them from being used. If for instance you set the In Stock = 10 and
Reserved = 5, then the In Stock count will not go below 5.

l

Allow backorder/preorder - if selected, backorders/preorders will be allowed.
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l

Backorder/preorder availability - when either of the two are turned on and a quantity is specified, the count will begin to decrease after the "In stock" count reaches its limit. For
example, if you set In stock = 10, Reserved =3, and Backorder =10, then the Backorder
quantity will start to decrease after In Stock count reaches 3. So if you place an order for 10
units, then the final count will be In Stock = 3, Reserved =3, and Backorder = 7.

l

Inventory status - this value can be set to "Enabled", "Disabled" or "Ignored". If this is
enabled, the number of units of a product being purchased cannot exceed the inventory value.
This means that the check out procedure cannot be completed if the number in the inventory
is exceeded. Instead, the quantity you can purchase will default to the actual number of
remaining units.
If Tracked for a product variant is selected, and Inventory Status is set to Disabled/Ignored,
then the available quantity will be monitored, but the number of units that can be checked out
will not be limited. If you only have a quantity of 5 and you order 6 items, the checkout will still
complete and the inventory number will become -1. The inventory status for a particular warehouse is generally considered more important than the tracking flag on the variant itself.

Assets
The Assets tab is where you will link media files to a catalog entry. A media file can be one or more
images, or one or more document in for example PDF format. Add media files of your choice by dragging items from Media in the assets pane into the assets area of the catalog entry.

You can also use the Add Media button to add asset items. Using the move up/down options in the
context menu for an item, you can rearrange the order of items in the list. On the sample site, the
item tagged with the "default" group at the top of the list will be the one used for the main display.
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When uploading media items, you can also sort them into groups, for instance "Banner".

Variants
The Variants tab is only visible for products and provides an overview of variants for a product. Click
Edit variants to add or remove variants for the product.

From this view you can add variants for the product either by dragging them from Entries in the
Assets pane, or through the Add Variant button. To remove a link to a variant, click the Remove button for the variant in the item list. When done, click Back in the upper notification bar to return the
product you were working with.
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Relations
The Relations tab provides an overview of how a product or variant relates to other products and
variants, as well as all the different categories where a product or variant will occur. Relations can be
used to promote new, popular, or sale products by displaying them as featured products in category
and search result pages.
A product can for instance appear in the "French Market" category, as well as under "Weekly Specials" and "Mixed Cases". These type of relations are displayed in the Categories section. You can
also display top selling products in your store, as well as create up-selling/cross-selling items like
"Product Accessories" or "You May Also Like" type of displays. These types of relations are displayed in the Related Entries section.
Click Edit categories or Edit related entries to edit relations.
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Editing category relations
From Edit Categories you can create category relations either by dragging categories from Entries
in the Assets pane, or through the Add Category button. To remove a category relation, click the
Detach button for the category in the item list. When done, click Back in the upper notification bar to
return the catalog entry you were working with.
The top category is always the "home" location of products, meaning that the product is
located here and linked to other categories. When you edit a product, the selection in the
catalog tree will jump to the home category. If URLs based on the "Name in URL" property are used, the URL will automatically be based on the path from the home category.
This is important for instance if you move another category to become the top location,
then products will be moved and their URLs will change accordingly.
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Editing related entries
From Edit Related Entries you can create entry relations either by dragging entries from Entries in
the Assets pane, or through the Add Entry button. You can also Edit, Duplicate or Delete a related
entry by selecting these options in the context menu for the item.

You can have different relation entry types available for selection when editing. These are implementation specific and cannot be changed from here. If these are available you can click an entry in
the list and select the desired related entry type.
When done editing relations, click Back in the upper notification bar to return the catalog entry you
were working with.
Settings
The Settings tab is a default tab in EPiServer containing a set of built-in date-related properties
which you rarely need to change. Refer to Editing content properties for more information about the
options here.
Deleting a product or variant (SKU)
When deleting a product or a variant (SKU) the following will happen depending on how the entry
you want to delete is related to other catalog entries:
l

If a product is deleted, all links from other catalog entries to the product will be removed.

l

If a product with associated variants is deleted, the variants will be left associated with the
same category as the deleted product.

l

If a variant is deleted, all links from other catalog entries to the variant will be removed.

To delete a product or variant, select Delete from the context menu for the item in the item list, and
click Delete to confirm the deletion.
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To delete multiple catalog entries at the same time, select the entries in the item list and click the
Delete button in the toolbar.
Be aware that deletion of catalog entries cannot be undone.
Use the Detach option in the toolbar to remove a link between catalog entries. Linking is used when
you want a catalog entry to appear in multiple categories, or when cross-selling related items. Refer
to product categorization for more information on how to manage catalog entry links.

Editing packages and bundles
A product package contains multiple products or variants, with a single unique pricing for the
entire package, whereas a product bundle is a collection of variants with individual pricing, allowing
customers to purchase two or more items at once. The editing of packages and bundles are similar
to the editing of products and variants, except in that the properties available for editing will be somewhat different.
Here we assume that you already have existing product packages and bundles that you want to
update in your system. Refer to Creating catalog entries for information on how to create packages
and bundles.
Editing a package or bundle
This section describes properties in the EPiServer Commerce sample templates, as they appear
when editing them from the All Properties view. Some of the properties in a template are default, and
some are template-specific for the website. The Settings tab is a default tab in EPiServer containing
a set of built-in date related properties which you rarely need to change.
Here we will discuss the usage of tabs and properties for packages and bundles. Refer to Editing
products and variants for more information on tabs and properties that are available for both
products, variants, packages and bundles.
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Pricing
Since unique pricing can be set only for packages and not bundles, the Pricing tab is only available
for packages and will provide an overview of the pricing for that particular package, for your different
markets and customer groups. Click Edit prices to compare and edit the price for the package, refer
to Managing pricing for more information on how to edit prices.
Inventory
A package is a physical assembly of a set of products or variants (SKUs), and will therefore also
have inventory information attached, which a bundles will not have. The Inventory tab for packages
provides an overview of inventory status information, which is often retrieved from external systems. Refer to Editing products and variants for more information on how to work with inventory
information.
Assets
Just like products and variants (SKUs), packages and bundles can have associated assets such as
images and documents. Add media files of your choice by dragging items from assets pane into the
assets area of the package or bundle, or use the Add button. Refer to Assets in the CMS Editor
User Guide for more information on how to work with assets.
Relations
Packages and bundles can also have relations to other categories in the catalog tree, or products or
variants. The Relations tab provides an overview of the existing relations for the package or bundle.
Click Edit categories or Edit related items to edit the information. Refer to Editing products and
variants for more information on how to edit relations.
Package entries
The Package Entries tab provides an overview of entries included in the package. Click Edit
entries to edit the information. Add catalog entries to the package, either by dragging them from
Entries in the Assets pane, or by using the Add Entry button. Click the Manage Entry Groups button to add package groups to associate packages with. The same groups will be available for
bundles.
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When done, click Back in the upper notification bar to return the package you were working with.
Bundle entries
The Bundle Entries tab provides an overview of entries included in the bundle. Click Edit entries to
edit the information. Add catalog entries to the bundle, either by dragging them from Entries in the
Assets pane, or by using the Add Entry button. Bundle entries can be associated with the groups as
created for packages above.
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Deleting a package or bundle
When deleting a package or bundle, the item will be deleted and all links from related products and
variants to the current package or bundle will be removed.
l

To delete a package or bundle, select Delete from the context menu for the item in the item
listing, and click Delete to confirm the deletion.

l

To delete multiple catalog entries at the same time, select the entries in the item list and click
the Delete button in the toolbar.
Be aware that deletion of catalog entries cannot be undone.

Product categorization
Using product categorization you can work with your product catalog to adjust the structure and
range in order to optimize the selling potential of products. You can search for products or a collection of products, and assign these to different categories through the creation of relations. You
can also copy or move a product or collection of products between categories, or detach a product
from a category. The Relations tab provides an overview of relations for a catalog entry.
When creating catalogs you should carefully consider the catalog structure for maintenance and performance reasons. It is recommended not to build too deep hierarchies of
categories, products and variants in your product catalog. However, a flat catalog structure with too many entries in the same category can have a negative impact on performance.
Categorization involves the following tasks:
l

Moving allows you to control the structure of your catalog after entries are created, by moving them to another location in the hierarchy. When moving a category or product to a new location in the catalog tree, the related products and variants will also be moved, and any
existing links to other catalog entries will be kept intact.

l

Linking allows you to create relation links between entries in the catalog hierarchy. For
example, you can create a category called "Featured Products", and link a product in the
"Sport Shoes" category to this to this, without having to duplicate any entries. The item will
be visible in both categories, and can be updated from any of these locations.

l

Detaching allows you to remove a relation link from a product or a variant to a category, for
instance for a product that appears in two categories "Sport Shoes" and "Featured Products".

Moving catalog entries
In the example below we will move a product to a new location, but the procedure is similar for moving a category or a variant.
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1. In the Catalog view, select the desired product in the main listing.
2. Drag the product into the desired location in the catalog tree to the left.

3. Click Move in the Paste Item dialog.
You can also use the Copy/Paste option in the context menu to move catalog entries.

Linking catalog entries
In the example below we will create a relation link from a product in one category to another category, but the procedure is similar for the linking of a variant.
Do the following to create a link from a product to a category:
1. In the Catalog view, select the desired product in the main listing.
2. Drag the product into the desired location in the catalog tree to the left.
3. Click Link here in the Paste Item dialog.

Detaching catalog entries
Do the following to detach a link between a product or a variant and a category:
1. In the Catalog view, navigate to the location in the catalog tree where the desired catalog
entry to detach is located.
2. Select the product or variant in the main listing, and then select Detach from this category
in the Context menu, or click the Detach from this category button.
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To detach multiple catalog entries at the same time, select the entries in the item list and click the
Detach button in the menu.
If a product or variant is linked to only one category, the detach option will not be available. This is to avoid that products or variants become "orphans" without a category location, and difficult to locate in a product catalog.

Viewing relations
To view relation links for a product or a variant, select the item in the main listing to access the All
Properties editing view and go to the Relations tab.

In addition to category links, there are also other types of links between items in a product catalog.
Refer to Editing products and variants for more information on how to work with links.

See also
Refer to the following sections for information about creating, editing and deleting catalog entries:
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l

Creating catalog entries

l

Editing catalog entries

Managing pricing
The Edit Prices overview provides a convenient way of viewing and editing pricing within product
catalogs. Using this view you can review a compact list of prices by market or customer group.
Prices are displayed in the default currency for a market, together with minimum quantity and availability date for the defined price. There might be multiple prices with different currencies for the same
market. Both active and inactive markets will be displayed in the market filtering. You can also add
prices to variants (SKUs) from this view.
Changes to the pricing information for a catalog entry will be instantly available on the
website, and is not included in the saving and publishing flow for the rest of the content.

Viewing prices
Do the following to view prices:
1. In the Catalog view, navigate to a category to display products and variants in the main listing.
2. Select Pricing from the view selector in the upper right corner to access the pricing editing
view.
3. Use the filtering options on top for Customer Group and Market, to filter the price list and
make it easier to locate the desired pricing information
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Note that only catalog entries with a price will appear in this listing, even if the catalog
entry is published. This means that if you have added new variants for a product, and
these have no price, you will not see them in the pricing overview.

Adding and editing prices
Adding a price for a variant (SKU) is done from the Pricing tab in the All Properties view when editing product variants (SKUs) or packages. To add a price for a variant, click Add Price and enter the
desired pricing information. See below for a description of editable pricing properties.
Prices must be added first to become available for editing in the Edit Prices view.

To work with prices, select a category, product or variant and select the Pricing option. Or, open the
item (variant) for editing, select the Pricing tab end then Edit prices.
The following information is available for editing:
l

Sale Type - associate the price with either All Customers, a specific Customer or a Customer Price Group. With the last option you can create tiered pricing (differentiated pricing,
see below).

l

Sale Code - used for assigning a price to a specific group of customers. For instance, when
you add a new price and select "Customer Price Group" as type, you put the name of the cus-

tomer group in the Code field. If the Code field matches a customer group, any member of
that group will receive the specified price.
l

Market - associate the price with a market for your website.
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l

Currency - associate the price with a currency, to create different prices depending on the
selected currency.

l

Price - the price that will be displayed on the public site.

l

Date from/to - the time interval when the price will be available.

l

Min. quantity - the minimum number of units that must be purchased to get a discounted bulk
rate.

Duplicating and deleting prices
l

Select Duplicate in the context menu for the entry you want to duplicate, to use as a foundation when creating a new pricing item. Edit the information as desired and click Save when
done.

l

Select Delete in the context menu for the entry you want to delete, and click Yes to confirm.
Note that the deletion of a price cannot be undone.

Setting pricing by customer group
Customer groups are useful for instance when setting specific permissions and creating targeted
marketing campaigns. Customer groups must be created in Commerce Manager first to become
available when adding price information.
To create a customer group-specific price, select "Add Price" in the Edit Prices view, select "Customer Price Group", and then the customer group for which the price should apply.

See also
Refer to Editing catalog entries for more information on how to edit other properties for catalog
entries.

Catalog batch update
As a catalog grows larger, you will want to utilize the batch update tool to update multiple catalog
entries at once. The Catalog Batch Update option in Commerce Manager allows you to quickly
make multiple changes to your catalog without having to update each catalog entry individually.
When searching for catalog entries to update, you can narrow down you results by using a set of filters.

Updating multiple catalog entries
Do the following to update multiple catalog entries:

© EPiServer AB

68 | EPiServer Commerce User Guide update 15-1

1. Go to Catalog Management > Catalog Batch Update. The Batch Update screen appears.

2. The Main Adjustment filters are divided by Entry Type, Meta Class, and Field. Entry
Types in the drop down menu include Product, Variation/SKU, Bundle, and Package. The
Meta Class and Field drop down menus depend on the Meta Class you selected, your selection will then populate the Field drop down selections.
3. To narrow down your results, you can use the additional filters: Language, Catalog and Keywords. If your entries are in more than one language and you want to edit a specific entry in
another language, you would want to apply the Language filter. If you want to narrow the results to a specific catalog, use the Catalog filter to search for entries within that catalog. To narrow your search even further, enter in Keywords, such as "Wine Glass" (without the quotes).
4. Within your search results, you can click on a specific catalog entry and go directly to its edit
page. Or by adjusting the Field drop-down menu, you can select which field you want to directly edit. For example, if you have a list of variation/skus, and you want to change the display price for all of them at once, you can change the Field drop-down menu to "Variation :
Display Price." The right column will then change, allowing you to directly edit the display
price for all the catalog entries at once.
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5. When you are satisfied with your changes, click on Save All.
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Orders
Order Management is a central part of the e-commerce system. Since the majority of orders will be
created from the front-end site, the ordering process is usually automatic following an order management workflow, but in some cases orders need to be manually managed. The Order Management
system provides shopping carts (baskets), order capture, order fulfillment, payment functions and
item return or exchange support.

Meta classes and fields for products
You can define your own meta classes and meta fields for both products and orders in Commerce Manager. For instance, if you create a meta class called "Wine" you will want to add meta
fields that are characteristic for wine, for instance "color", "taste", "vintage" and "maturity".
When meta fields and classes have been created, they will be available for usage when working with
the product catalog. Meta classes and fields for catalogs are defined in the Catalog System part of
System Administration. For more information, refer to Catalog meta classes and fields.

Working with order management
The work with orders includes the following tasks:
l

l

Browsing orders for example to monitor order status and find specific orders
Creating orders - different ways of creating orders, adding payment plans and split shipments.

l

Managing shopping carts and turning them into orders.

l

Processing orders - adding payments and preparing the shipment.

l

Managing shipments - processing shipments and creating picklists for orders including
returns.

l

Managing returns and exchanges - processing returns and product exchanges.

l

Editing, canceling and deleting orders - the cancellation and deletion of orders.

Refer to the Shopping process flow section for a general description of the shopping procedure and
system support in EPiServer Commerce.

Browsing orders
The majority of your orders will be created on the front-end by customers in the online store, and you
will most likely have a significant amount of orders in your system. In this section we will describe
different ways of finding specific orders whenever you need to manage them manually.

Using order search to find existing purchase orders
Order Search allows you to find existing orders, giving you six different search filters to help refine
your search results. You can click on the ID number of the order to view it.
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Filter

Description

Name
Class

Select "Purchase Orders" on the drop-down list. Otherwise, if you want

Type

to search for a specific shopping cart or payment plan, select those.

Status

You can filter results by their statuses. For example, if you want to find
only completed purchase orders, select from the drop-down list "Completed".
Available status options are:
l

OnHold

l

PartiallyShipped

l

InProgress

l

Completed

l

Cancelled

l

AwaitingExchange

Date

You can select from date ranges from "today," "last week," or "this

Range

month."

Return #

Enter the return number of a purchase order if a return was created for
that particular order.

ID

You can specify the order ID. Orders created out of the box with
EPiServer Commerce are typically numbered as PO####.

Customer Enter a customer name and the search results will return only orders
filtered by the specified name.
Click on Search to being your search query. The desired results appear below. The results are
broken down by five column fields:
l

ID

l

Customer (name)

l

Total (cost of order)

l

Status

l

Modified (date)

You can sort results by ID, Customer, Total, or Status.
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Viewing purchase orders by date or status
In the left navigation menu, you can click on the nodes below Purchase Orders and Purchase
Orders by Status. For example, clicking on Purchase Orders > Today will show the orders created today only on the right window.

Moreover, you can view orders within the Order List by status. For example, click on Purchase
Orders by Status > InProgress to view orders with that status.

The Catalog Search function enables you look for specific sales items stored in EPiServer Commerce.
Click on Order Management and then Order Search.

Creating orders
Most orders are created by customers from the front-end part of the website, but in some cases it
might be necessary to create orders manually from within Commerce Manager. You can create
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orders either from within Order Management, or directly for a Contact in Customer Management.
The order management option is the most common way to create an order.
Compared to the customer management option, it is faster and has additional alternatives for orders
such as Purchase Order versus Payment Plan. Using the Customer Management system takes a
little longer but allows you to double-check a customer's information before beginning an order.
When an order has been created in this step it appear in the Purchase Orders list with
the order status "In Progress".

Creating an order from order list
1. Go to Order Management > Purchase Orders.
2. Click on New Order. A pop-up appears, allowing you to select the site and contact to apply the
new order to. Use the drop-downs to make your selections. For Customer, if your customer is not listed select More to search for them.

3. Click OK once your selections are made .
Filling out the purchase order
1. Enter basic order information.
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Field

Description

Customer This is the name of the contact.
Currency

Select from the drop-down list the currency to associate with the Purchase Order.

Coupon

Coupon codes created with a promotions can be applied here to associate with the
Purchase Order. Click Apply once code is entered.

2. Click New Item to select the items in the site catalog to associate with the Purchase Order. A
pop-up windows appears allowing you select items from a site catalog.

3. Search for items by entering your search terms into the search field and click Find. You can sort
your search results alphabetically by clicking the Name column. Select an item from the list and
click on Configure Selected Entry.

Advanced search
You can apply three filters to refine your item search results.
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Field

Description

Select catalog

Select which specific catalog to search

Select language

Select a specific language (such as German) for items described in German

Select entry type Select a specific type of entry, such as variation/SKU or bundle
Configuring the selected entry
1. Before you add the item to the order, you can configure the actual price, the quantity, and apply a
percentage or discount based discount.

Required fields
l

Price

l

Quantity

Field

Description

Display
Price

This is the price seen on the public website. This is set at the catalog entry level.

Price

This is the actual cost of the item that will be charged when the item is added to the
order.

Quantity

Set how many of the item to add to the order.

Discount

You can apply a discount to the item, either Value or Percentage based.

Total

The total is automatically calculated, factoring in the actual price, quantity, and any
discounts applied.
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2. Once the item is configured, click Add item to the order. The item will appear on the Purchase
Order form.

Completing the rest of the purchase order form
1. Enter a Billing and a Shipping Address.
When entering the Shipping or Billing Address, you can select an existing address associated
with the contact, if any.

Select Add to customer's address book if you want to save the address to the contact.
If the Shipping Address is the same as the Billing Address, click on Same as Billing
Address. The Shipping Address form is auto-populated with the information entered in the
Billing Address form.
2. Select the kind of shipping to use for the order under Shipment Details. Select from the dropdown the shipping methods (add link) available.
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3. Click on Recalculate to generate the cost summary.

4. Click OK to save the order.

Creating an order within a contact
1. Go to Customer Management > Contacts and create or click on an existing contact. The
contact details appear.
2. Click on New Order.

3. The New Order pop-up window appears. Select the site to apply the order to and click OK.
4. The Purchase Order New form appears, allowing users to enter basic information about the
order.
5. Follow the steps under Creating an Order From Order List above to complete order.
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Processing orders
The order processing or fulfilling, includes adding a payment and releasing the order for
shipping. These steps are needed in order for the order to be completed and ready for shipping to
the customer. When the payment is cleared the order will be released for packing and shipping.
Depending on how your system is set up, this process may be automatically handled by the system.
In these examples we will describe how the procedure is done manually.
When an order has been processed and released for shipping in this step it will have the
status "In Progress" in the order list, and it will appear in the Released for Shipping list
under Shipping/Receiving.

Submitting payment and releasing to shipping
Do the following to add a payment and release an order to shipping:
1. Go to the Order Management and open the order you wish to add a payment for and process.
2. Add a payment to the order.

3. Enter the amount of the payment. The Amount field auto-populates the value of the total
order, including shipping costs. However, you can change the value of the payment (useful
for splitting payments between two or more payment methods at the request of the customer).
4. Select the Payment Method from the drop-down list.
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5. Click OK. The order goes into Edit Mode.

Note: When in Edit Mode, you can add more payments to the order. However, once you click
Save, you finalize the payment. This means that you cannot add or delete any further payments.
6. Once you have finished adding one or more payments, click Save to exit Edit Mode and save
your changes. The payment gets automatically processed for the amount specified.

7. Check the Details tab. You will see that the Shipment Status has changed to "Awaiting
Inventory." Once the availability of the item has been determined, click on Release Ship-
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ment to release the order to your shipping department.

8. By clicking on Release shipment, the status changes to "Released." For further processing
of the order, your shipping department will go to Order Management > Shipment.
If you click Cancel shipment, you will end up canceling the entire order. (At the moment,
there is no way to undo the cancellation, so you must be careful.)
Refer to Splitting shipments for more information on how to split shipments. Refer to Setting up payment plans for information on how to work with recurring payment plans for orders.

Splitting shipments
If there are two or more items within an order, they can be split into separate shipments. This is useful for expediting items within the order that are immediately ready for shipment, while other items
have extra shipping lead time. It can be useful for shipping multiple heavy items to the same customer, back-ordered items, or a large volume of items for ease of delivery and pickup. A shipment
can be split as many times, up to the number of items in a single order. Note that the order must
have two or more items in order to be able to split shipments.
Splitting a shipment for an order
Do the following to split a shipment for an order:
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1. In Order Management, go to an existing purchase order or create a new one.
2. Go to the Details tab in the order form. Look for Shipment # 1.

3. Select the item you want to move by clicking on the Move icon.

4. The pop-up appears, which allows you to choose to move the item(s) to an existing shipment
or create a new shipment. You can also select the quantity of the item to move. Each new
shipment within the order can have its own separate shipping address and shipping method.
Select a shipping address and shipping method from their respective drop-down lists. Click
OK to save your changes.

© EPiServer AB

82 | EPiServer Commerce User Guide update 15-1

5. After splitting the shipments, the order form goes into Edit Mode. The Details page shows the
new shipment, which can be processed completely separate from one another, but tied to a
single purchase order.

6. Click Save to save your changes.

Setting up payment plans
Payment plans work exactly like orders, except that you use them spread out the payments over
time that a customer has to make. This allows flexibility in how you sell your products, as well as
how a customer pays for them. You can use this for large and complicated orders, orders that need
to be shipped in sequence, or just expensive items.
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Payment plans can be setup by the Customer Service Representative (CSR) to generate recurring
payments. An example recurring payment would be for magazine or grocery subscriptions. Payment
plans are handled in the background through the Subscription payment plan scheduled job.
Creating a payment plan
1. Go to Order Management > Payment Plans (recurring). You will open up the Payment
Plans List. To create a new payment plan, click on New Payment Plan.
2. Select a customer contact to attach the payment plan to.
3. The Payment Plan New page appears. Complete the form as you would when creating a
new order.
4. Under Payment Plan Details, you will set the cycles and parameters of the payment plan.

5. Once the payment plan is configured, click OK.
Field

Description

Plan Cycle

You can choose from the following plan cycles, which determine how often
the customer is charged.

(Cycle Mode)

- No Cycle: No recurring payment is created. The customer is charged once
when the initial purchase order is created.
- Daily Cycle: recurring payment happens daily from start date.
- Weekly Cycle: recurring payment happens weekly from start date.
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Field

Description
- Monthly Cycle: recurring payment happens monthly from start date.
- Custom1/Custom2: these are placeholders for developers to create custom
cycles within the Mediachase.Commerce.Orders.PaymentPlanCycle class.

Cycle Length

Entering a value of 1 or higher determines the unit of time for the Plan Cycle.
For example, if the Plan Cycle is set to "Daily," and the Cycle Length is "3,"
then a transaction occurs every three days. If the Plan Cycle is set to
"Monthly" and the Cycle Length is "1," then a transaction occurs once every
month. If "2," every two months, etc.

Max Cycles

Determines the maximum number of cycles to run for this payment plan. For
example, if the Max Cycles is set to "2," then the maximum number of transactions cycles is two and then the payment plan stops. Set the Max Cycles
to "0" if you wish to run the payment plan indefinitely.

Completed
Cycles

This tallies the number of completed cycles so far after the payment plan was

Start Date

Set the start date and time to determine when the payment plan should begin
(beginning recurring transactions).

End Date

Set the end date and time when the payment plan should end (ending recurring transactions).

Is Plan Active

Set "True" to enable the payment plan. Set "False" to create the payment
plan but keep it inactive.

Last Transaction Date

Logs the last transaction date. The date and time already in those two fields

created. When initially creating the payment plan, set this field to "0".

when first creating the payment plan should be kept as is.

Payment plan order detail page explained
The payment plan begins once the first purchase order is generated. The purchase order can be created manually (by clicking on Create First Purchase Order) or automatically by the payment plans
quartz job.
After creating a new payment plan, a new Order page appears. This is slightly altered from the original Order detail page that appears after creating a new order. The changes include:
l

Inability to manage shipments (i.e. release shipments for further processing)

l

An Orders tab that shows a history of processed purchase orders from this payment plan

l

A "Create First Purchase Order" button that a CSR can manually click on to create the first
purchase order related to this payment plan. The button disappears after creating the first purchase order manually or when the payment plan quartz job runs and generates the first purchase order. Once that first purchase is generated, the payment plan goes into effect.

l

The purchase order number that is generated includes the parent ID of the payment plan. For
example, if the payment plan parent ID is 35, the subsequent purchase orders are numbered
as "PO35XXX."
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l

When a payment is added to a payment plan, the customer is not charged. The customer is
charged once the purchase order is generated for the first time (and through subsequent purchase orders). The payment plan simply collects the payment information until converted to a
purchase order.

Editing and canceling a payment plan
1. To edit an existing payment plan, go to Order Management > Payment Plans (Recurring)
or Today/This Week/This Month/All. Click on the payment plan ID number to open the payment plans order details page and make edits.
2. To cancel a payment plan, when editing a payment plan, click on the Summary tab and then
click on Cancel Payment Plan.
Creating a recurring payment plan using Authorize.Net
Out of the box, EPiServer Commerce supports Authorize.net as a recurring payment plan gateway.
For more information on how to setup payment methods, refer to the Payments section.
1. Go to Administration > Order System > Payments > (Language) and create a new payment method or click on an existing payment method (such as "Pay by Credit Card").
2. When setting up the parameters of the payment method, select this class name:

3. Select "Yes" for Supports Recurring.
4. Click OK.
5. Click on the name of the payment method again and click on the Parameters tab.
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6. Configure your Authorize.net account for both regular payments and recurring payments.

Editing, canceling and deleting orders
Orders can be edited after they have been created, which is useful when you need to update for
instance the items for the order or the shipping information. Orders can also be deleted if needed.
Both of these tasks are done from Order Management.
When an order is canceled it will still be visible in the order list but the status will change
to "Canceled". When an order is deleted it will be completely removed from the order list.
Editing an order
Do the following to edit an order:
1. Go to Order Management.
2. In the order list, select the order to edit.
3. Edit the order changing any desired fields under Summary, Details, Payments, Returns and
Notes.
4. When done, save the order by clicking Save.
Canceling an order
Do the following to cancel an order:
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1. Go to Order Management.
2. In the order list, select the order to cancel.
3. Under the Summary tab, click on Cancel Order. This will completely cancel the order. The
status of the order changes to "Canceled" but it will remain in the order list for viewing.
4. The cancellation of the order will be logged under the Notes tab.

Deleting an order
Do the following to completely delete an order:
1. Go to Order Management.
2. In the order list, select the order(s) to delete.
3. Click OK to confirm the deletion.

Shipping and receiving
Shipping and Receiving is split into two areas: shipments and returns. Shipments control both
items released for shipping and "pick lists", or items that have been packed and are prepared for shipping/ready to be picked up. "Returns" are incoming items that have been return by customers for
some reason, for instance faulty items that need to be replaced by exchanges. Returns are processed in a similar way as outgoing shipments.
The final parts in completing the order processing includes these tasks:
l

Creating picklists for picking up the physical items in the warehouse.

l

Completing the shipment by preparing the physical package to be shipped.

Shipments and returns can be viewed and monitored as described in the following sections.

Viewing shipments
The Shipments view contains information as described below.
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Order Created
This column specifies when an order was created. This is useful, for example, if you want to ship
orders by date and time.
Last Modified
If any changes were made to an order, a date stamp for its last modification will be displayed here.
Number #
This column is for the individual IDs assigned to each order. The first number is the unique tracking
number we described under Purchase Orders. The second number is the unique tracking number
assigned to the order for shipping purposes.
Customer
The full name of the customer as it appears on the package. This is useful, for example, if you want
to ship orders all together to one customer.
Shipping Method
Specifies the shipping method used by each order. Depending on how many methods of shipping
you have specified in the administration area, a different shipping method can show up in this
column.
Address
The Address that the package is being shipped to.
Warehouse
A warehouse is (most likely) a physical location where you store your goods before delivery. You
can select from any of the warehouses you have put into your system. Remember to select the correct one when attempting to check for shipments. The Default Warehouse can be changed to any
name you desire. This can be changed in the Administration section of the Commerce Manager. If
you have only digital products, the default warehouse should be more than enough.

Viewing received items
Items that have been returned are managed as incoming packages and can be tracked under
Returns under Shipments in the Shipping/Receiving area of Order Management.
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Creating picklists
After you have created an order and processed the order, its status is now "Released for Shipping."
Adding an order to an existing picklist or creating a new one is an important part of moving an order
in the workflow. Without this, orders cannot be completed nor shipped and this is one of the last
steps to completing a purchase order. The shipment will be added to a picklist, and the warehouse
will be selected where the physical item will be packed and shipped from.
When an order has been added to a picklist in this step it will have the status "In Progress" in the order list. It will disappear from the Release for Shipping list and appear in
the Picklist listing under Shipping/Receiving.
Creating picklists and adding shipments
1. Go to Order Management > Shipping/Receiving > Shipments > Released for
Shipping. This shows the Released Shipments screen.

2. Select a Warehouse from the drop-down list to determine where the item ship be packed and
shipped from.
3. Select the orders you want to add to the Picklist and click Add Shipment to Picklist.

4. The Add Shipments to Pick List pop-up appears. You can choose to create a New Pick
List (by default, the List Name shows the date and time the Pick List was generated) or add
the chosen shipment(s) to an existing Pick List you can select from the List Name drop-down
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list.

5. Click OK to save your changes.
Note that it is currently not possible to change the picklist name, default is date and time.

Completing shipments
This is the final area for an order where you prepare the actual physical shipment by assigning tracking information, preparing packing slips and "sending the package out of the door". Once this has
been done, the order is completed. This also means that the order becomes available for creating
returns if needed, since returns can only be created for completed orders.
When an order has been completed this step it will have the status "Completed" in the
order list and will disappear from the Picklist listed under Shipping/Receiving. The picklist will still remain in the list even if there are no packing shipments remaining.
Completing a shipment
There are two ways to complete a shipment which are described in the following.
Method 1
1. Select the box next to the shipment and then click Complete:

2. The Complete shipment pop-up appears. The default shipment number is based on the number after the purchase order number. For example, in the image above, the PO number for the
selected order is "PO10728-9". The last number after the dash is the number you want to
enter into the text field, in this case it is "9".
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3. Click Validate. Once validated, you will see the customer name, shipping address, shipping
method, and a field to enter in the tracking number provided by the shipping provider. Enter in
a tracking number and click OK. The shipment is sent out and completed. The purchase order
status will change to "Completed."

Currently, the Complete shipment pop-up is rendered over the purchase order number. So
to reference the shipment number without closing the pop-up, you can move and drag the
pop-up so you can see the PO number by hovering your mouse cursor over the Complete
shipment title bar.
Method 2
1. To complete a shipment, click on the complete shipment icon highlighted in the image below:
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2. The Complete shipment pop-up appears. The shipment # is already validated with the last
number of the PO number.

3. Enter a tracking number provided by the shipping provider and then click OK to complete the
shipment and complete the order.
Printing picklists and printing packing slips
1. Go to Order Management > Pick Lists. You can see existing Pick lists; you can filter the
view by choosing which warehouse the pick list was generated in.

You can also sort existing pick lists by Name, Packing Shipments, Warehouse, and
Created By.
2. Click on an existing pick list. The Packing Shipments window appears. You can choose to
print a packing slip and/or a picklist. Select one or more purchase orders. Click on Print Picklist to generated a printable and exportable (Excel or PDF) pick list.
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To generate a packing slip, select one or more purchase orders to include in the packing slip
and then click Print Packing Slip.

Removing items and deleting picklists
It may sometimes be necessary to manually remove items from a picklist or delete entire picklists.
In this section we will describe how this can be done.
Removing items from picklists
Do the following to remove an item from a picklist:
1. Go to Shipping/Receiving under Order Management and Picklists.
2. Select a picklist in the list to display the related order shipments.
3. Select the shipment(s) you want to remove and click Remove from Pick List.
4. Click OK to confirm the deletion.
Deleting picklists
Do the following to delete a picklist:
1. Go to Shipping/Receiving under Order Management and Picklists.
2. Select the picklist(s) you want to remove and click Delete Selected.
3. Click OK to confirm the deletion.
A picklist must be empty of all "packing shipments" (0 shipments remaining) before it can
be deleted.
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Shopping carts
A shopping cart (or basket) is created in the system as soon as a visitor selects the Add to basket option on any page. The majority of carts are created automatically by shoppers from the frontend of the e-commerce site. However, if needed shopping carts can also be created and managed
manually from Order Management under Carts. Registered and anonymous customer carts can be
viewed in detail and manually converted into a purchase order.
In the following sections we will describe how to manage the shopping cart tasks from inside Order
Management. For more information about the overall shopping workflow, refer to Shopping process
flow in this documentation.

Creating shopping carts
Shopping carts are the first step in the shopping procedure, created before the purchase order. Each
cart is unique and has its own ID#. When creating a cart manually, you must select a customer, and
the system will automatically redirect you to an open cart for a customer if that customer already has
a cart open. You can only have one cart open at a time per customer. When a cart is turned into an
order, it will disappear from the carts list, and appear in the purchase order listing.
Functions in the cart view
The carts view has the following functions and information:
l

New Order
Allows you to create a new order from here. Creating a new order means that this will not produce a cart to view and will not show up in this view screen. It will appear under Purchase
Orders. Only use this button on this screen if you actually wish to create a new order from
here.

l

New Payment Plan
Allows you to create payment plans which will appear under "Payment Plans (recurring).

l

New Shopping Cart
Creates a new cart assigned to a customer.

l

Delete Selected
Allows you to delete carts.

l

ID
Each cart has an individual ID which can be viewed from here by clicking the numbers.

Creating a shopping cart
Do the following to create a shopping cart manually:
1. Go to Order Management and Carts.
2. Select New Shopping Cart.
3. Select a customer to create the cart for. If you do not see your desired customer in the list
click More to search for them.
4. Enter product items to the cart by selecting New Line Item.
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5. Return to the Carts view to verify that the cart is there.

Converting shopping carts
In most cases shopping carts will be automatically converted into purchase orders when shoppers
proceed to checkout and finalize their purchase there. However, it might sometimes be necessary to
manually complete a purchase by converting the shopping cart into an order for further processing.
Converting a shopping cart to a purchase order
1. Go to Order Management > Carts. You will see the Shopping Carts list. You can also
select "Today," "This Week," or "This Month" to filter by date range.

2. Click on the ID number of the shopping cart you want to convert over to a Purchase Order.
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3. You will see the Cart View window and details of the customer's shopping cart.

An anonymous user Cart View will look like this:

a. Edit Information - You can change the currency to be used for the Purchase Order.
b. Open Customer Profile - You can view the profile of the registered customer (this
option is not available for anonymous shopping carts).
c. Line Items - This is the list of items currently in the customer's shopping cart, displaying the Quantity of each item, List Price, and Total.
d. Notes - You can add, edit, or delete notes about the shopping cart.

4. Click on More Actions and click on Convert to Purchase Order.
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The page refreshes and shows the Order view page for further processing of the purchase

order.

Returns and exchanges
Once a package has been finalized and shipped out, EPiServer Commerce enables you to process
returns and exchanges directly in the order. A "return" is the actual return of the faulty delivery item.
The customer can either be refunded or be compensated by an "exchange" of either the same
product item or something else.
Generating an exchange creates a separate Exchange Order (denoted by "EO", instead of "PO")
tied to the original purchase order. An exchange order is similar to processing a purchase order, as it
involves payment processing and releasing packages for shipment.
Returns and exchanges can only be processed once a purchase order status is tagged as
"Completed."

Initiating a return
Do the following to initiate a return:
1. Go to purchase order that has been finalized and shipped. Go to the Details tab and you will
see that the Create Return is available under Returns/Exchanges. Click on it to begin the
return and/or exchange process.

2. The Create/Edit Return form appears. Click on New Item to add associate the items to be
returned.
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3. The Line Item drop-down menu defaults to the items that were in the original purchase order.
You can set the Return Quantity and the Return Reason from the drop-down list (Faulty,
Unwanted Gift, Incorrect Item). You can also add additional information to the return. Click
OK to save your changes.

4. The purchase order will go into Edit Mode. Click Save to continue the return process. Otherwise, click Cancel to cancel the return.
5. In the Order List, the order will now appear with status Completed/Awaiting Return Completion.

Return completing actions
1. Click on the Returns tab to process the return further. Once you get a notice from the shipping department, for example, that they have received the returned item, click on Acknowledge Receipt Items.
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You can also choose to edit the return or cancel the return completely.
2. Once you click on Acknowledge Receipt Items, the Complete Return becomes available.

3. Click on Complete Return to open the Create Refund form.
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a. The Amount value defaults to the invoice cost of the item (not including the shipping
costs). For example, if the item cost $49.99 and the shipping cost was $2, then the
Amount text box will show $49.99.
However, you can specify a different amount to refund to the customer, including the
full cost of the order, item(s) + shipping cost. By default, the refund will be deposited
based on the payment method the customer used to make the order.
b. If the customer wants the refund processed and deposited to a different credit card or
payment method (such as cash, money order, or electronic transfer), click on the New
Credit radio button and you can enter their alternate credit card information or other
refund payment information.

4. Once done, click OK to create and process the refund. The status of the purchase order
changes to Completed.

Initiating an exchange order
Do the following to initiate an exchange order:
1. Go to a Purchase Order, click on the Details tab, and then click on Create Return.
2. Add the items for exchange.
3. Click on the Returns tab and click on Acknowledge Receipt Items. Click Create
Exchange to open the Create Exchange Order form.
4. Click on New Item and then select the item to be exchanged by clicking Configure Selected
Entry. You can adjust the price, quantity, and applicable discounts before you add the item to
the Exchange Order by clicking Add items to the order.
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5. Enter a shipping and billing address. Select the shipping method to use for the Exchange
Order. Click on Recalculate to adjust the Summary total.
6. Click OK once done.
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Viewing an exchange
1. Once an Exchange Order (EO) has been created, click on View Exchange to view the details
of the EO. An EO is similar to how a Purchase Order is set up.

2. Click on the Payments tab to add a payment to the Exchange Order. Select a payment
method for processing the EO. You can adjust the amount if needed (the amount default
value is based the item cost + shipping).

3. The Exchange Order goes into Edit Mode. Click on Save to process the payment and the
order. The payment Transaction Type changes to "Authorization."
4. In the Order List, the there will be an exchange order with prefix EO instead of PO, and with
status Awaiting Exchange.
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5. Go back to the original Purchase Order and click on the Returns tab. Click on Complete
Return to enable the Customer Service Representative (CSR) to release the EO shipment.
Optionally, you can cancel the shipment to cancel the Exchange Order. Once you release
shipment, the CSR repeats the same process as he would when shipping a Purchase Order.
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Customers
The Customer Management system is the Customer Relationship Management System (CRM)
within EPiServer Commerce. Customer Management is comprised of Organizations, Contacts,
and Roles. Customer Management can be used to organize both internal business users and customer groups. Furthermore you can control both end-users and employees within your company that
use the system. Utilizing the hierarchy you can create with organizations, sub-organizations, contacts, and roles you can segment all users of the system into the desired groups.
l

l

l

Organizations - organizations are structures that allow you to divide, separate and manage all
of the users that are in your system. Organizations can also have suborganizations to further
classify your users.
Contacts - contacts are individual persons that are added to your Customer Management system. They also contain all the information for a person's account, which allows them to interact with the system based on their account and role.
Roles - roles in the Commerce Manager back-end system, are classes that you setup in order
to give specified users certain accessibility and permissions. Certain roles come out of the
box and roles can be created, edited and deleted to fit your needs. It is useful to set up roles
to coincide with organizations within your Customer Management system, since that will
allow you to more easily manage your users and organizations. Roles are completely separate from users and organizations, so how you choose to divide your roles will be up to you.

Contacts can be managed within customer groups and organization customer groups, to which
you can apply specific pricing and discounts, as well as personalization.

Working with customer management
Planning organization hierarchy
One of the first things you will want to do is to plan your organization hierarchy so that your organizations, contacts and roles ready for input. You can create Organization Hierarchies by creating
parent-child relationships between organizations. For example, creating your Organization Hierarchy
for your internal Administration you can create a the hierarchy of organizations being Administration
> EU Headquarters > EU Management.
You may then associate Contacts with the appropriate level of the Organization Hierarchy. Permissions can be set to determine which users can view certain Organizations in the hierarchy as
well. The same principle applies for creating hierarchies for customer groups. For example, you
could have a customers organization with sub-organizations of Gold, Silver, and Bronze level customer groups. You could then leverage those customer groups to display different prices for each of
your valued customer groups.

Creating organizations and contacts
Organizations are structures that allow you to divide, separate and manage all of the users that are in
your system. Contacts are individual persons that are added to your Customer Management system. They also contain all the information for a person's account, which allows them to interact with
the system. When users register on the front-end of the site (for example to make a purchase) they
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automatically get a Contact made for them and an account created that they setup. For more information see Organizations and Contacts.

Using roles and permissions
Roles allow you to give users access to different parts of the system with varying levels of permissions. For example, a marketing person within your organization may be able to draft new pages,
and their marketing director must be the person to approve it. Users are able to have multiple roles
within the system. For more information see the Roles section.

Organizations
Under Organizations, you can create new organizations. Organizations can be categorized into different types such as organization or organization units (for example regional branches, departments) and also business categories such as "Computer and Electronics" or "Clothing and
Accessories".
Organizations can be assigned to organization customer groups, to which you can apply specific
pricing and discounts, as well as personalization.
Organizations can be structured into a tree structure with subunits with different levels of permissions assigned to each. For example, you can set up your company as a parent level organization while your departments such as Sales & Marketing, IT/Development, and operations as
organization units. With this scenario, you can allow users in each departments to have access to
only relevant systems, screens and functionality within Commerce Manager.

Working with organizations
The work with organizations includes the following tasks:
l

Creating organizations and organization hierarchies

l

Browsing and viewing existing organizations

l

Editing and deleting existing organizations

l

Defining dictionary values for organization types and business categories

Browsing organizations
Organizations are one of the major function areas of the Customer Management system. You can
browse and view existing organizations and suborganizations.
Viewing organizations
To browse organizations, go to Customer Management and select Organization in the left menu.

This will open the Organization List page.
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In this view, the organization details displays the following information:
Field

Description

Name

Name of the organization.

Description

Additional details of the organization.

Organization Customer Group

Select a customer group to assign for the organization, this provides the possibility to apply pricing,
discounts and personalization of content for this
group.

Type

The kind of organization.

Business Category

Under which category the organization falls.

Viewing organization details
Selecting an organization in the list will display more detailed information about the type of organization and related contacts, organizations (parent/sub), addresses and credit cards.

Searching for organizations
You can also use the search field on top of the Organization List to find specific organizations by
name. To conduct a search, enter your search terms and click on the Search button. To conduct a
new search, click on the Reset button to reset the form and enter new search terms.
Customizing views for browsing organizations
As an Organization List gets longer, you can create and customize views to filter the list. You
define the columns you want to be displayed for the view, and the filters to be applied when selecting
what to include in the view.
Do the following to create a new organization view:
1. Click on the View drop-down menu and select "New View."
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2. The New View dialog is displayed.

3. The default tab is General. Enter a Title for the custom view. Click the check-box Show this
view for all users, if you want other users to see this custom view.
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4. Click on the Fields tab to select which columns you want to appear in the custom view.
Under Available columns, select the columns you want to appear by clicking and highlighting the column name and moving it over to the Visible columns list by clicking on the
Right Arrow icon.

To deselect a column, click and highlight a column name from the Visible columns list and
then click on the Left Arrow icon. To change the ordering of the Visible columns list, click
and highlight a column name and click on the Up and Down Arrow icons on the right of the
list to reposition the column.
5. Click on the Filters tab to set the view filters. Clicking the + icon allows you add an additional
filter.
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6. Click Save to save the settings and return to the Organization List screen.
Applying a view
Once a View is created and saved, it appears in the View drop-down box.

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the
custom View, your organization list will reflect those options.
Editing and deleting views
To edit an existing view, select the view from the drop-down menu and click on the Edit icon next to
it. The View Editing dialog is displayed and you can edit all properties.
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To delete a custom View, click on the X icon next to the Edit icon.
There are a multitude of options available for customization, but here are some examples to get you
started.
Customized view example
In this example we will create a view that only shows organizations matching a business category
and organization name. We will create a filter condition that display organizations with a Business
Category that equals "Business & Professional Services" and an Organization Name that equals
"Company X."

1. Click on the + icon and from the drop-down select "Business Category." Two fields, which
default to "Equals" and "Arts & Entertainment," automatically appear. Click on "Equals" and a
drop-down appears. Keep the field as "Equals." Click the field to the right of it and select a
"Business Category" name (such as "Business and Professional Services").
2. Since we want to add another filter so that the Organization not only matches this "Business
Category," but also a specified name, click on the following + icon and then on the drop-down
select "Name."
3. In the next field, select "Equals" and then on the field that says "Text" enter in the name of the
Organization.
4. Once done, click Save to save the View.

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the
custom view, your organization list will reflect those options.
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Printing a list of organizations
If you want to generate a printer-friendly list of Organizations, click on Printer Version. A new window will pop-up and render a simple table suitable for printing. Click on the Print button on the upper
right corner of the page.

Creating organizations
In the following we will describe how to create an organization hierarchy with a "parent" and "child"
organizations for your EPiServer Commerce site. The parent organization is of the type "Organization", and the suborganization will be of the type "Organization Unit" in the system.
Creating an organization or organization unit
These steps apply to both organizations and organization units.
1. Go to Customer Management and Organizations. You will be brought to the Organizations page which lists any existing organizations.
2. Click New Organization. This will lead you to a new screen to input data for your new Organization.

3. Enter data for the new organization, see below for available options.
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Field

Description

Name

Enter in the organization name (this is the only required field).

Description

For additional details about the organization.

Type

Select from the drop-down menu to assign a type to the organization.
If the organization is a parent organization, select "Organization", if
the organization is a suborganization, select "Organization Unit".
More types can be added to the drop-down by clicking on the icon.

Organization Cus- Select a customer group to assign for the organization, this provides
tomer Group

the possibility to apply pricing, discounts and personalization of content for this group.

Business Cat-

Select from the drop-down menu to assign a category to the organ-

egory

ization. You can add more categories by clicking on the icon.

Parent

You can assign a parent organization to an organization. If the organization you are creating is a subunit (child) of a larger organization,
then select the parent in the drop-down menu. If you do not see the
Organization listed on the drop-down menu, click More...

4. Save the organization by clicking OK. The Organization Info window of the organization
appears. From here, you can view Information about the Organization you just created. Out
of the box, you can also see associated Contracts, Organizations, Addresses, and Credit
Cards. You can further edit the Organization by clicking the Edit button. To go back to the
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Organization List, click on Organizations on the menu bar next to Edit.

Creating an organizational hierarchy
You can create organization hierarchies by assigning a "parent organization" to a "child organization" and then another organization to the child. Permissions can be set to determine which
users can view certain organizations in the hierarchy. In this example, "Company X" is the Parent
Organization and "Company X West" is the Organization Unit.
1. Go to Organizations and click New Organization. Enter data for the organization (see previous section).
2. Under the Parent option, assign the desired parent organization ("Company X"). If you do not
see the organization listed on the drop-down menu, click More...

3. Click OK to save the organization.
4. In the Organization Info page, the Organization Unit ("Company X West") becomes the
child to the Organization ("Company X") you selected.
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5. Repeat the steps above to create further organization units for the parent organization

Editing organizations
Do the following to edit an existing organization (parent) or organization unit (child):
1. Go to Customer Management and Organizations. The Organization List page will be displayed.
2. Open an organization by clicking on it in the list.

3. Select any of the Edit options at the top or the bottom.

4. Edit the available information, see Creating an organization for explanation of the fields.
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5. When you are done, click OK to save your changes.
Deleting organizations
Do the following to delete an existing organization (parent) or organization unit (child):
1. Go to Customer Management and Organizations. You will be brought to the Organizations page which lists any existing organizations.
2. In the list of organizations, select the organization you want to delete and click Delete.

3. A confirmation message will be displayed. You can delete organizations with children without
deleting the child organizations and contacts with no repercussions. This only leaves the contacts and child organizations as orphans that you can later reassign using the same methods
described in Creating organizations.
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Select either Delete Organizations Only or Delete Organizations, Child Organizations
and Contacts and click OK to complete the deletion.

Dictionary values for organizations
This section describes how to add dictionary values to create your own organization types, organization customer groups and business categories, that can be applied when building an organization structure.
By default, organizations can be of type "organization (parent)" or "organization unit" (child). An
organization customer group can be for instance "Partner", and a business category can be an
industry branch such as "Automotive" or "Food & Dining". This type of data is managed in so called
dictionaries.
Creating, editing and deleting dictionary values for organizations
1. Open the Organization Edit page by creating a new organization or editing an existing one.
Click on the Edit Dictionary icon next to the Type drop-down menu.

© EPiServer AB

Customers | 117

2. A dialog is displayed appears allowing you to edit the existing organization type dictionary by
clicking the edit icon. To add a new item to the dictionary, click on New Item.

3. Select the order of the item from the drop-down on the left and enter a name for the item on
the field next to the drop-down.

4. Click the Save icon to save the dictionary item. Click Close to close the dialog.
5. The dictionary item is now available for selection in the Type drop-down.
To edit an existing dictionary item, click the Edit icon next to the item. To delete a dictionary item,
open the dictionary list and click the Delete icon next to the item.
If you change the number to a position higher in the list, the list will NOT be automatically
reordered. You must therefore manually edit the entire list. However, having multiple copies of the same numerical value does not affect the system. Therefore, you can feel free
to use the numbers as a ranking system, or you can devise your own internal method to
numbering.
Creating, editing and deleting business categories
Out of the box, there is a list of categories you can assign to an organization. You can add more categories the same way you add organization types.
1. Click on the Edit Dictionary icon next to the Business Category drop-down menu.
2. A dialog is displayed appears allowing you to edit the existing business categories by clicking the edit icon. To add a new item to the dictionary, click on New Item. To delete an item
in the list, click the Delete icon next to the item.
3. Select the order of the item from the drop-down on the left and enter a name for the item on
the field next to the drop-down.
4. Click the Save icon to save the dictionary item.
5. The new business category is now available for selection in the Business Category dropdown menu.
To edit an existing dictionary item, click the Edit icon next to the item. To delete a dictionary item,
open the dictionary list and click the Delete icon next to the item.
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Contacts
Contacts and their related accounts are created automatically when users create them on the frontend, for example if they register to make a purchase, or you can create them from the back-end.
Contacts are individuals with a certain set of personalized information (name, address, email, etc.).
l

Contacts with Accounts - a customer who registers on the public site. Customers can
access their accounts from the public site as well as order history and other personal information, but cannot access Commerce Manager.

l

Contacts with User Permissions - someone internal to your team who has varying levels of
access to the systems within Commerce Manager.

Contacts can be assigned to customer groups and organization customer groups. These drives
two areas in the system; the selling prices – price can be set for eligibility for a customer group and
also for eligibility for discount campaigns. There is a priority to these; if there is a customer group
assigned to an organization then this is used to drive pricing and campaign eligibility.
Contacts in an organization will be a member of that organization's customer group, even if the contact is assigned individually to a different customer group.
Contacts that are users who will be accessing Commerce Manager, can be assigned roles based on
varying permissions. Refer to Roles for more information.

Working with contacts
The work with contacts and accounts includes the following tasks:
l

Creating contacts and related accounts

l

Browsing and viewing existing contacts

l

Editing and deleting existing contacts and related accounts

l

Defining dictionary values for customer (contact) groups

Browsing contacts
To browse Contacts, go to Customer Management > Contacts.

Viewing detailed contact information
The Contact List page shows a list of existing contacts.
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You can click through the name an existing Contact to view more information.

From within the Contact Info form, you can view other recorded information about the contact. For
example, you can view Addresses and Order History related to this contact.
More objects or metadata can be added to the default View Form via Business Foundation.
Searching for contacts
On the Contact Info page, you can use the search form above to search for a particular Contact
using key terms. Conduct the search by clicking on the Search icon (magnifying glass). Contacts
that match the search terms will appear on the list.
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To clear the search and revert back to show all Contacts, click on the Reset icon (eraser) next to the
search icon.
Customizing views for browsing contacts
Like Organizations, users can create or customize Views when browsing objects.
Creating a view
On the Contact List page, click on the View drop-down menu and select New View.

A pop-up appears, very similar to the one found in Organizations. This form gives users the ability to
customize which columns appear and apply a variety of filters.

The default tab is General. Enter in a Title for the custom View. Check the box Show this view for
all users if you want other users to see this custom View.
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Click on the Fields tab to select which columns you want to appear in the custom View. Select the
columns you want to have appear by clicking and highlighting the column name and moving it over to
the Visible columns list by clicking on the Right Arrow icon.

To deselect a column, click and highlight a column name from the Visible columns list and then
click on the Left Arrow icon.
To change the ordering of the Visible column list, click and highlight a column name and click on
the Up and Down Arrows on the right of the list to reposition the column.
Click on the Filters tab to set the view filters. Users are given precise controls over filters for setting
up rules for their custom View. Clicking on the + icon allows you add an additional filter.

© EPiServer AB

122 | EPiServer Commerce User Guide update 15-1

There are a multitude of options available for customization.
Applying and editing a view
Once a View is created and saved, it appears in the View drop-down box.

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the
custom View, your Contact List will reflect those options.
To edit an existing View or a View you just created, select the View from the drop-down menu and
click on the Edit icon next to it. The View Editing form pops up and you are able to edit all properties.
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Printing a list of contacts
To generate a printer friendly layout of the Contact List, click on Printer Version from the menu bar
on the Contact List page.

A new browser window opens showing a printer-friendly version of the Contact List. Click on Print
on the far right corner of the browser window.

Creating contacts and accounts
Creating contacts
To create a new Contact, from the Contact List page, click on New Contact.
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The Contact Edit page appears where you can enter all relevant information about the contact. The
only required fields to complete are Full Name, First Name, Last Name, and Email. The rest of the
fields are optional but are recommended.
1. Select a Parent Organization from the drop-down menu to associate the contact with a
single parent organization.
2. Assign the contact to a Customer Group. More Customer groups can be added by editing
the Customer group dictionaries. Customer groups become useful for instance when setting
specific permissions and targeted Marketing campaigns.
3. Select a Preferred Currency for the contact. If the contact is in France, you may want to
associate the Euro currency. Available currency options are based on settings in Administration > System Settings > Dictionaries > Currencies.
4. Select a Preferred Language to associate with the contact. Languages are populated based
on the languages set under Administration > System Settings > Dictionaries > Languages.
5. Preferred Shipping and Billing addresses are related to company accounts.
6. The Registration Source field is a text field for entering in notes about the contact. For
instance, you may want to reference which website the contact is currently registered under.
The Registration Source field is automatically filled when a user creates a new account
from the public website.
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Click OK to save the contact. The Contact Information form is displayed. From here you can enter
additional information for the contact. Order history for the contact can be viewed, and you can add
notes for both orders and the contact. The form can be customized using Business Foundation.

To go back to the Contact List, click Cancel or the Contacts button next to the Right Arrow icon.
Creating accounts
An Account can be created with a contact. Once an account has been created, the contact can be
assigned permissions using Roles and access the Commerce Manager.
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A customer account is automatically created for a customer who registers from the frontend public website, allowing them to log in and view personalized information.
To create an account for an existing contact, click on a contact name from the Contact List. On the
Contact Info page, click on Create Account.

A pop-up appears to enter in their user account credentials. A User Name and Password are
required to create the account.
1. Enter in a User Name, which can include spaces and special characters.
2. Enter in a Password, which must be four or more characters.
3. Enter in a Description and Email Address, which are both optional.
4. To enable the account, select "Yes" under Approved. Otherwise, select "No" to keep the
account inactive and inaccessible by the user.
5. Click OK to save the account.

User account information appears under the Account section of the Contact Information form.
Explanation of account fields:
l

Last Activity - last time the user logged in or made any changes to the site.

l

Last Lockout - last time a user was locked out due to too many failed log in attempts.
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l

Last Log in - last time the user logged into his or her account.

l

Last Password Changed - last time the user account password changed.

Editing contacts and accounts
To edit a Contact, select the contact in the contact list and click Edit. Edit the information and click
OK when done.
To edit an Account, select the related contact in the contact list and select the Edit Account option
in the lower part of the dialog. Edit the information and click OK when done.
You cannot change the User Name unless you remove the account and recreate the
same account again.
Deleting contacts and accounts
To delete a contact, select the contact in the list of contacts, select the contact you want to delete
and click Delete. Click OK to confirm the deletion.
To delete an account, select the related contact in the contact list and click the Remove Account
option in the lower part of the dialog.

Dictionary values for contacts
This section describes how to update dictionaries to create your own customer (contact) groups
that can be applied when adding contacts to your organization. By default, customer groups can be
of type "customer", "partner" or "distributor". This type of data is managed in so called dictionaries.
Customer groups can be used for instance when defining specific pricing or restricting promotions.
Creating and editing dictionary values for customer groups
1. Open the Contacts Edit page by creating a new contact or editing an existing one. Click on
the Edit Dictionary icon next to the Customer Group drop-down menu.
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2. A dialog is displayed appears allowing you to edit the existing customer group dictionary by
clicking the edit icon. To add a new item to the dictionary, click on New Item.

3. Select the order of the item from the drop-down on the left and enter a name for the item on
the field next to the drop-down.
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4. Click the Save icon to save the dictionary item. Click Close to close the dialog.
5. The dictionary item is now available for selection in the Customer Group drop-down.
To edit an existing dictionary item, click the Edit icon next to the item. To delete a dictionary item,
open the dictionary list and click the Delete icon next to the item.
If you change the number to a position higher in the list, the list will NOT be automatically
reordered. You must therefore manually edit the entire list. However, having multiple copies of the same numerical value does not affect the system. Therefore, you can feel free
to use the numbers as a ranking system, or you can devise your own internal method to
numbering.

Roles
Roles are used for managing permissions for different groups of users. Out-of-the-box, EPiServer
Commerce includes a list of predefined roles that can be assigned to user accounts.
l

Order Managers - allows users to manage (View/Create/Edit/Delete/Others) elements
within the Order Management system.

l

Order Supervisor - allows users to fully administer the Order Management system.

l

Shipping Manager - has the ability to view, pack, and complete shipments.

l

Receiving Manager - has the ability to view shipments and receive returns.

l

Everyone - one of the default roles which is assigned when a customer registers an account
from the front-end public site.

l

Registered - one of the default roles which is assigned when you register from an account
from the front-end public site.

l

Management Users - allows users access to Commerce Manager.

l

Administrators - allows users to fully administer most areas of Commerce Manager.

l

WebEditors - allows users to access the edit interface for working with website content.

l

WebAdmins - allows users to access the admin interface for administering the website.

Users can also create their own roles based on a set of permissions. Roles allow administrators to
restrict users from accessing different systems or folders depending on their needs. There is a
wealth of permissions options administrators can set for a role, and each role area has specific areas
that may not be applicable to other areas. Generally, permissions such as View and Edit are commonplace.

Exploring roles and permissions
When you first select Roles, you will see a list of the roles that are currently available in the system.
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Each role has a series of defined permissions that can be set on a very detailed level. For instance,
the Order Managers role can create returns and exchanges, and view. edit, send notifications, process payments and split shipments for orders.

For a role to be able to successfully view Commerce Manager, it must have the following
attribute. Go to Core > Management > Login and check the Login button. Without this
checked, the user with that role will be unable to login into Commerce Manager unless
that user has another role that includes that ability since all roles are cumulative in their
effect.
Definitions of roles can be even more in-depth. A role can have certain detailed permissions in parts
of the system, but not full control. In the example below, this role has full control over the Management part of the Core system, but only partial control over the Administration system.
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Notice how the tree system works. Clicking on the system above it gives full control of all the
branches beneath it, but clicking farther down the tree only gives access to those systems.

Working with roles
The work with roles and permissions includes the following tasks:
l

Creating, editing and deleting roles

l

Assigning roles to individual accounts

Creating and editing roles
Commerce Manager includes a list of preexisting Roles that can be assigned to Accounts. You can
also create your own roles based on a set of permissions. Roles allow administrators to restrict
users from accessing different parts of the system.
Creating a role
To create a new Role, go to Customer Management > Roles to see the Role List.
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Click on New to open up the Role Edit page.

There is a wealth of Permissions options Administrators can set for a Role.
Enter a Role Name.
Select the desired permissions for the Account for this particular function or action. For example, if
you want an Account to only View and Edit Assets, you will need to expand Assets > Manage and
select View and Edit.
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Once done defining the Role, click on OK. The new Role will appear on the Role List.

Editing roles
All existing Roles, including the ones included out of the box with Commerce Manager, can edited
and customized. It is also a recommended reference to how each preexisting Role works.
To edit a Role, click on the Edit icon.

The Role Edit page appears. You can customize the Permissions settings for the Role. Once done,
click OK.
Deleting roles
To delete any Role on the list, there are two ways:
Click on the X button next to the name of the Role to delete one at a time.
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To delete multiple roles, select the desired roles and the Delete Selected option from More Actions
in the top menu. Click OK when the pop-up appears.

Assigning roles
Roles in Commerce Manager are designed to allow certain functionality to be accessed by individual
accounts. When a contact logs into his or her account, that account is bound by the roles to which it
is assigned.
Assigning roles to individual accounts
To assign one or more roles to an account, open Commerce Manager, go to Customer Management > Contacts and click on an existing contact with an account.

Under Security, click on Roles. The Security section only appears after an account was created for
the contact.
The Roles form appear, allowing you to assign roles to the account. By default, an account is
already assigned to the "Registered" and "Everyone" roles.
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Click on Assign Role to assign a new role to the account. A pop-up appears allowing you to assign
a specific role from the drop-down menu.

Select a Security Role from the drop-down to assign to the account.
Optionally, you can assign an organization to the account, which enables the Inheritance drop-down
menu below. If specific permissions are set for an organization, you can set to "Inherit from Parent"
(inherit permissions from the parent organization) or "Overwrite parent."
Click Save to assign the role. Repeat these steps to assign more roles to the account.
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Markets
The market concept is central in this area of e-commerce. A market can be a country or a set of
countries, regions or specific customer groups, where you want to apply specific products, languages, currencies or promotions. You can define many markets, each with its own product catalog,
language, currency, and promotions, to be used on a single-site. The market features opens up for
targeted merchandising and a more personalized user experience.

Working with markets
Markets are defined under Market Management in Commerce Manager, for usage in other parts of
the system. With the multiple market options, you can for instance customize which products to be
displayed and payment methods to be used for a specific market. Furthermore, reports can be
filtered per market by using the market definitions. Markets can also be used to personalize content
for targeted customer groups.

Defining markets
This section describes how to define markets in EPiServer Commerce.

Browsing markets
To browse existing markets, go to Market Management in Commerce Manager, and expand Markets in the left menu.

The market overview displays existing markets with their languages, currencies and status (active
or not).
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The Default Market will define the language and currency to be used as fallback for markets that have not been specified.

Creating a market
Do the following to create a new market definition:
1. Go to Market Management, select Markets in the left menu, then click Create New and
New Market.
2. Enter data for the market. Add the Market ID, display Market Name and Market Description. Select Yes in the Is Active field to make the market available. Add Countries, Languages and Currencies for the markets. Ensure to add a default language and currency as
fallback.
Note that a website can exist in many languages, but selecting English as preferred language
does not automatically mean that a visitor belongs for instance to the US or UK markets. By
defining market languages, you provide the possibility to read content in a desired language
for a selected market. You can for example provide content in English for a Swedish market,
for non-Swedish speaking visitors located in Sweden.

© EPiServer AB

138 | EPiServer Commerce User Guide update 15-1

3. Save the market by clicking OK.

Editing an existing market
Go to Market Management, select Markets in the left menu to display the list of existing markets.
Click the name of the market you want to update to open the Market Edit dialog. Make the changes
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and click OK to save.

Deleting a market
To browse markets, go to Market Management and expand Markets in the left menu. Select the
check box next to the market you want to delete, select More Actions and Delete Selected. Confirm the deletion by clicking OK.
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Marketing
The Marketing system is where you will come to create coupons, discounts, and promotions that
can be applied to products, orders, or shipping. Most commonly, these promotions will be created
and managed by marketing and catalog managers, as well as other users or administrators who
handle pricing and discounts.
The marketing features makes it possible to create unique and compelling discounts and promotions. Any discount that you create can be either percentage or value based. You will also have
the ability to create campaigns and customer segments so that you can target the promotions you
have created to specific customers or time periods. Campaigns and promotions can also be targeted
towards specific markets.
The Marketing system consists of the following components:
l

Campaigns - a logical grouping of promotions and/or customer segments which will run over
a specified period of time.

l

Customer segments - a subset of customers or users of your website to whom you can target individual promotions or campaigns.

l

Promotions - any sort of discount or coupon that can be applied to individual catalog entries,
orders or shipping charges.

l

Expressions - conditions expressed in XML which are used to extend or create custom promotions.

l

Policies - global rules that are applied to all aspects of the marketing system, and promotions
in particular.

Working with marketing
The work with the marketing system includes the following tasks:
l

Creating and managing campaigns, which can be targeted to specific groups of users.

l

Configuring customer segments used for targeting of promotions to specific groups of users
and customers.

l

Creating different types of promotions with discounts and coupons.

l

Configuring expressions and policies for defining additional rules and promotion types.

Campaigns
Campaigns are the first step to deploying targeted marketing efforts on your e-commerce website,
and provide a way to organize marketing activities. Campaigns must be associated with discounts
(promotions) in order to provide customer discounts. Optionally, campaigns can also be tied to customer segments for targeted marketing purposes. For example, you can create a seasonal campaign
that will include different promotions targeted for the spring season. Campaigns and promotions can
also be restricted to specific markets to serve local needs without discounting a product world-wide.

Campaign management
Campaigns and discounts (promotions) are managed in Commerce Manager.
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Browsing campaigns
To browse existing campaigns, go to Marketing > Campaigns in Commerce Manager, and open
the Campaign List.

From the Campaign List, you can view existing campaigns.

You can click on the name of a campaign to view its properties.
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Managing campaigns
This section describes how to work with campaigns from Commerce Manager.
Browsing campaigns
To browse existing campaigns, go to Marketing > Campaigns in Commerce Manager, and open
the Campaign List.
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From the Campaign List, you can view existing campaigns.

You can click on the name of a campaign to view its properties.
Creating and editing campaigns
1. To create a new campaign, click on New Campaign on the Campaign List page.

2. This opens up the Campaign Edit page. Enter a Campaign Name, such as "Graduation
Special."
3. Enter any Comments as notes about the Campaign.
4. Enter a date directly (or click on the Calendar icon to select a date) and time into the Available From field. This will indicate when the Campaign is expected to start.
5. Enter a date and time in the Expires On field.
6. Select the Target Segments from the list. Segments are created under the Customer seg-

ments section.
7. Select the Target Markets from the list. Markets are defined under the Defining markets section.
8. Indicate whether or not the Campaign is Active, "Yes" or "No."
9. Indicate whether or not to Archive the Campaign, "Yes" or "No. NOTE This feature has not
been implemented and switching its status from "No" to "Yes" will not change anything.
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10. When done, click OK.

Editing a campaign
To edit an existing campaign, go to Marketing and Campaigns to expand the list of campaigns.
Select a campaign to edit by clicking on the campaign name in the list. Update the information and
click OK to save your changes.
Deleting a campaign
In the Campaign list, check the box next to the name of the campaign(s) and then click More
Actions > Delete Selected on the menu bar. Click OK to confirm the deletion.
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Customer segments
Customer Segments determine the target audience for promotions or campaigns. Within a campaign, all promotions will be applied to whatever customer segments associated with the same
campaign. Members of the customer segments can be pre-defined in static groups or you can use
expressions to create dynamic groups whenever promotions are run.
For example you can have a customer segment that targets all users from the Los Angeles area.
You can create an expression that will include all the customers whose home city is Los Angeles.
Thus, when a user registers on the site he or she immediately becomes part of the target customer
segment.
You can create a customer segment and manually assign specific contacts to the customer segment, or you can use conditions to apply rules that automatically make selected customers become
part of the customer segment.

Browsing customer segments
To view and browse customer segments, click on Customer Segments on the left navigation bar.

The Customer Segments List page opens, displaying a list of existing customer segments.

You can click on the name of a customer segment to view its properties.
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Creating customer segments
Customer Segments defines a specific groups of customers to be targeted by promotions or campaigns.
Creating a customer segment assigned to contacts
In Commerce Manager, go to Marketing > Customer Segments.

Click on New Segment on the menu bar to open the Segment Edit page.

1. Enter a Segment Name, such as "Los Angeles Customers."
2. Enter in a Display Name, which will appear to users when associating this customer segment when Creating a Marketing Campaign.
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3. Enter a Description.
4. Select from a list of contacts from the Members drop-down to assign them to this customer
segment. Select the name from the drop-down and then click add member. You can
exclude a member by selecting Exclude member and then clicking add member.
5. Once done, click OK to save the customer segment.

Creating a customer segment with conditions
Instead of assigning members manually to a customer segment, you can use Conditions to apply
rules. If a customer satisfies the conditions, then the customer is part of the customer segment.
To add conditions to the customer segment, click on New Condition on the Segment Edit page.
This example will show how to specify "Company X" or "Winearts" emails as part of this customer
segment.
Enter an Expression Name, such as "Company X or Email Addresses."
Setup the conditions based on the image below.

Click OK to save the Conditions.
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Editing customer segments
Editing a customer segment
To edit an existing customer segment, go to Marketing and Customer Segments to expand the list
of customer segments. Select a customer segment to edit by clicking on the customer segment
name in the list.

Update the information and click OK to save your changes.
Deleting a customer segment
In the Customer Segment list, check the box next to the name of the customer segment(s) and
then click More Actions > Delete Selected on the menu bar. Click OK to confirm the deletion.
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Promotions
Promotions provide a way to apply various discounts to products, order totals or shipping. A promotion is a marketing tool used to increase sales of certain products or product lines. Various incentives such as lowered pricing and other discounts can be employed as part of a promotion.
Promotions are always tied to campaigns, which means that you need to create a campaign before
you can create a promotion. In addition, promotions can be classified into two types: 1) either you
can create a promotion that is visible prior to checkout or 2) you can configure the promotion to be
displayed during the checkout.
Through the use of expressions you can apply conditions to promotions. These conditions vary
from the number of items, the percentage discount, shipping rates and many others.
There are a number of built-in types of promotions that can be created and applied to individual catalog entries, orders, and shipping:
l

Entry level promotions

l

Order level promotions

l

Shipping level promotions

You can also build your own custom promotions.

Browsing promotions
To view and browse promotions, click on Promotions on the left navigation bar.

The Promotion List page opens, displaying a list of existing promotions.

You can click on the name of a promotion to view its properties.
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Creating entry level promotions
The following catalog entry promotion types are available out-of-the-box:
l

Catalog Entry: Build Your Own Discount

l

Catalog Entry: Buy Catalog entry X, get catalog entry Y at a discount

l

Catalog Entry: Buy X Get $ Off Discount

The options above are available in the Promotion Type field when creating a new promotion. The following are examples of how to create each type of promotion.
Example: build your own discount - "40% off wine decanter"
Once you have selected "Build Your Own Discount" from the Promotion Type drop-down menu,
enter in a Promotion Name, such as "40 % Off Wine Decanter"
Under the Display Name section, enter in the display name for each language type.
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Promotion Properties:
l

Under the Campaign drop-down, select an existing campaign created earlier.

l

Target Markets will display the associated markets for which the campaign is available.

l

Promotion Group is grayed out because the Promotion Type is specified

l

From the Combination with other promotions drop-down, select the degree to which multiple promotions can be combined. There are three options: "Combine with other promotions",
"Exclusive within select groups", and "Exclusive within all groups."
Combine with other Promotions - The selected promotion will be combined with all
other promotion types that may be in use
Exclusive within Selected Groups - If the selected promotion is applied, no other
promotions within that group will be applied (but other promotions in other groups may
be applied)
Exclusive within all Groups - If the selected promotion is applied, no other promotions will be applied.

l

Enter a numerical value into the Priority field (promotions with a higher priority will be evaluated first)

l

Optionally, enter in a Coupon Code that customers can redeem from the front-end public
site to get receive the discount. Otherwise, leave the field blank.

l

Set the Status of the Promotion either as "Active", "Inactive," "Suspended," or "Deleted"
from the drop-down menu. Select Active to enable the promotion.
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Purchase Condition and Reward:
Here you can set your own Purchase Condition to receive the discount Rewards. To apply a 40%
discount for a wine decanter, use the following settings in the screenshot.

Redemption Limits:
Under this section, you can specify the redemption limits of this promotion.
l

Next to Max. Total Redemption, enter in the maximum number of times the promotion can
be redeemed.

l

Next to Max. Redemption Per Order, enter in the maximum number of times the promotion
can be redeemed per customer order.
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l

Next to Max. Redemption Per Customer, enter in the number of times a promotion can be
by a single customer.

Schedule:
Enter the date and time when the Promotion is Available and when it Expires.
Click OK to save the promotion. The promotion will appear in the Promotion List.

When the promotion is applied, the price on the front-end should change.
Buy catalog entry X, get catalog entry Y at a discount
The steps to create this discount are similar to creating a custom discount. The difference is the
Purchase Condition and Reward.
1. Under the Select catalog entry X drop-down menu, select a specific catalog entry.
2. Under the Select catalog entry Y drop-down menu, select another specific catalog entry.
3. Enter a value for the Quantity of "X" needed to qualify for the promotion. For example,
the customer must purchase 2 of Catalog Entry X as a prerequisite for the discount.
4. Enter a value for the Quantity of "Y" needed to quality for the promotion. For example,
the customer must purchase 3 of Catalog Entry Y as a prerequisite for the discount.
5. In the Amount field, enter in a number and select from the drop-down to indicate that the Promotion is Percentage Based or Value Based. For example, if you enter 40 and select Percentage Based, the Promotion will take off 40%. If Value based, it will be 40 off the total
price.
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Buy X get $ off discount
This type of promotion gives a discount per item by purchasing the minimum quantity specified
under these Purchase Conditions.
1. Enter a Minimum quantity that the customer needs to purchase in order to receive the discount.
2. Enter the Amount of the Promotional discount, whether Percentage Based or Value Based.
3. Select any number of Variations from the drop-down menu and click on "add variation."
Repeat to add more Variations to this Promotion. Click on the red X button next to the Variation to delete it.

Creating an order level promotion
Order Level Promotions are discounts applied if the overall order satisfies the conditions specified
by the promotion.
Out of the box, you can build these Order Entry Promotion Types:
l

Order: Buy X, get N quantity of Y at a discount

l

Order: Sub Total Volume Discount - if the order subtotal minimum is met, then the customer receives the discount.

l

Build Your Own Discount - you can create a custom order level promotion based on a range
of purchase conditions and rewards (similar to creating a custom catalog entry discount).

The options above are available in the Promotion Type field when creating a new promotion. The following are examples of how to create each type of promotion.
Buy X, get N quantity of Y at a discount
This type of promotion allows a customer to be eligible to buy a designated number of items at a
reduced price.
1. Select an Entry X variation from the drop-down menu and click on "add variation.
2. Select catalog entry Y from the drop-down menu. A certain number of "Y" entries will be discounted based on the Purchase Conditions.
3. Enter a Max quantity Y for the maximum number of Y entries eligible for a discount.
4. Enter the Amount of the promotional discount, whether Percentage or Value based.
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Order sub total volume discount
Enter in the Minimum order amount into the field. For example, if the order amount was set to
$200, then the customer must have $200 or more in his shopping cart to qualify for the discount.
Enter in the Amount of the discount. It can either be "Percentage Based" or "Value Based." If Percentage Based, then the customer gets a percentage off the price. If Value Based, the customer
gets a fixed amount discounted off.

Example: build your own discount - "20% off for a shopping cart subtotal of $100 or more"
Like a custom Catalog Entry discount (add link here), users can create their own custom Order Level
discount based on a list of Purchase Conditions and Rewards. This means that there is a wide
range of Order Level discount possibilities.
The follow Condition and Reward example shows how to create a Promotion that gives 20% off for a
shopping cart subtotal of $100 or more.

The discount should reflect on the shopping cart on front-end public site.
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Creating shipping level promotions
Shipping Level Promotions are promotions that give discounts based on the overall shipment.
The discount will appear on the order page just before you submit the order.
Out of the box, you can build these Order Entry Promotion Types:
l

Shipping: Build Your Own Discount - you can create a custom shipping promotion based
on a range of purchase conditions and rewards (similar to creating a custom catalog or order
entry discount).

The option above is available in the Promotion Type field when creating a new promotion. The following are examples of how to create each type of promotion.
Example: buy N quantity get % off shipment discount
This Promotion type applies shipping discount if the specified Variations total the Minimum Quantity set or more.
1. Enter a Minimum Quantity, for example "5".
2. Enter an Amount of the discount Reward, and select from the drop-down whether it is "Percentage Based" or "Value Based, for instance "20%".

Creating custom promotions
You can create custom promotions instead of using the built-in ones. It is possible to create custom
promotions on a catalog, order, or shipping level.
How to use "or" when building your own promotions
EPiServer Commerce has a powerful discounting engine and can be used to build all types of promotions without writing custom code. In most cases these discounts can be built using one of the
built in "Build Your Own Discount" options.
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Building the discount
In this case we want to build a promotion that will give a $10 discount on certain items in our catalog.
We want products with "Bordeaux" OR "Sauternes" in the display name to receive $10 off the item.
In this case we are using a Promotion Type of "Catalog Entry:Build Your Own Discount". Constructing the purchase condition can be a confusing when using the Or operator. The first item we
must add to the condition is the Or operator since And is the default. The Or will have the effect we
desire if added first which is And (Or (DisplayName = Bordeaux, DisplayName = Sauternes)) which
is translated by the rules engine to And (DisplayName = Bordeaux Or DisplayName = Sauternes). If
the Or is not added first the results will not be as desired as the DisplayName would have to contain
Bordeaux And Sauternes.
The Reward is set to $10 Off.

Setting promotions by customer group
Customer groups are useful for instance when setting specific permissions, promotions and targeted
marketing campaigns. Customer groups are not applied directly to a single promotion but rather controlled at the campaign level by means of customer segments. Customer segments allows various
conditions to be defined, one of which is "Customer Group". If any condition is satisfied then the customer in question qualifies for the segment.
Applying customer groups to promotions
Do the following to create a promotion for a specific customer group.
1. In the Marketing view in Commerce Manager, select Customer Segments and click New
Segment or edit an existing one in the list. Click New Condition or edit an existing condition.
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2. Click the green plus sign to start entering criteria for the condition.
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3. Select "CustomerGroup" and select a specific Customer group. Note that the customer group
must first be created in Commerce Manager, before it will appear in the listing.

4. Click OK to make the Customer Segment reflect the added condition (only the name is displayed for the condition). It is recommended to use a condition name indicating the customer
group.

5. The above example is a simple inclusion check, but there are additional options for customizing the selection of customers. For example the "Equals" comparison can be changed
to "NotEquals", which can be useful for excluding multiple customer groups as long as they
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do not match any other conditions for the segment.

6. Once the customer segments have been defined, the Campaign dialog allows a marketing
campaign to be associated with one or more customer segments. All promotions created for
the campaign will apply only for users in the selected customer segments. In this example
only contacts with an EffectiveCustomerGroup matching the selected customer group will be
eligible for promotions in the campaign.
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Editing and activating promotions
Editing a promotion
To edit an existing promotion, go to Marketing and Promotions to expand the list of promotions.
Select a promotion to edit by clicking on the promotion name in the list.

Update the information and click OK to save your changes.
Activating and inactivating promotions
Once a promotion has been created it can be activated and inactivated from the Promotion List
view. This is useful if you want to keep the promotion for reuse on another occasion.
In the Promotion List list, select the name of the promotion and then click on More Actions > Flip
status (active/inactive) on the menu bar. The selected promotion(s) will be activated/inactivated
depending on their current status.
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Deleting a promotion
In the Promotion List list, check the box next to the name of the promotion and then click More
Actions > Delete Selected on the menu bar. Click OK to confirm the deletion.

Expressions
Expressions are customizable conditions which allow users to extend different aspects of the marketing system. Expressions are essentially XML statements that enable you to create custom promotions, customer segments, and policies. The various parts of the marketing system - promotions,
customer segments and policies all rely on expressions. As an example, if you want to set up a promotion like "40% off Item X", the expression or condition to enable this promotion would include:
"Catalog ID for Item X and Reward of 40%".
Because of the powerful features of this function, creating expressions should only be
done by advanced users of EPiServer Commerce. In order to create an expression, knowledge of XML is required.

Creating an expression
Do the following to create an expression:
1. Go to Marketing under and select Expressions .
2. Expand Expressions and Promotions/Segment/Policy to view the Expression List page.
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3. To create a new Expression, click on New Expression. The Expression Edit page appears.
4. Enter an Expression Name, such as "EntryCustomDiscount."
5. Enter a Description of the Expression.
6. Enter the Expression XML.
7. Under Category, select from the drop-down whether this Expression is for a "Promotion,"
"Segment," or "Policy." Depending on your selection, the expression will appear under those
respective folders.
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8. Click OK to save changes.

Policies
Policies are business rules on how to eliminate similar promotions for the same order or same
product. Policies are always executed when promotions are applied and can be preconfigured for
each store. Policies can be optionally associated with one or more promotion groups.
If a policy is associated with a promotion group, it is considered a local policy, and applies only to
those promotions in the group to which this policy is associated. If a policy is not associated with a
promotion group, it is considered a global policy which applies to all promotions. This allows a marketing manager to declare rules just once for the whole site. An example of a rule can be for instance
"Do not allow negative orders".
Because of the powerful features of this function, creating policies should only be done
by advanced users of EPiServer Commerce.

Creating a policy
Do the following toe create a policy:
1. Go to Marketing and Policies to open the Policy List.
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2. Click on New Policy to open the Policy Edit page.
3. Enter a Policy Name.
4. Enter the Status of the policy.
5. Select "Yes" or "No" to set the policy Is Local.
a. Policy Is Local is No - this is the default behavior. This means that this policy is not
part of a promotion group and is available for all promotions.
b. Policy Is Local is Yes - this means this policy is part of a promotion group and is
applicable only for that promotion group.
6. Select an existing Policy Expression from the drop-down menu.
7. Select from the Groups list to place the policy under.
8. Click OK when done.

Policy Status and Policy Is Local has not been fully implemented. Therefore, all
policies will be global (meaning it cannot be limited to a promotion group) until this feature
becomes available in a future release.
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Reporting
Reporting for Commerce offers some common type reports out-of-the-box, intended to be used as a
support tool for e-commerce managers.
The built-in reports include:
l

Sales Report - an overview of the website sales performance over a period of time.

l

Shipping Report - the shipping method, number of orders and total shipping cost over a
period of time.

l

Best Sellers Report - shows which products are sold the most in terms of quantity and total
revenue over a period of time.

l

Low Stock Report - shows which products are running low in inventory. If a product's inventory is less than its reorder minimum quantity, it will be included in this report.

The display of these reports can be filtered by date, time, currency and markets, and reports can be
exported to Excel or PDF format, or printed.
You can also develop your own customized reports, refer to the technical documentation for
EPiServer Commerce for more information on how to do this.

Working with reports
The work with reports includes the following tasks:
l

Generating various reports based on e-commerce data such as sales quantities, markets,
order numbers, shipping costs and inventory stock status.

l

Filtering the view for displaying data for the desired time intervals.

l

Exporting reports to various outputs such as Excel, PDF or print.

Accessing reports
Reports are managed under the Reporting option in the left menu of Commerce Manager.

Generating a report
To generate a report, click on Reporting and select one of the default reports available under Sales
and Products: Sales Report, Shipping Report, Best Sellers Report or Low Stock Report. The
report display will be generated.
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Filtering report data
Reports can be filtered by markets and currencies, together with a date intervals. To filter the data
displayed, select Market, Currencies and set the Start Date and End Date ranges and time. You
can also group the report data by "Day," "Month" or "Year." Once done, click Apply Filter. To regenerate the report after changing the filtering, click the reload icon.

Exporting a report
When the report has been generated it can be exported as a file for further processing.To export a
report to a file, click on the Select a format option. By default reports can be exported either as
Excel or PDF files. Select a format in the drop-down, click Export and Open or Save the file once
the prompt appears. Reports can also be printed by clicking the print icon.
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Administration
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
In the Administration part of Commerce Manager you will configure and administer many of the system settings used in EPiServer Commerce. The settings configured here are both general settings
used by the entire system, as well as settings used by specific parts of the system such as Catalog
and Order management.
Languages supported by Commerce are added from the EPiServer CMS administrative
and editorial interfaces, as described in Managing multi-lingual content in the
CMS Administrator User Guide.
There are also a number of Commerce-specific scheduled jobs available, and these are also managed from the EPiServer CMS admin view as described in the Scheduled jobs section.

Working with administration
The work with system administration includes the following tasks:
l

Adding countries, currencies and return reasons to the e-commerce system, which is done
through so called Dictionaries.

l

l

l

Tracking changes and monitoring system activities through the log features.

Configuring common settings such as default language, currency, and length and weight
units to be used by the system.
Customizing, creating and publishing business objects in order to extend the attributes of the
Customer Management system, providing more flexibility for fields and attributes displayed
and collected.

l

Updating the search index for the website to reflect changes to the product catalog.

l

Customizing the left menu by adding your own menu items.

l

Defining warehouses and tax categories, as well as meta classes and meta fields to be used
by the Catalog Management system.

l

Defining payment gateways and shipping methods and providers, as well as configuring

taxes used by the Order Management system.

System settings
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
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System Settings includes functionality for adding default system settings for language, currency,
units and meta data fields and classes, as well as many other general configuration possibilities.
The features can be accessed by selecting System Settings under Administration.
Note that languages supported by Commerce are added from the EPiServer CMS administrative and editorial interfaces, as described in the Managing multi-lingual content in the
CMS Editor User Guide.

In this section we will describe how to work with the options under System Settings.

Dictionaries
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Dictionaries and dictionary values is a way to add "data about data". This feature is useful in many
ways to enrich data for instance when working with currencies, countries, customer organizations
and for describing catalog content.
In EPiServer Commerce, dictionary values are used in the following areas:
l

When defining countries and currencies used in the e-commerce process.

l

When creating return reasons used in order management.

l

When working with the enrichment of catalog content.

l

When working with customer organization structures.

l

When working with customer contact groups.
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Note that languages supported by Commerce are added from the EPiServer CMS administrative and editorial interfaces, as described in the Managing multi-lingual content in the
CMS Editor User Guide.

Adding countries
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Countries are used for instance when defining markets. To add a new country, open Commerce Manager and go to Administration > System Settings > Dictionaries > Countries.

Click on New Country and fill in the following displayed in the Overview tab:
l

Country Name - this is the friendly name that is displayed in the public site during the checkout process

l

Code - to obtain the correct country code, go to the MSDN site Table of Country/Region and

State/Province Names and Codes [C++] (use the ISO Short Code or ISO Long Code as long
as you remain consistent).
l

Sort Order - enter a number starting from 0 (the lower number is listed on the top of the dropdown)

l

Visible - Yes/No.

Regions refer to states, provinces or prefectures. In the Region tab, fill in the following:
l

Type a Friendly Name (e.g. CA - this will be displayed in the public site during the checkout
process) and click Add. You can also select whether it will be Visible or not on the public
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site.

When you click the Edit icon, you can change the Ordering of the region. Click Update to save
those changes.

Adding currencies
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Currencies are used for instance when defining markets and for catalogs. To add a new Currency,
open Commerce Manager and go to Administration > System Settings > Dictionaries > Currencies.

Click on New Currency. Fill in the following displayed in the Overview tab:
l

Currency Name - this name is displayed in the front-end public site currency drop-down and
various Commerce Manager administration pages.

l

Code - currency codes can be obtained from http://en.wikipedia.org/wiki/ISO_4217#Active_

codes.

© EPiServer AB

Administration | 173

In the Rates tab, you can Add Rates which are the foreign exchange rate when you want to convert
from one currency to another.

In the Edit Currency Rate Information dialog enter the following:
l

To Currency - select from the drop-down the currency to convert to from the current currency.

l

End of Date Rate - enter the End of Day rate.

l

Average Rate - enter the Average rate.

l

Currency Rate Date - enter a Currency Rate Date.

Click Save Changes.

Managing return reasons
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Return reasons are used in the order management process for adding data about returns. The built-in
return reasons in EPiServer Commerce are "Faulty," "Incorrect Item," and "Unwanted Gift." More
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return reasons can be added so that when a customer sales representative processes a return, customized return reasons will also be available from the drop-down menu.

Creating a new return reason
1. To add a new return reason, go to Administration > System Settings > Dictionaries >
Return Reasons. The Return Reasons screen appears.
2. Click New Return Reason. The Return Reason Edit screen appears.
3. Once done, click OK. The new return reason appears on the list.
Description

Field
Return Reason

Enter a friendly name, such as "Changed Mind".

Sort Order

The lower the value, the higher the position the return reason is on the list
screen.

Visible

Select Yes (to enable to return reason) or No (to disable it).

Editing and deleting a return reason
l

On the Return Reasons list, click on the Edit icon. Make any edits to the Return Reason
name, Sort Order, and its Visibility and then click OK to save your changes.

l

To delete an individual Return Reason, click on the Delete icon. To delete multiple return reasons at one time, check-mark the box next to the Return Reason and then click More Actions
> Delete Selected. Confirm your selection by clicking OK.

Logging
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Logs contains the system log and application log. These logs track the activities of made specifically within the EPiServer Commerce system. This is useful for troubleshooting purposes and if
you want to track events and changes in the system during a specific time period.
The log features are available under Administration, System Settings and Logs, in the left
column. Refer to the technical documentation for Commerce for more details on how to set up and
configure the logging features.
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EPiServer also has a log feature which tracks changes done to content in the system. Refer to
Change Log in the CMS Administrator User Guide for more information.
System log
The System Log keeps a detailed track of system-related activities within EPiServer Commerce.
Here is where you would be able to view any errors that occur in the system as well to find out more
details about it.
You may filter these logs to show more detail by filtering by Operation, Object Type, or the Created
Before date and time and clicking Apply Filter. You may also use Export Log for your records after
you have filtered for the desired data. The More Actions drop-down includes options to Delete
Selected or Delete All to remove log items.

Application log
The Application Log by default tracks changes made in the Catalog management system. For
example, when you add a SKU to a catalog, it gets logged here. This is the default behavior of the
application log and can be configured and extended to track and log other sources as well.
You may filter these logs to show more detail by filtering by Source Type, Operation, Object Type,
or the Created Before date and time and clicking Apply Filter. You may also use Export Log for
your records after you have filtered for the desired data. The More Actions drop-down includes
options to Delete Selected or Delete All to remove log items.

Configuring common settings
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
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Under Common Settings you are able to select your default language, currency, length unit, and
weight unit. When the defaults are set and saved, parts of Commerce Manager where you select the
language, currency, length unit, and weight unit default to those settings. Length and weight settings
are typically used when calculating shipping costs.
Defining languages, currencies and length/weight units
To set the default language, currency or unit, login to Commerce Manager and go to the Administration --> System Settings --> Common Settings and make the appropriate selections.

You have the following options:
l

Language - available languages as defined in the language settings.

l

Currency - available currencies as defined in the currency settings.

l

Length units - in centimeters or inches.

l

Weight units - in kilograms or pounds.

Click OK to save your changes.
See also
Refer to Multi-language management for more information on how to work with language settings in
EPiServer Commerce.
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Business foundation
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Business Foundation allows you to extend the attributes of the Customer and Asset Management
systems to give you move flexibility on the fields and attributes displayed and collected. Business
Foundation works with the meta data engine to allow no-code customization of the data model.
Using this you can define new objects and relations between these for the Customer Management
system.

The form is fully customizable so you can define layout and specify which fields you want to display.
You can also work with system fields. Common examples of how users leverage Business Foundation are setting a standard height and width for an image file uploaded to the Asset Management
system, or creating a "Gift Card" field within the Customer Management system used to track how
much a customer has left on their gift card.
The current implementation of Business Foundation only supports the Customer and
Asset Management subsystems. The Asset Management subsystem in Commerce Manager has been replaced by the EPiServer Asset system.
In the following we will describe how to work with the features in Business Foundation.
Creating business objects
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Business objects allows users to extend customer and asset forms for tracking and relating different
types of data. New business objects can be created to support customized business scenarios. In
this example we will describe how to create a "Contract" business object.
Creating a contract object
Do the following to add a contract business object:
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1. Go to Administration, expand System Settings, and click on Business Foundation to access
the Business Foundation Configuration page.
2. Click Create New and select New Business Object. The New Business Object dialog
appears.

Enter information as described below.
Base Info
l

System Name: name of the Business Object (once you input a name, the Friendly Name and
Plural Name fields are auto-populated).

l

Friendly Name: alternative to the System Name.

l

Plural Name: plural version of the system/friendly name for example inventories.

l

Supports Extensions: this allows you to extend an existing meta class with extra
properties. For example, you can have a download class and you can extend it with
"imagedownload" which contains width and height as extra parameters.

Field Info
l

System Name: enter a system name.

l

Friendly Name: enter a friendly, front-end name.

l

Maximum Length: maximum number of characters allowed in this field.

3. Click Save to save the changes. You will now see the details of your newly created business
object.

Next steps
Add fields to the contract business object as needed, refer to Adding Fields to Business Objects. To
further customize a business object, refer to Customizing Business Objects.
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Customizing business objects
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
A standard installation of EPiServer Commerce includes a number of business objects that can be
edited and customized. Customizing existing business objects is a good starting point to model business objects for your needs.
Editing existing business objects
Many of the default business objects and related fields can be both edited and deleted but not all of
them. For example, preexisting business objects such as "Address" and "Organization" cannot be
deleted, only edited. Business objects that can be edited and deleted will have an Edit and Delete
icon next to them.

Editing existing fields of business objects
Fields that can be edited and deleted will have an Edit and Delete icon next to them.

Fields that are locked cannot be edited, for instance Field Name and Field Type in the image below.
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Update the fields that are unlocked and click Save to save the changes to the business object.
Adding fields to business objects
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Existing Business Foundation objects can be customized to have additional data entry fields. For
example, you can add fields to the New Credit Card form built into Commerce Manager.
Adding fields to a business object
Do the following to add fields to an existing business object:
1. Click on Administration, expand System Settings, and click on Business Foundation to
access the list of Business Foundation objects. In this example, the CreditCard Business
Object is used.
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2. Click on the business object in the list to open it for editing. To add a new field to the CreditCard Business Object (or any other Business Object), click on New Field.

3. The New Field form allows you to specify the type of data field you want created for the business object.

Enter a Field Name, which is the system ID or name of the field. The Field Name that is
entered auto-populates the Friendly Name field.
Since the Friendly Name is auto-populated based on the Field Name, you can either keep
the name the same or change it. The Friendly Name is what appears on a form (such as the
Credit Card form).
You can optionally enter in a Description that appears below the data entry field to explain
the field to the user.
Select whether to Allow Nulls for this field.
You can choose to Add Field To an existing Form. Select all that apply.
Enter a Field Type. For further explanation of each Field Type, refer to the Reference Section
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on the bottom of this page. In this example, a String field type is used.
The Format drop down menu and options depend on your Field Type selection. In this
example, Text is selected as the field format, with a Maximum Length of 100. Unique value
is left unchecked.
4. Once done, click Save. The new field appears on the list of fields.

5. To verify if the new field appears, check the form associated with that new field. Since this
example customized the New Credit Card form, you will see that the new field appears.

Customizing forms
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Forms dictate how fields are presented to the EPiServer Commerce user when viewing and editing
information in the system. Every field is associated with a form, and each business object is associated with one or more types of forms. Some common types of forms found are the Edit Forms,
Short Info Forms, and View Forms. For example, the New Credit Card form looks like this:
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In this section we will describe how you can customize forms and adapt them to the specific needs
of your EPiServer Commerce users.
Editing forms
By editing the form, you can change the layout, add new fields and sections, and more.
To edit an existing form, click on a Business Object and click on the Forms tab to see the list of
associated forms.

Click on the Edit icon next to the form you want to make changes to. The form customization window pops up.

There are various functions available to edit and customize a form.
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Editing the layout
You can change the layout and the fields that appear on the form.
1. Click on Edit Form.
a. Select a View Type (or the layout of the form). You have a choice between a Two Column
(1:1, 1:2, 2:1), or Three Column (1:1:1) layout.
b. Enter in a pixel value for the Cell Padding, or spaces between each cell.
2. Click Save to confirm your changes.
This example uses a Two Column (1:1) layout.

Adding sections and fields
Once your layout is set, you can add additional sections and/or additional fields.
1. Click on Add --> Add Section to add a new section. Adding sections allows you to separate
and divide groups of fields on a form with their own header and border.
2. Enter in a Title for the section.
3. Select "Show border line for this section" if you want to show the border around section.
Otherwise, deselect the box to hide the border.
4. Select "Show the name of this section on the form" if you want to show the title of the section
on the form. Otherwise, deselect the box to hide the title.
5. Select a View Type or layout of the section: One Column, Two Columns (1:1), Two Columns
(1:2), Two Columns (2:1)
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6. Enter a numeric pixel value for Cell Padding or amount of space between each cell in the
section.
7. Click Save to save your changes.

You can edit a section by clicking on a section and click on Edit.

Within each section are fields. You can add new fields to a specific section by highlighting the section and then by clicking Add --> Edit.
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Select an existing associated field in the dropdown menu.
a. Select "Field is Read Only" box if you want the field to be unavailable for edit. When you see the
rendered form, the field will be grayed out.
1. Select the "Item label showing on the form."
2.

l

Hide Label: No label appears next to the text box

l

System Label: Shows the system name next text box

l

Custom Label: Enter in a custom label

3. Enter in a Label Width numerical value. Default is 120px.
4. Tab Index: enter an index for the tab.
5. Select a View Type, either a One Column or Two Column. In the dropdown, enter in the number of text box rows, up to 3.
6. Click Save to add the field to the section.
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To edit a field, click and highlight the field and click on Edit to change your previous settings.

You can re-arrange fields on a form but using the arrow controls on menu bar. Highlight the field and
then click on the directional arrow you want the field to move to.
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In this example, the "Security Code" field is moved to the right where the "Customer Service Phone
Number" field is placed by clicking on the right directional arrow. Fields are moved from cell to cell
within a section.

Deleting sections and fields
To delete a section or field, highlight either one and click on Remove. A pop-up will appear. Click OK
to confirm deletion. Otherwise, click Cancel.
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Recreating a form
Recreating a form allows a user to create a form from scratch with a single field rather than customize a form with all fields already in place. Click on Recreate Form on the upper right corner of the
window.

A pop-up will appear. Click on OK to recreate the form. Otherwise, click Cancel. Once you confirm,
the fields will clear from the form except for the required field.
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Saving a customized form
Once you are done with your changes, click on Save on the upper right corner of the window. To
save and close the window at the same time, click the down-arrow next on the Save button and on
the dropdown click Save and close.

Once those changes are saved, the form you edited will render based on your configuration. For
example, here is the customized Credit Card edit form an end user sees.
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Relating business objects
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Business objects must be related to other business objects to be able to connect, track and record
relevant data. This is where the concept of Relations is used in Business Foundation.
Relations can be of these types:
l

l

l

1 to Many Relationship - 1 object can be associated or related with multiple object-related
data. For example, one organization can be associated with multiple contracts.
Many to 1 Relationship - Multiple object-related data can be associated or related with a
single object. For example, multiple contacts can be related to a single organization.
Many to Many Relationship - Multiple object-related data can be associated or related with
multiple objects. For example, different SKUs can be associated with one or more warehouses for tracking and storage.

In the following we will describe how to create the various types of relationships between business
objects.
Adding a 1 to many relation
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Business Foundation objects allows you to specify 1 to Many Relationships. For example, if you
have one organization, you can relate many types of data to that organization, such as multiple contacts, addresses, or organizational units or divisions within an organization. Within a 1:N relationship, the business object you selected will be "1."
In the example below, 1 = Organization and N = related objects such as Address, Contact, CreditCard etc.
To add a 1 to many relationship to a business object, you will need to create a new business object
or use an existing one. On the Business Object Customization page, click on 1:N Relations.
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Click on New Relation "one to many" to create a new relation.

Under General Info, the Primary Object Organization is automatically set to Organization.
1. Select a Related Object to relate an the Organization object in the dropdown.
2. The Object section below General Info will have a different title based on Related Object you
selected. For example, if you selected "Address," the title would be "Object 'Address'".
3. Enter in a Field Name and Friendly Name. They are auto-populated already using the system name of the business object.
Both names must be unique and not be the same as an existing field. The Field Name cannot contact spaces or special characters, only letters, numbers, and underscores.
4. Select Allow Nulls if you do not want this to be a required field the user fill in while editing a
form. Otherwise, deselect the box to make it a required field.
5. Under Add Field To, select the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).
6. Under the Object "Name of Primary Object" section, select a Display region in the dropdown
box. Additional options such as Display Text and Display Order will appear based on your
dropdown menu selection.
7. Once all the relevant information is entered, click on Save.
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The Related Object will have the Primary Object appear under the opposite relationship
(N:1) on its configuration form. For instance, if organization is the Primary Object and the
Related Object is Address, the relationship is automatically generated under the N:1 tab
in Address.

Adding a many to 1 relation
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
You can relate business objects via a Many to 1 Relationship. For example, you can relate multiple contacts to a single organization or unit.
In the example below, N = Organization and 1 = related objects such as ParentId, PrimaryContactId
etc.
To create Many to 1 relationships, click on a business object and click on the N:1 Relations tab.
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Click on New Relation "Many to one" to create a new relationship.

The Relation N:1 form is very similar to the Relation 1:N form, except you can select the Primary
Object from the dropdown, whereas the Related Object defaults to the name of the Business Object.
Under General Info, the Primary Object Organization is automatically set to Organization.
1. Select a Primary Object to relate an the Organization object in the dropdown.The Object section below General Info will have a different title based on the Related Object name.
2. Enter in a Field Name and Friendly Name. They are auto-populated already using the system
name of the business object.
Both names must be unique and not be the same as an existing field. The Field Name cannot contact spaces or special characters, only letters, numbers, and underscores.
3. Select the box Allow Nulls if you do not want this to be a required field the user fill in while
editing a form. Otherwise, deselect the box to make it a required field.
4. Under Add Field To, select the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).
5. Under the Object "Name of Primary Object" section, select a Display region in the dropdown
box. Additional options such as Display Text and Display Order will appear based on your
dropdown menu selection.
6. Once all the relevant information is entered, click on Save.
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Like an 1:N relationship, if you create a N:1 relationship with a Primary and Related
Object, a 1:N relationship is automatically generated for the Primary Object under the 1:N
tab.

Adding a many to many relation
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
You can also create Many to Many Relationships with business objects. For example, many to
many relationships help to track different SKUs and their inventory levels with different warehouse
locations. Another example is multiple contacts a part of multiple organizations. A Many to Many
relationship between two objects is also referred to as a Bridge.
In the example both Organization and Organization_Contact = N.
To create a Many to Many relationship, click on a business object and then click on the N:N Relations tab.
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Click on New Relation "many to many" to create a new N:N relationship.

The Relation N:N is much different compared to the Relation 1:N/N:1 forms.
1. The Current Object defaults to the name of the Business Object you are editing
2. Select a Related Object from the dropdown menu
3. The Relation Name is auto-populated by (Current Object Name_Related Object Name).
Change this name if you wish, but you cannot have spaces or special characters, only letters, numbers, and underscores.
4. Enter in a Friendly Name, which can have special characters and spaces. Make sure both
Relation and Friendly Names are unique do not already exist.
5. Under Current Object, select a Display Region where the field will appear.
6. Under Related Object, select a Display Region where the field will appear.
Once all the relevant information is entered, click on Save.

© EPiServer AB

Administration | 197

A many to many relationship is automatically generated for the related object when you
click on its N:N tab under its configuration form.

Publishing business objects
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Another feature of Business Foundation is the ability to publish objects as a node in the left navigation in Commerce Manager. You can essentially add more functionality to a specific system
without modifying code. Before publishing you can set proper access permissions for the business
object, controlling which user groups will have access to use the business object
For related information refer to the section Customizing the left menu.
Setting permissions and publishing
Click on Publish on the Business Object Customization page.
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You can set permissions by customizing Access Permissions. This string is auto-generated. To
change, you can copy and paste string values from other objects.

Click Publish to publish the selected business object.
You must refresh your browser after a business object has been published in order to
make it appear in the left hand navigation.

Deleting business objects
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
All customized business object that have been published can be deleted by going to Administration > System Settings > Business Foundation.
To remove from the left menu, you have to perform an additional step of going to Administration >
System Settings > Left Menu and clicking the Delete icon.
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Updating the search index
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
When you have done changes to an existing product catalog, such as adding or deleting products,
you will need to index the catalog for those changes to be reflected in the search results.
There are two types of indexing: Build and Rebuild. Use the Build option to make a quick reindexing of an existing catalog where you made changes to existing products. Build is faster than a
rebuild because it performs a reindexing of only the items that were changed since the last build.
If you are using a brand new catalog or you made structural changes to your existing catalog (i.e.
moving categories around, changing a product name, etc.), then you will need to perform a Rebuild.
Rebuild takes longer because it does a complete indexing.
Building and rebuilding the catalog
To build or rebuild your catalog, go to Administration > System Settings > Search Index.
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Select Rebuild Index or Build index. Once you perform either of these two operations, you will see
the changes or additions reflected in your search results.

Customizing the left menu
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
The left navigation frame in Commerce Manager can be customized through the addition of business
objects. Before doing this, it is recommended to read the section Publishing business objects
describing how to set permissions and publish business objects.
Adding a left menu item from the left menu page
To add a Left Menu item, you have two choices. You can either configure the entire menu item first
within Business Foundation or you can add an empty container by clicking the Add button and then
go back to Business Foundation to fill in the page contents (objects).
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A new window will pop up for publication settings.
1. Select a Display Region from the navigation three on the left. Click on the node you want
Contract to be placed under. For example, Contract will be placed on the root level of Customer Management.
2. The Display Text defaults to the system name of the Business Object. You can choose to
keep the name or change it.
3. Enter in an Item Link, an URL to a page. When the object is clicked, a new window will
appear on the right based on the given link.
4. The Display Order defaults to 10000. You can keep it at that number or change the value to
determine the position of the node.
5. Access Permissions is auto-populated only when a menu is created through the Business
Foundation. When creating a new left menu from scratch, you may leave this field blank or
otherwise copy in permissions from other existing menus. If you want to change Access Permissions, refer to the Permissions section.
6. An Item Icon can be uploaded to represent the node. Click Browse to upload an icon.
7. Once all relevant information is entered, click on Publish.

To verify if the object was published, go to the Display Region where you specified the object to be
published to. Click on the Refresh icon on the left navigation frame if at first you do not see the new
node.
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Editing, ordering, or deleting a left menu item
To Edit a user-generated node in the left menu, click on the Notepad icon.

If the left menu item was created via the Left Menu page, this pop-up window will appear.

© EPiServer AB

Administration | 203

If the left menu item node was created using Business Foundation, this pop-up appears.
To change the sort order of the left menu item, adjust the numerical value in Display Order. The
lower the value, the higher the position of the item within the navigation tree relative to items with a
higher Display Order value.

To save changes, click OK.
To delete a left menu item, click on X icon.
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Catalog system administration
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Under Catalog System in Commerce Manager, you can set up warehouses and tax categories, as
well as work with catalog specific meta fields and meta classes.
The features can be accessed by selecting Catalog System under Administration in Commerce
Manager.

In this section we will describe how to work with the options under Catalog System.
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Warehouses
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
A Warehouse is the physical inventory location with an address from where product items are
shipped. Items can also be picked-up by customers in designated warehouses. As an e-commerce
manager in an organization with many fulfillment centers, you can manage multiple stock locations
by defining multiple warehouses in EPiServer Commerce. You can manage stock figures for a
product variant (SKU) by warehouse, and you can show total product availability across all warehouses. You can define physical store locations, and depending on how you set up your warehouses
you can work with features such as check stock in-store, reserve and pick up in-store and deliver to
store. When creating product variants, you will specify the warehouse where the item is being
stored.
Adding a warehouse
Do the following to add a warehouse or an inventory location:
1. In Commerce Manager, go to Administration, expand Catalog System and select Warehouses.

2. The Warehouse List appears. Click on New Warehouse on the menu bar.

3. Enter information for the Overview tab.
Name - the name of the warehouse.
Code - the location code for the warehouse.
Available - select "Yes" to make the warehouse available.
Is Primary - select "Yes" to make this a primary warehouse.
Is Fulfillment Center - select "Yes" to make this a fulfillment center where orders can be
placed for outgoing shipments.
Is Pickup Location - select "Yes" to make this a pickup location where orders can be placed
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for in-store pickups.
Is Delivery Location - select "Yes" to make this a delivery location which an be used for
future in-store pickups.
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4. Enter relevant information for the Address tab.

5. Click OK to save your changes. The warehouse will appear in the list.
Deleting a warehouse
Select the warehouse(s) to be deleted in the warehouse list, then click More Actions and select the
Delete Selected options..

Click OK to confirm the deletion.
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Tax categories
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Tax categories for catalogs will work in coordination with your tax configuration setup for orders.
The tax configurations includes specific taxes for example state, local and federal taxes. You can for
instance add a tax category "luxury items" for specific products, or VAT for different regions.
Refer to the Tax configuration section for more detailed information.
Adding a tax category
Go to Administration, Catalog System and click Tax Categories to see a list of existing tax categories.

To create a new category, click on New. A pop-up window appears. In the Tax Category Name
field, enter a name and click OK to save the tax category.
Deleting a tax category
To delete a tax category, click the Delete icon next to the item in the Tax Categories List. To delete
multiple items, select the check boxes next to items, select More Actions and then Delete Selected.

Catalog meta classes and fields
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Using meta classes and meta fields, it is possible to extend the meta data of catalog items and order
forms. Meta fields are for adding specific data about an item. For instance, if you create a meta class
called "Wine" you will want to add meta fields that are characteristic for wine, for instance "color",
"taste", "vintage" and "maturity".
From here you can also define both single and multiple dictionary type of value selectors and define
options for these. This will result in a drop-down selector where editors can select values for product
properties, for instance "fabric types" for clothing, or "genre type" for media.
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When meta fields and classes have been created in Commerce Manager, they will be available for
usage when working with catalog entries in the product catalog.
Creating a meta class
Do the following to create a meta class:
1. Navigate to Administration, Catalog System and select Meta Classes. This will open the
Meta Classes page.
2. Click Create New and select New Meta Class.

3. Enter the meta class details.
Name - name of the meta class used in your code, this cannot have any spaces.
Friendly Name - name of the meta class displayed for practical use in Catalog Management.
Description - description of the meta class.
Object Type - select Catalog Node or Catalog Entry.
4. Click OK to save your changes.
5. You will now see that your newly created meta class is available in the drop-down for Type.
If you select the meta class you will see all of the available meta fields listed below, but with none
selected. Next steps will be to create and apply desired meta fields.
Creating a meta field
Do the following to create meta fields and customize the attributes of a catalog meta class:
1. Navigate to Administration, Catalog System and select Meta Fields. This will open the Meta
Fields page.
2. Click Create New and select New Meta Field. Click on New Meta Field and the meta field edit
page will appear.
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Alternatively, select New Meta Field from the Create New drop-down within the Meta Classes
page.
3. Enter Meta Fields details.

Field

Description

Name

Enter a system name without spaces or special characters (e.g. "NumberMegapixels," without the quotes).
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Friendly

Enter a user-friendly name seen by end-users on the back and front-end (e.g. "Num-

Name

ber of Megapixels," without the quotes).

Description Enter any additional information about the meta field.
Type

The drop-down menu shows the field types you can use for the meta field. The
types available are:
- datetime
- decimal
- float
- money
- Integer
- Boolean
- Date
- Email
- URL
- Short String
- Long String
- Long Html String
- String Dictionary
- File
- Image File
- Dictionary (single and multiple line dictionary type option selector)

Search
Properties

Depending on the data field type selected, you may have the option to set the
search properties of the data field. The options are:
- Allow search - allows for searching directly on this metafield.
- Enable Sorting Search Results - search results will be sorted on this metafield.
- Include Values in Search Results - when the search results is returned, the original value of this metafield will be included with the search results.
- Tokenize - search is prepared for individual words in, for example a long product
description property (word breaking).
- Include in the Default Search - feature which tokenizes and combines
metafield values for search from the front end site.

4. Click OK to save your changes. The newly added meta fields will be listed in the meta fields list.
If newly created meta fields are not immediately visible, go to the next page or set the
Page Size to display more entries.
Applying meta fields to a meta class
Do the following to apply meta fields to a particular meta class:
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1. Navigate to Administration, Catalog System and select Meta Classes.
2. Select Catalog Entry from the Element drop-down menu, then select the desired meta class
from the Type drop-down.
3. To apply a meta field to a meta class, check mark the box next to the meta field. If you wish
to sort the order that the meta fields appear in the catalog entry, enter a number into the Sort
field.

4. Click OK to save your changes.

Order system administration
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Under Order System you can set up payment methods, shipping methods and providers, configure
specific taxes, as well as work with order specific meta fields and meta classes.
The features can be accessed by selecting Order System under Administration in Commerce
Manager.
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In this section we will describe how to work with the options under Order System.

Payments
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Payments is an essential part of an e-commerce system. When shopping online customers will be
presented with a number of different payment options. You can also customize market specific payment methods, to be used for specific markets. When creating and configuring payments in
EPiServer Commerce, there are three components that need to be created or re-used as well as configured: Payment Types, Payment Gateways and Payment Methods.
Payment types, gateways and methods
Payment types are meta classes which contain the properties for a particular payment type. For
example, a credit card payment type contains credit card number, card expiration date and card
type. Some payment types are built-in to EPiServer Commerce:
l

Payment by phone

l

Exchange payment

l

Credit card payment
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In addition, a generic "OtherPayment" class type is included in EPiServer Commerce. There are
also additional payment providers available as modules for EPiServer Commerce.
Payment gateways provide an interface to the system which provides payment processing. A payment type is passed to the payment gateway and the gateway executes the payment transaction
with the payment system (for instance PayPal). One payment type is associated with each payment
gateway.
Payment methods contain information about the way the customer views a payment option and
has a payment gateway associated with it.
Using built-in payment gateways
To setup payments using a built-in payment gateway, go to Administration, Order System and
Payments. Select a language in the list.

The Payment Methods window appears, displaying available payment methods for the selected language.

Creating a payment method
To create a new Payment Method, click on New to open the Payment Method Edit screen.
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Explanation of payment method properties:
l

ID – the system-assigned unique identifier for the payment gateway.

l

Name – the name to be displayed to the user.

l

Description – a description that can be displayed to the user.

l

System Keyword – the unique name for each instance of the gateway; new non-unique
keywords will not save to the database. This is not be editable after a gateway is initially created.

l

Language – allows a specific language to be specified for the payment gateway.

l

Class Name/Payment Class – name of the gateway class to be associated with the payment.

l

Sort Order – specifies the order of the payment method on the list of payment methods page.

l

IsActive – specify whether or not the payment method is active.

l

IsDefault – specific whether or not the payment method is the default one.

l

Supports Recurring – specify whether this payment methods supports recurring payments,
such as for subscriptions.
l

Restricted Shipping Methods – restricted shipping methods is not fully implemented out of the box and requires a developer to complete the functionality.
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Under the Markets tab you can select the markets where the payment method should be available.
Note that markets must be defined before they can be made available for selection.

Click OK to save the Payment Method. The payment method will appear in the list of Payment
Methods.
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For a payment method to appear it has to be all of: (1) assigned to the market, (2)
assigned to a language that is valid for the market, and (3) assigned to a language that is
valid for the site.
Editing payment methods
To edit an existing payment method, click on the Notepad icon next to the Delete icon.

The ID is auto-generated. Every field can be changed except System Keyword. After you are satisfied with your changes, click on OK.
Deleting payment methods
To delete Payment Methods, click on the X icon next to the payment method name and click OK
when the pop-up appears. To delete multiple payment methods at once, check mark each payment
method you want to delete, then click on More Actions --> Delete on the drop-down menu. Click
OK when the pop-up appears.
Using nSoftware provided payment gateways
EPiServer Commerce supports multiple payment gateways out of the box using nSoftware where
new payment methods can easily be set up by end-users.
1. To enable nSoftware supported gateways, create a new payment method.
2. Enter in a Name, such as nSoftware or anything else.
3. Enter in a Description.
4. Enter in the System Keyword as "ICharge".
5. Select a Language from the drop-down menu.
6. Select the Class Name "Mediachase.Commerce.Plugins.Payment.ICharge.IChargeGateway".
7. Select "Yes" for IsActive.
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8. Change the Sort Order, IsDefault, Supports Recurring as needed.
9. Click OK to save changes.

Once created, click on the payment gateway again to go back to the Payment Method Edit page.
Click on the Parameters tab.
The Configure IBiz E-Payment Integrator Component appears and you can select from the Gateway drop-down menu several dozen of the most popular payment gateways will appear. Depending
on the gateway you select, such as Authorize.Net, the Configuration Parameters will change.
Enter in your credentials and other relevant information to activate the gateway and click OK.
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Shipping
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Shipping involves everything related to the actual physical delivery of products to e-commerce customers. Just as for payments, you can set up shipping methods, gateways and providers. In the following the terminology is described as well as the different configuration possibilities for shipping.
There are two options out of the box for shipping gateways:
l

Generic Gateway (flat shipping rate)

l

Weight/Jurisdiction Gateway (base price + additional fee depending on weight and shipping
location)

These are starting points to create customized shipping gateways. For more information refer to the
Developer Guide for EPiServer Commerce.
The shipping administration is available under Administration, Order System and Shipping.
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Shipping methods
A shipping method manages a set of information and rules that determines the shipping cost and
displays it on the front-end site while a customer checks out an item from his/her shopping basket.
The shipping fee is added to the total price of the purchase. A shipping method is mapped to a shipping provider visible to a back-end administrator in Commerce Manager. This allows the public site
to display friendly names such as "Ground Shipping" to the customer and this is mapped to a provider such as UPS. Therefore, when a customer picks "Ground Shipping", UPS will be used by
default.
Shipping providers
A shipping provider is the class(es) that interacts directly with one or more actual shipping services such as USPS, UPS, or FedEX. It retrieves shipping price information from the shipping service(s) its associated with. One typical scenario would be to have a provider that represents a
particular service (e.g. USPS). A provider can also represent a particular type of shipping situation.
One example is that you could have a provider for overnight delivery. The provider could retrieve pricing for that service to determine the lowest price given the location of the customer. A provider
could also represent other specific scenarios with one or more services such as price by weight or
ground shipping.
Shipping gateways
A shipping gateway is the specific class that you select (Generic Gateway or Weight/Jurisdiction
Gateway). You select the shipping gateway in the Shipping Provider screen and then configure the
actual values for that gateway/provider in the Shipping Methods area.
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Shipping jurisdictions
An option which allows you to define values for region-specific shipping rates; this is only used when
you select the Weight/Jurisdiction Gateway, for instance for a "county".
Shipping jurisdiction groups
Group of jurisdictions; this is required because this is a required field when configuring the Shipping
Method parameters, for instance for a "region".
Shipping methods
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
A Shipping Method manages a set of information and rules that determines the shipping cost and
displays it on the front-end site while a customer checks out an item from his/her shopping basket.
The shipping fee is added to the total price of the purchase.
Customizing shipping methods
There are two Shipping Methods available out of the box for you to customize: Ground Shipping
and Fixed Shipping.
To customize the Shipping Methods, first go to Administration > Order System > Shipping >
Shipping Methods > English (United States) or any other languages.
At the Shipping Methods List screen, select the edit icon for either of the available methods. The
Overview tab screen for Shipping Method Edit will load with the below fields:
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l

ID - this is auto-generated after saving the new shipping method

l

Name - enter in a name without spaces or special character; this name will not be displayed
in the public site, but is only for end users to manage and organize the shipping methods

l

Friendly Name - enter a friendly name which can have spaces and special character; the
friendly name is the name seen by customers who are purchasing items

l

Description - enter a description (optional)

l

Provider - select an available provider from the drop-down menu; the options displayed here
are created in the Shipping providers screen (Generic Gateway is for a fixed shipping fee specified below under base price, while Weight/Jurisdiction Gateway is used for a shipping fee
depended on the weight and shipping location)

l

Language - select a language of your choice from the drop-down menu

l

Base Price - the base price you specify here will become the fixed shipping fee for the Generic Gateway option, and part of the Weight/Jurisdiction Gateway option.

l

IsActive - select Yes or No under IsActive to enable is disable it, respectively

l

IsDefault - select Yes or No if this shipping method is the default one

l

Sort Order - enter a number for the sort order to determine its position on the list of shipping
methods

The Settings tab is used to exclude any Countries, Regions, and Payments from a particular shipping method.
To exclude a selection, highlight the items on the Available boxes on the left and move them to the
Chosen Countries boxes by clicking Add.
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The Parameters tab is use to set conditions to determine the shipping fee. This screen become available only when the Weight/Jurisdiction Gateway is select in the Provider field in the Overview tab (it
will be empty with the Generic Gateway option).
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l

Jurisdiction Group - select a jurisdiction group to apply the current Shipping Method using
the drop-down menu; the options listed here are set up in the Shipping Jurisdictions and
Shipping Jurisdiction Groups screen.

l

Weight - enter a numerical value for the weight; units for the weight is set in the Common Set-

tings screen
l

Price - enter a price to be added to the base price (Overview tab) when the weight and jurisdiction group conditions are met.

l

Start Date - enter a start date and time for the shipping method to take effect

l

End Date - enter a end date and time for the shipping method to expire

When finish entering the values above, select Add to save the condition. The condition will appear
on table below. In the above example, if the customer checks out an item that weights anywhere
between 0 to 10 weight units (lbs for example), and the customer's shipping address is in the United
States, then the total shipping fee will equal $10 + the base price you enter in the overview screen.
Click OK to save changes.
Deleting shipping methods
1. Check off the box that corresponds to the shipping methods you want to delete.
2. Click on the More Actions button on the upper left corner of the main window menu bar, and
choose Delete from the pull down menu.
3. Click OK when prompted. The selected methods will be deleted from the list.
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Shipping providers
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
A Shipping Provider is the actual shipping service such as USPS, UPS, or FedEX. However, a
provider can also be a type of shipping in order to determine shipping price. The Shipping Providers page manages the list of these providers/types. There are two shipping methods available
out of the box for you to customize: 1) Generic Gateway and 2) Weight/Jurisdiction Gateway.
A Generic Gateway is used for a fixed shipping fee while Weight/Jurisdiction Gateway is used for
a shipping fee that is calculated based on the weight and shipping location.
Customizing shipping providers
Go to Administration > Order System > Shipping > Shipping Providers. Edit one of the two
providers listed.
1. Edit Name, and Description.
2. System Keyword (no spaces) and Classes are something that your developers need
to code and provide.
3. Click OK to save changes.
The revised shipping provider will appear in the Shipping Providers page.
The Parameters and Packages tabs are not fully implemented; they serve as a starting
point for developers for full implementation of those features.
Deleting shipping providers
1. Go to the Shipping Providers page.
2. Check off the box that corresponds to the shipping providers you want to delete.
3. Click on the More Actions button on the upper left corner of the main window menu bar, and
choose Delete from the pull down menu.
4. Click OK when prompted. The selected providers will be deleted from the list.
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Tax configuration
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Taxes can be configured so that specified rates are calculated and added to the total price during the
checkout process. Depending on your configuration, it is also possible to combine and apply multiple
taxes (such as federal, state and local tax) to a purchase.
Taxes can be set up and maintained using two methods:
l

Creating/editing each tax control manually.

l

Importing all data using a CSV file.

In the following we will provide a few examples to demonstrate how this works.
Taxes are configured
Configuring taxes manually
To set up your taxes manually, you will need to work with the following areas in the Administration
tab of the Admin Site – Tax Categories, Tax Jurisdiction Groups, Tax Jurisdictions, and Taxes
– as well as the configuration pages for each of the catalog items.
The steps below summarize the process you need to follow to configure taxes.
1. Create and configure Countries and Regions (Go to Administration > System Settings > Dictionaries > Countries): In Countries section create the countries you plan to sell
your products in and set the appropriate country codes. For the country codes, it is important
that you use the ISO Short code provided at MSDN site Table of Language Culture Name,

Codes, and ISO Values Method [C++]. Using the ISO Long code or anything else will not correctly calculate taxes during checkout.
2. Create new Tax Categories (Go to Administration > Catalog System): In this step you
will create tax categories that will be used later to associate your catalog items with the tax
rates you define. For example you may create categories such as "General Sales," "Food,"
and "Luxury Items" depending on the tax regulations for your item types. The categories you
create here will become selectable on the Page Details of your items (i.e., Variations/SKU
Edit page) and on the Tax Edit page.
3. Create and configure Tax Jurisdictions (Go to Administration > Order system > Tax
Configuration): In this step you will specify particular Tax Jurisdictions. You can create different Tax Jurisdictions for a particular region by specifying zip codes, country codes, etc.
Tax rates will be applied to whatever level of information you specify for each Jurisdiction.
For example, if you specify only the country code as US, all shoppers with a US address
(regardless of state, county etc.) will be included in this jurisdiction. Note: Country Code and
Region Code you enter in the Jurisdictions Edit page must match the codes you used in
step 1.
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4. Create and configure new Tax Jurisdiction Groups (Go to Administration > Order system > Tax Configuration): New Tax Jurisdiction Groups created here can include multiple
Tax Jurisdictions.
5. Create and configure Taxes (Go to Administration > Order System > Tax Configuration): Here you will specify tax rates and also associate the Tax Categories and Jurisdiction groups created in Steps 2 and 4.
6. Associate Catalogs to the Tax Categories created in Step 2 (Go to Order Management >
Catalogs): Now you will switch over to the Catalog Management subsystem and link specific catalog items to the appropriate Tax Categories. This can be done on the Pricing/Inventory page within each Variation/SKU Edit page.
Configuring taxes using CSV import
Using the CSV Tax Import functionality is a convenient way to quickly setup and update tax data in
bulk. Creating a CSV tax file with a specified format (see "Example Scenarios" below) will allow you
to complete steps 2 through 5 in one shot (above in Method 1). Step 6 of Method 1 can be done manually, but you can also use the CSV import functionality in the Catalog Management subsystem to
associate catalogs to tax categories.
Import your CSV tax file into your Commerce Manager by following the steps:
1. Select the Administration tab in the Commerce Manager.
2. In the navigation tree drill down to Taxes: Order System > Taxes Configuration > Taxes.
3. Click Import Taxes on the menu bar.
4. Choose Add New File and then Browse to select and upload your CSV tax file. The path of
your chosen file will appear in the field.
5. Click Upload File and then Save The File icon. The CSV tax file will appear under the Files
Available for Import section.
6. Select and highlight the CSV file and click the "Start Import" button.
7. Your import should begin and complete successfully in a pop-up dialog box.
8. You will now be able to view your tax setup in the Commerce Manager.
If you want to edit the existing setup, simply repeat steps 1 through 8 with your modified file.
Caution: Re-importing CSV files only edits existing information or adds new data, but nothing gets
deleted. If you delete an entire row of data in the CSV file, you must manually delete those entries in
the Commerce Manager. If in doubt, you can always delete all the tax data and perform the CSV tax
import from scratch.
Sample CSV files and scenarios
Example 1: Single tax per catalog item based on a single jurisdiction
For example, if your variable is State, then you can specify the tax rate on a state-level. So let's say
CA is 9% and MA is 6%. If you placed an order from California, then 9% sales tax would be applied
during checkout.
Jurisdiction

Jurisdiction Group

Tax Rate

Tax Category
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California

CA Tax Group

9%

General Sales

Massachusetts

MA Tax Group

6%

General Sales

Sample "TaxCSVSample1.csv" in this sample .zip file.
Example 2: Two or more taxes per catalog item based on more than one jurisdiction
For example, if you have a luxury item that requires State and Federal tax to be applied, then you can
specify tax rates on a state and federal level. So let's say a luxury item purchased in CA has a 9%
state tax rate and a federal tax rate of 3%. Both taxes would be applied during checkout.
Jurisdiction

Jurisdiction Group

Tax Rate

Tax Category

California General

CA GS Tax Group

9%

General Sales

Massachusetts General

MA GS Tax Group

6%

General Sales

California Luxury

CA LX Tax Group

9%

Luxury Sales

Massachusetts Luxury

MA LX Tax Group

6%

Luxury Sales

US Federal Luxury

US LX Tax Group

3%

Luxury Sales

Refer to "TaxCSVSample2.csv" in this sample .zip file.
Example 3: Tax CSV file with tax type specified
You have the possibility to specify the tax type, available built-in options are "Sales Tax" and "Shipping Tax".
Jurisdiction

Jurisdiction Group

Tax Rate

Tax Category

California

CA Tax Group

9%

Sales tax

Massachusetts

MA Tax Group

6%

Shipping Tax

Sample "TaxCSVSample3.csv" in this sample .zip file.

Order meta classes and fields
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
Using meta classes and meta fields, it is possible to extend the meta data of catalog items and order
forms. Meta fields are for adding specific data about an item. For instance, if you create a meta class
called "Wine" you will want to add meta fields that are characteristic for wine, for instance "color",
"taste", "vintage" and "maturity".
When meta fields and classes have been created in Commerce Manager, they will be available for
usage when working with catalog items and orders.
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Default order meta fields used by the ordering process are built into the system and are
not available. However, you can add your own meta fields to extend the attributes of your
orders.
Creating a meta class
Do the following to create a meta class:
1. Navigate to Administration, Order System and select Meta Classes. This will open the
Meta Classes page.
2. Click Create New and select New Meta Class.

3. Enter the meta class details.
Name - name of the meta class used in your code, this cannot have any spaces.
Friendly Name - name of the meta class displayed for practical use in Order Management.
Description - description of the meta class.
Object Type - select Order Group, Order Form, Shipment, LineItem, Order Group
Address or Order Form Payment.
4. Click OK to save your changes.
5. You will now see that your newly created meta class is available in the drop-down for Type.
If you select the meta class you will see all of the available meta fields listed below, but with none
selected. Next steps will be to create and apply desired meta fields.
Creating a meta field
Do the following to create meta fields and customize the attributes of an order meta class:
1. Navigate to Administration, Order System and select Meta Fields. This will open the Meta
Fields page.
2. Click Create New and select New Meta Field. Click on New Meta Field and the meta field edit
page will appear.
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Alternatively, select New Meta Field from the Create New drop-down within the Meta Classes
page.
3. Enter Meta Fields details.

Field

Description

Name

Enter a system name without spaces or special characters for example "NumberMegapixels".

Friendly

Enter a user-friendly name seen by end-users on the back and front-end.

Name
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Description

Enter any additional information about the meta field.

Type

The drop-down menu shows the field types you can use for the meta field. The
types available are:
- datetime
- decimal
- float
- money
- Integer
- Boolean
- Date
- Email
- URL
- Short String
- Long String
- Long Html String
- String Dictionary
- File
- Image File
- Dictionary

Search Prop- Depending on the data field type selected, you may have the option to set the
erties
search properties of the data field. The options are:
- Allow search - allows for searching directly on this meta field.
- Enable Sorting Search Results - search results will be sorted on this meta
field.
- Include Values in Search Results - when the search results is returned, the original value of this meta field will be included with the search results.
- Tokenize - search is prepared for individual words in, for example a long product
description property (word breaking).
- Include in the Default Search - feature which tokenizes and combines meta
field values for search from the front end site.
4. Click OK to save your changes. The newly added meta fields will be listed in the meta fields list.
If newly created meta fields are not immediately visible, go to the next page or set the
Page Size to display more entries.
Applying meta fields to a meta class
Do the following to apply meta fields to a particular meta class:
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1. Navigate to Administration, Order System and select Meta Classes.
2. Select Catalog Entry from the Element drop-down menu, then select the desired meta class
from the Type drop-down.
3. To apply a meta field to a meta class, check mark the box next to the meta field. If you wish
to sort the order that the meta fields appear in, enter a number into the Sort field.

4. Click OK to save your changes.

Scheduled jobs
This topic is intended for administrators and developers with administration access rights
in EPiServer. Refer to EPiServer World for additional technical information and developer
guides.
A scheduled job is a service performing a specific task that can be executed repeatedly at a given
time interval or when an administrator manually executes. In a sample installation of EPiServer Commerce, a number of scheduled jobs will be added to the administration interface. The predefined
Commerce-specific scheduled jobs are described in more detail in the following.
Refer to Scheduled jobs in the CMS Administrator User Guide for more information about scheduled
jobs in the EPiServer platform.
Remove expired carts
Shopping carts are created by shoppers from the front-end site, and then converted to a purchase
order during the checkout process. Carts that are "abandoned" and not converted into an order, will
be stored in the system for a certain time before they expire. The Remove Expired Carts job will
remove expired carts when executed.
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Rotate encryption keys
Encryption keys are used for securing sensitive customer data and is set on meta fields. The Rotate
Encryption Keys job will rotate the encryption keys used by the system. Refer to the EPiServer
Commerce SDK for more information on encryption.
Full search index
The Full Search Index job will perform a full search indexing.
Subscription payment plans
Payment plans are used for generate recurring payments, for example for magazine or grocery subscriptions. The Subscription Payment Plan job will ensure that these recurring payments are regularly generated as a background process.
Incremental search index
The Incremental Search Index job will perform an incremental search indexing.
Serialize catalog meta data
The Serialize Catalog Meta Data job is used for serializing catalog data to speed up the meta data
retrieval when searching catalogs.
Shipment releasing
The Shipment Releasing job searches for releasable shipments in active orders. If the difference
between current time and shipment creation time is greater than the configured time span, the shipment status for the order will be changed to "released".
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Managing content
Content on a website can originate from different sources, depending on where on the site and by
whom it has been created. On an e-commerce site the main content is usually made up by the
products from the product catalog, and the exposure of these through various types of categorization, faceted navigation or filtering. This content is usually created "internally" by marketers,
merchandisers and editors. Content can also be created "externally" by the "shopping community"
through various social features on the website.
This section describes how to work with e-commerce-related content. Refer to Managing content in
the CMS Editor User Guide, for general information on how to work with content creation and publishing in EPiServer.

What is content?
In EPiServer Commerce content can be information related to catalog entries such as categories,
products and variants. Often catalog content is based on data retrieved from external systems. Content can also be information entered in CMS pages and blocks. Content updating is done by different
user groups, for instance merchandisers organizing the product catalog, managing pricing and enriching the product information, as well as marketers and editors creating campaign pages and promoting products.

Content types
The content type defines a set of properties for an item. Content types are normally created through
code (page, block, media or catalog entry types), but they can sometimes be modified through the
administrative interface.
Catalog content consists of a set of content types related to catalog entries such as categories,
products, variants, packages and bundles. You will see these when you create a new catalog entry,
for instance a product category. You can also browse the catalog tree to see the structure of catalog
entries, and the content types that they are based on.
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Working with product catalogs
The product catalog structure is conveniently managed from the Catalog view in Commerce. From
here you can work with product categorization to create new categories and add products and variants to these. Relations between catalog entries are easily created through drag-and-drop functionality. Refer to Product categorization for more information.

Editing catalog content
Content editing involves adding text, media such as images and videos, and links to properties in different content types, for instance adding a product description. Much of the same editing features
are available when working with content in both CMS and Commerce.
Catalog entries such as categories, products and variants can be edited from the On-Page Editing
or the All Properties editing views, the last one providing access to all editable properties for the
entry. Changes done can be published directly on the website, or scheduled for later publishing.

Linking to content
In Commerce, the Link tool has an additional option where you can create links to entries in the
product catalog. Links to catalog content can be created either from the rich-text editor, or from a link
property in the content you are working with. In both cases you will have the option to select a catalog entry in the link tool dialog.
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Refer to Managing content in the CMS Editor's User Guide for more information about editing features in EPiServer.

Editing price information
The Pricing overview available from the Catalog view in Commerce, offers a convenient way of
managing pricing across products, markets and customer groups. You can view and compare prices
filtered by markets and customer groups, and easily make adjustments as needed. Refer to
Managing pricing for more information.

Catalogs gadget
The Catalogs gadget is available in the assets pane in both CMS and Commerce. You can use this
to drag catalog entries into the rich-text editor or a content area of a CMS page or block, to display
and promote selected product information, for instance in a campaign page.
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In order for product information to be properly displayed when used in other types of content, rendering templates must first be defined for displaying catalog content.
You can also use the Catalogs gadget to create relation links between catalog entries by dragging
catalog items into the Relations tab of other catalog entries. Refer to Editing and publishing catalog
entries for more information.

Managing multiple languages
E-commerce businesses often exist in multiple markets, meaning that catalog content needs to be
available in several languages. Catalog content can be managed in multiple languages, and you can
also activate multiple languages for the EPiServer Commerce user interface. Refer to Multi-language management for more information on how to work with multiple content languages.

Personalizing content
The personalization feature in EPiServer CMS can be used to target content towards specific visitor
groups. You can for instance design campaigns based on recent orders or the total spent amount for
a customer. The personalization option is available in the rich-text editor, and can also be applied to
blocks if these are available on your website. Refer to Commerce personalization criteria for more
information.

Commerce-specific gadgets
EPiServer Commerce has a set of e-commerce-specific gadgets which can be added to the dashboard in EPiServer Refer to Commerce gadgets for more information.
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Search and best bets for catalog content
If you have EPiServer Find installed on your website, you can promote content in your product catalog by adding best bets to the search results. Refer to the EPiServer Find User Guide for more
information.

Multi-language management
Translating catalog content is similar to translating CMS-related content such as pages and blocks.
In addition to this, specific language settings are also used for catalogs, markets, as well as payment and shipping methods in Commerce.
Usually a website will have a default or "master" language for content set up at the time of installation. In addition to this, you may add multiple content languages as required for your website.To
work with multiple languages for content in EPiServer Commerce, the languages must first be
enabled in the CMS admin and edit views.
Languages for catalog entry content such as product (SKU) descriptions, are set on catalog level.
This means that when you configure a language for a catalog, you will get the possibility to define
catalog entry descriptions in this specific language. When enabling a language, the language specific fields will appear ready for translation in edit view.
When a language has been enabled for a Commerce catalog, all catalog entries will be
immediately available in that language when viewed on the site. This means that for
instance product descriptions that have not yet been translated, will appear empty if they
are displayed on the front-end site.

Enabling languages for catalog content
Do the following to enable a new language for creating catalog content:
1. Activate the language in the CMS admin and edit view, as described in Multi-language man-

agement. Note that you need to enable the language in edit view to make it available for editors to translate content, and you also need to make the website start page available in the
same language, for proper display of translated content.
2. Enable the language for the desired catalog where you want to apply the new language:
a. In the Catalog edit view, open the catalog for which you want to add a language in the
All properties editing view.
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b. Select the newly added language under Available languages, and publish the
changes to the catalog.

Translating content for catalog entries
Follow the steps below to translate content for existing catalog entries (category, product, variant/SKU, package or bundle). In this example we will translate content for a product.
1. In the Catalog view, select the desired catalog entry to translate in the catalog tree.
2. Select Edit in the context menu for the selected entry, or click on the entry to open the All
Properties editing view.
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3. In the header next to Languages, select the desired language to translate to (enabled languages will be listed).

4. Edit the content as desired in the properties available for editing, and follow the content publishing flow to save and publish the translated catalog entry information.
When translating content, have the original content open in another browser window for
comparison. You can also copy and paste the original content into the text area where
you are working, as reference.

More on language management
Switching language and viewing language versions
When working with Commerce, you can switch languages by selecting the desired language in the
Header, when editing translated content in the All Properties editing view. The user interface will
reload displaying the content in the selected language. Refer to Translating content in the
CMS Editor User Guide for more information on how to switch between languages and view language versions for content.
Editing global properties
Depending on your implementation, some properties may be "globally shared" and can only be
edited in the master language. Refer to Translating content in the CMS Editor User Guide for more
information on how edit global properties.
Changing the user interface languages in Commerce
l

To set the user interface language for the Catalogs and CMS parts, click your user profile
name in the upper right corner. Select My Settings and then the Display Options tab. Select
the language of your choice in the list, and click Save.

l

To set the user interface language for Commerce Manager, select Change Language in
the upper menu of Commerce Manager. Chose the language of your choice in the list and
click OK to save you changes.
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Personalization
EPiServer Commerce features a number of predefined visitor group criteria customized for an e-commerce site where you want to personalize content based on products and order information. Visitor
groups can be applied to the various content on your e-commerce site, creating a personalized website experience.
The visitor groups and their associated personalization criteria can be accessed by clicking CMS in
the global menu, and then selecting Visitor Groups in the submenu displayed. The personalization
criteria for EPiServer Commerce are available under Commerce Criteria when you click Add to
define visitor groups for your site. The various criteria can then be dropped into the configuration
area.
The predefined Commerce-specific personalization criteria are described in more detail in the following.
You need administration access rights to create and edit visitor groups. Once the visitor
groups have been created, they will be available in edit view for editors to use.

Commerce-specific criteria
In addition to the built-in visitor group criteria for CMS, these will be available by default in an
EPiServer Commerce installation, to be used when creating visitor groups for an e-commerce audience.
Customer properties criteria
With the Customer Properties criteria you can personalize content based on for instance age and
geographic location.
Personalize content based on the following information (select from drop-down list):
l

Date of Birth - define an age range by entering a from/to date. Select a date in the calendar or
enter a date directly in the field (default format mm/dd/yyyy).

l

Customer group - select one of the existing groups Customer, Partner or Distributor.

l

Registration source - enter the source of registration in free text format.

l

Country - select a country from the list.

l

Region code - select a region code based on the address region in addresses.

l

Address postal code - based on state selected, select a postal code from the list.

l

State - select a state from the list.
Only one property type with a related value can be selected for a criterion, but several
Customer Properties criteria can be defined for a Visitor Group.

Market criteria
With the Market criteria you can personalize content based on the market a visitor to the website
belongs to.
Personalize content based on the following information (select from drop-down list):
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l

Market - select a market from the drop-down list. Available markets are defined under Market

Management.
Order frequency criteria
With the Recent Orders criteria you can identify customers that have placed an order in the store"
X" times in the last "Y" days.
Personalize content based on the following information:
l

Order times - select the number of times an order has been placed.

l

Number of days - select the number of days.

Product in cart or wish list criteria
With the Products in Cart or Wish List criteria you can identify shoppers that have placed a
product of a certain type or brand in their cart or on their wish list.
Personalize content based on the following information:
l

Specified product code - enter the desired product code in free text format.

l

Product from a specified category - select the desired product category from the list.

l

Product has a specified property and value - enter the desired product property and value,
for instance "brand" and "Sony".
Only one property type with a related value can be selected for a criterion. However, you
can add several criteria of the type "Products in Cart or Wish List" to a Visitor group.

Recent orders criteria
With the Recent Orders criteria you can personalize content for visitors that have placed an order
on the site in the last "X" days.
Personalize content based on the following information:
l

Number of days - select the number of days.

Total spent criteria
With the Total Spent criteria you can personalize content for visitors that have spent "X" amount of
money (in a specified currency) on the site in the last "Y" days.
Personalize content based on the following information:
l

Spent at least - select amount and currency.

l

Select number of days.

Gadgets
A gadgets is a small application that can be made available in the user interface. Gadgets can be
added to the assets and navigation panes, as well as to the EPiServer dashboard. Refer to Gadgets
in the CMS Editor User Guide for more information on built-in gadgets in the EPiServer platform.
The EPiServer Commerce sample site features a number of predefined gadgets for e-commerce
websites. The Commerce-specific gadgets are described below.
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Commerce orders gadget
The Commerce Orders gadget displays orders statistics in the form of a sales graph and a list of
purchase orders in a time interval of your choice.
Do the following to add and configure the Commerce Orders gadget:
1. Log in to EPiServer Commerce and select Dashboard in the right-click menu.
2. Select the Dashboard tab under which you want the gadget to appear.
3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce
Orders gadget by clicking on it in the list. The gadget will be displayed on the dashboard. By
default, it will be updated to display new data every 30 seconds.
4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a
new time interval. Click OK to save you changes.
When the Commerce Orders gadget has been added to your dashboard, you will be able to easily
monitor sales activities for your EPiServer Commerce website.

Commerce overview gadget
The Commerce Overview gadget shows sales data from the e-commerce system. The data is
grouped by products, categories, orders, customers and promotions.
Do the following to add and configure the Commerce Overview gadget:
1. Log in to EPiServer Commerce and select Dashboard in the right-click menu.
2. Select the dashboard tab under which you want the gadget to appear.
3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce
Overview gadget by clicking on it in the list. The gadget will be displayed on the dashboard.
By default, it will be updated to display new data every 30 seconds.
4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a
new time interval. Click OK to save you changes.
When the Commerce Overview gadget has been added to your dashboard, you will be able to easily
monitor sales data from your EPiServer Commerce website.

Community approval gadget
Users logged on to the sample site can add comments (reviews) to products on the site. The Community Approval gadget makes it possible for EPiServer Commerce administrators and editors to
manage comments that are left by website visitors. This gadget provides an overview of the commenting status, and you can view, approve or delete comments from here.
Do the following to add and configure the Community Approval gadget:
1. Log in to EPiServer Commerce and select Dashboard in the right-click menu.
2. Select the dashboard tab under which you want the gadget to appear.
3. Select Add Gadgets in top left corner of the dashboard, and then select the Comment
Approval gadget by clicking on it in the list. The gadget will be displayed on the dashboard.
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4. By selecting Edit in the drop-down menu of the gadget, you can set the number of approval
items to display, as well as the length of the description.
5. Click OK to save you changes. The gadget will be displayed on your dashboard.
Do the following to use the Community Approval gadget:
1. Log in to EPiServer Commerce and select Dashboard in the right-click menu and select the
Dashboard tab under which the Approval gadget is located.
2. You can chose to view all comments, or filter them according to their status - Approved,
Pending or Deleted. Click Refresh to update the list if needed.
3. Select one or more comments for which you want to update the status, by clicking the checkbox to the left of each comment. Click the top left checkbox to select all comments displayed
in the list.
4. Select the status you want to apply - Approve, Mark Pending or Delete. For instance,
select Approve to approve the selected comments.
5.

Comment abuse report gadget

6. The Comment Abuse Report gadget makes it possible for EPiServer Commerce administrators and editors to manage comment abuse reports that have been created by website
visitors. This gadget provides an overview of abuse reports, and you can remove selected
comments from here.
7. Do the following to add and configure the Comment Abuse Report gadget:
8.

a. Log in to EPiServer Commerce and select Dashboard in the right-click menu.
b. Select the dashboard tab under which you want the gadget to appear.
c. Select Add Gadgets in top left corner of the dashboard, and then select the Comment Abuse Report gadget by clicking on it in the list. The gadget will be displayed
on the dashboard.
d. By selecting Edit in the drop-down menu of the gadget, you can set the number of
items to display, as well as the number of abuse reports to be displayed for each comment.
e. Click OK to save you changes. The gadget will be displayed on your dashboard.

9. Do the following to use the Comment Abuse Report gadget:
10.

a. Log in to EPiServer Commerce and select Dashboard in the right-click menu and
select the Dashboard tab under which the Comment Abuse Report gadget is located.
b. Select the comments you want to manage by clicking the checkbox to the left of each
comment. Click the top left checkbox to select all comments displayed in the list.
c. Click Remove Comment to remove the comment. Select Ignore to leave the comment without any actions.
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Commerce settings for CMO gadget
With EPiServer Campaign Monitor and Optimization (CMO) you can measure and monitor campaigns on your website and optimize your landing pages. EPiServer CMO provides a simple way to
analyze campaigns and landing pages, rather than whole sites. Find out more about EPiServer CMO
in the user documentation on world.episerver.com.
EPiServer CMO can also be used for monitoring activities on an EPiServer Commerce site. You can
for instance monitor the number of views or orders for a specific product or product category. The logging of Commerce KPI data is supported using the Generic KPI function in CMO. The number of
orders is an example of a generic KPI. This allows for external applications such as Commerce to
send notifications using a specific application key. The application names and keys are defined in
EPiServer CMO, which will then listen for incoming notifications with these specific key values, and
collect and store the data.
The following procedure applies when setting up the integration between CMO and Commerce:
l

Set up the web services to be used by EPiServer CMO and the corresponding URL to be
used.

l

Define the external applications, their application names and keys, in EPiServer CMO.

l

Define the product views and/or product orders you want to monitor, using the EPiServer
Commerce Settings for CMO gadget. Here you will need the application keys and the URL
for the CMO Web Services.

l

In EPiServer CMO, create a campaign and add the generic KPI for EPiServer Commerce.

l

EPiServer Commerce will update the KPI value using web services.

l

The monitoring result will be displayed on the campaign report page in CMO, or by using the
CMO KPI Summary gadget for EPiServer Commerce on the site that has the EPiServer
CMO service installed.

The collected data for EPiServer Commerce can be monitored using the Commerce settings for
CMO gadget, as described in the following.
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To use this gadget you need to have both EPiServer CMO and EPiServer Commerce
installed on your website.
Adding the Commerce settings for the CMO gadget
When you add and configure this gadget, you can choose to monitor activities for a selection of
product(s) or order(s).
Do the following to add and configure the CMO gadget for EPiServer Commerce:
1. Open the EPiServer OnlineCenter for your website(s) and select Add Gadgets.
2. Click on the Commerce setting for CMO gadget to add it to your dashboard.
3. Click Add to define the monitoring parameters.
4. Select Type, choose either Product View or Product Order. The Product View will define
views of a product or all products under a specific category (node). The Product Order will
define orders for one selected product or all orders of products under a specific category
(node).
5. In the Product/Category field, choose a product or a category by selecting an option in the
tree structure on the left hand, and click Search in the area to the right. Select a product in the
search list and click Select. Or, you can select an entire category (node). You can also
search directly for a product name or ID. Click Select to add your selection.
6. In the Application Key field, enter the application ID (defined in EPiServer CMO).
7. In the URL for CMO Web Service field, enter the URL to be used by CMO for the web service (defined in EPiServer CMO).
Editing Commerce settings for the CMO gadget
Do the following to edit a set of settings for the CMO Gadget:
1. Open the dashboard, and navigate to the Commerce settings for CMO gadget.
2. Click the Edit icon for the settings you want to edit.
3. Update the settings information, please refer to the section about adding the Commerce settings for CMO gadget.
4. Click OK to save your changes.
Deleting Commerce settings for the CMO gadget
Do the following to delete the settings for the CMO Gadget:
1. Open the dashboard, and navigate to the Commerce settings for CMO gadget.
2. In the check box to the left, select the set of settings you want to delete.
3. Click the Delete button and click OK to confirm.

Access rights
Access right management involves setting permissions for users working with content in EPiServer
Commerce and EPiServer CMS. These may or may not be the same individuals, depending on the
size and setup of the organization. A “marketer” for instance may work with campaign pages in
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EPiServer CMS as well as enriching product content in Commerce. A “merchandiser” may work with
pricing information and categorization of catalog entries in the catalog interface in Commerce. Refer
to Roles and tasks for more information about users in EPiServer Commerce.
Note that you need administrative access rights in both CMS and Commerce Manager to
manage users and access rights for various parts of the system.

Contacts and accounts
The user administration in the Commerce Manager back-end system is based on contacts. A “contact” can be a (registered) customer shopping on the website, as well as a someone working with the
system, editing website content or managing online store tasks.
When an online customer decides to register with the website, a contact with an account is created.
However, anonymous shopping is allowed, which means that shoppers are not required to create an
account in order to purchase. Contacts can belong to organizations. The relationship between
organizations, contacts, accounts, roles and user groups, is illustrated below.

A contact can have an account associated with it, which is needed if you want to assign access
rights to that contact. Only contacts with associated accounts will appear in the CMS admin view,
which is where you set access rights for editing website content.

Managing users
Contacts, accounts and organizations in Commerce are administered from the Customers system.
This includes managing user accounts and adding roles to users (contacts). Setting access rights
for editorial content management in the page tree of the website is done from the CMS admin view.
When a user has been created in the system, you can set the desired access rights, depending on
whether the user is going to work with CMS, catalog content, the Commerce Manager back-end system or all parts.
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A user with an account created in Commerce Manager will be available in CMS, whereas
a user created in CMS will not be available in Commerce Manager. This means that
users must be created in Commerce Manager first, to be able to work with both CMS and
Commerce Manager.
Restricting access rights to the user interface
In addition the default EPiServer groups “WebEditors” and “WebAdmins” for controlling access to
the edit and admin views in CMS, Commerce has some specific groups for controlling access to the
Commerce user interface:
l

CommerceAdmins

l

CommerceSettingsAdmins

l

CatalogManagers

The following settings are needed depending on what parts of the system users will be working with:
l

A user account (contact) added in Commerce Manager (for all Commerce users).

l

Membership in WebEditors to access the CMS and Commerce user interfaces, for users
that are not members of WebAdmins (see below).

l

Membership in CatalogManagers for accessing the Catalogs user interface, but not the
Commerce Manager back-end parts.

l

Membership in CommerceSettingsAdmins for accessing Settings, but not the Commerce
Manager back-end parts.

l

Membership in CommerceAdmins for accessing Commerce Manager. This will include
access to the Catalogs user interface and Settings, but not the admin view in CMS.

l

Membership in WebAdmins will provide access to all parts of the editing and administration
interfaces, including Commerce Manager. Usually this is restricted to very few users.

l

For users that will be working with content in the CMS edit view, membership in one or more
"structure groups" is needed to provide editing access in the CMS page tree (see below).
Note that the CommerceAdmins, CommerceSettingsAdmins and CatalogManagers
groups need to be manually created in the CMS administration view, before you can add
users to them. Go to the CMS > Admin > Set Access Rights, and add the groups under
Administer Groups.

Creating a user and provide access right in CMS and Commerce
Follow the steps below to create a user and provide access rights.
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1. In Commerce Manager, go to Customers and create a contact with an account.

2. In the CMS admin view, go to Search User/Group and locate the user you created in the previous step. Click on the user name to edit the settings.
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3. Add the desired access rights and click Save.

4. Log in with the user to verify that proper access rights are applied.
Restricting user access in Commerce Manager
A standard installation of the sample site has a set of predefined roles, which you can use to restrict
access to various parts of Commerce Manager. These roles are based on common e-commerce
working procedures and provides a suggestion to how you can work with the system. A user will
need at least one of these roles assigned, in order to access Commerce Manager.

© EPiServer AB

Managing content | 251

Each role is associated with a range of permissions on different levels, related to the various parts of
EPiServer Commerce.
The following roles are available by default, with a set of permissions for each role:
l

Admins - default role allowing to fully administer most areas.

l

Order Managers - this role can create returns and exchanges, view and edit orders, send
notifications, process payments and split shipments. You can also allow order managers to
manage discounts and/or change the line item price.

l

Order Supervisors - this role has full permissions for the entire order management procedure, including the entire Order Managers permissions.

l

Shipping Manager - this role allows for viewing, packing and completing shipments.

l

Receiving Manager - this role can view shipments and receive returns.

l

Everyone - assigned when a customer registers an account from the front-end public site.

l

Registered - assigned when you register from an account from the front-end public site.

l

Management Users - this role allows users access to Commerce Manager.

l

Administrators - this role has extensive administration rights in areas such as assets, catalogs, core functions, marketing and customer and order management.

l

WebAdmins - this role is EPiServer CMS specific and provides access to the EPiServer
CMS administration interface, needed when administering the content management parts of
EPiServer Commerce.

l

WebEditors - this role is EPiServer CMS specific and provides access to the EPiServer
CMS editorial interface, needed when working with content on the EPiServer Commerce
website.

l

Expert - this role is used in the EPiServer Commerce sample site for external users that are
reviewing products.

You can change the detailed permissions for each of these roles, as well as define your own roles
and set permissions, all in order to match the specific working procedures in your organization.
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Additional accounts used by your internal team to access EPiServer Commerce must have one or
more Roles assigned to them. A role can be for instance "Catalog Viewers", "Marketing Admins" or
"Asset Managers".
EPiServer Commerce users are internal to your organization and should not be confused
with customers. By default, customers who register from your public site are given the
"Everyone" and "Registered" Roles, but these roles do not allow access to the administration interface of EPiServer Commerce.
Restricting user access in CMS
The WebEditors group only provides access to the editing view. Users editing content in CMS
must also be granted editing access in the page tree. This can be done using "structure" groups. You
can for instance create a group "Site_Editors" with editing permission in the entire tree structure, and
groups such as "Product_Editors" or "News_Editors" limiting editing access to selected parts of the
tree. Define access rights for the groups in the page tree, and then add users to the groups as appropriate.

Refer to access rights in the CMS Administrator User Guide for more information on how to work
with access rights in EPiServer.
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